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Sample Calibration Databases 

Explore Calibration Control with Sample Data 
The Sample Databases are most useful during the trial period but can be accessed at any time. 

Selecting the MS Access Sample Database on First Start 
When Calibration Control starts for the first time there are two database formats to choose from, MS Access or 
SQL Server. Click the [MS Access] button to continue. 

 

 
In the next dialog (Choose Database Type), check the "CREATE New SAMPLE Database" checkbox and click the 
[Continue] button. 

 

 
The Trial Period Notification dialog pops up each time Calibration Control starts without a current Product Key. If a Product 
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Key has been purchased click the [Yes] button to use it in the Sample Database. Otherwise, click the [No] button to 
continue. 

 
 

When Calibration Control starts, about 300 sample records will be visible. 
 

 
Selecting Sample Database After Program Start 
Open the Options dialog (from either the File or Utilities tab of the ribbon menu) and navigate to the Advanced 
tab. Click the Switch to Sample Database button. 
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Then click the [Yes] button in the following 'Show Sample Database' dialog. 

 

Reset Configuration 
If you selected MS Access and now you'd like to try using a SQL database or vice versa, you'll first need to reset the 
configuration. You can use the keyboard shortcut by holding CTRL and launch Calibration Control OR you can manually 
reset the configuration by navigating to this path on your computer: 

C:\Users\Public\Documents\Ape Software\Calibration Control 
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Then, delete the general.config file and restart Calibration Control. You should now see the Choose Database Format 
dialog. 

Sample SQL Database 
To get started using our Sample SQL Server database, choose SQL Server from the Choose Database Format dialog, then 
select SAMPLE DB in Cloud. If you'd like a blank database to try, first ensure you can connect to our Sample DB in Cloud, 
then email us with the subject "Blank SQL Database Request" and include your full name, company name and company 
address/general location. We'll set up a blank database just for you and send you the connection instructions. 

 
 

Remove Sample Data 

Remove Sample Data to Begin Entering Your 
Own Records 
If, during the trial period of Calibration Control (our Calibration Management Software), the sample database is used 
to evaluate the software, the sample data should be removed before entering live equipment records. 

Double Click (Automatic Method) 
The easiest way to remove the sample data is to double-click on the graphic in the bottom-right of the Equipment grid . . . 

https://www.apesoftware.com/calibration-control/help/network-configuration
mailto:service@apesoftware.com
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. . . and then click the [Yes] button. 

 

 
After the application restarts, select the 'CREATE New Blank Database' or 'BROWSE to Existing Database' checkbox, then 
click the [Continue] button. 
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Note: If the CREATE New Blank Database option is selected, then the new database will be created at this path 
C:\Users\Public\Documents\Ape Software\Calibration Control on the computer being used. Therefore, if the database 
needs to be moved to a network location, follow the instructions in the move database help topic. 

If you need any help, contact Ape Software and we can do a remote support screen share to do this together. 

Move Application Database 

Move Application Database to a New Location 
Watch this short video on how to move an application database file (apecal.mdb) in Calibration Control (our Calibration 
Management Software) from its initial location, to a new location to make the database easier to backup or to place it in 
a more central location to share with additional users. 

STEP 1: Close Application 
Before moving the database file, ensure the application is closed. 

STEP 2: Find Database File 
Before moving the ‘apecal.mdb’ file, find its location. If you need help, see the help page on finding your database 
file before moving to the next step. 

STEP 3: Move Database File 
Choose the new location either on a shared network or the same computer and move the ‘apecal.mdb’ file from its 
original location to the new location. 

Note 1: If moving the database file to a network location, grant appropriate user permissions to that new 
location depending on who needs access. 

Note 2: When moving a database, rename or backup to a different location the database from the first location. The 
goal is to ensure that the program does not mistakenly connect to the old database sometime in the future thereby 
making the users assume that data is lost (old db has fewer records). 

STEP 4: Point Application to New Location 
Point the Ape Application to the new location by starting the application. When the application discovers the 
‘apecal.mdb’ file is missing from its known location, it will show the following ‘Choose Database Type’ dialog: 

From within this dialog, select ‘BROWSE to Existing Database’ and click the [Continue] button. 

 

https://www.apesoftware.com/calibration-control/help/move-database
https://www.apesoftware.com/about/contact-us
https://www.apesoftware.com/help/remote-desktop-support
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Browse to and select the new database location and click the [Open] button. 
 

 
The Ape Database Software should start as normal and will remember this new location. 
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Locating Database File (MS Access) 

Find the Database and Configuration Files 
By default, the apecal.mdb database is stored in the Settings Folder unless the database was moved to another location, 
like a network folder. The default Data & Settings Folders is different for different versions of Calibration Control and 
different operation systems. Refer to the Folders Help Topic for an overview of the ones used by Ape Database Software. 

Method 1 - Version 5.5 and Higher 
This is the best method to find the database if the application can be opened. 

 
The easiest way to find the Data Folder in versions 5.5 and higher is to select the Open Data Folder Option from the 
File dropdown menu. 

 

 
Otherwise, the default Data Folder is located at: 

 
C:\Users\Public\Documents\Ape Software\Calibration Control 

Method 2 - Version 8.0 and Higher 
This is the best method to find the database if the application cannot be opened. 

 
Versions 8.0.4 and higher automatically create a Connection Log file (connectionlog .csv) found in the Settings 
Folder (see section above). The Connection Log can be read with a spreadsheet program, like MS Excel. This file logs 
each of the connections to the database (e.g., path). A blank path statement in the connection log means that the 
database was located in the default location (i.e., Settings Folder). 

https://www.apesoftware.com/calibration-control/help/folders
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Method 3 - General Config File 
If the apecal.mdb file is not located in the folders described above, the path to the database can be found inside the 
general.config file located in the Settings folder. After finding the general.config file, open it either by double-clicking or 
using a common text editor like Notepad. 

 

Data Imported To MS Access 

How to Deploy Your Imported Data 
This help topic only applies to the [MS Access] database format. If using SQL Server, refer to the Add Ape Database 
to SQL Server help topic. If Ape Software performed your data import, you will receive your imported database in a zip 
file through either a download link or an email attachment. To deploy the database yourself, follow the instructions 
below. Otherwise, contact us and we'll assist with the process through a screen share. 

Install Current Version 
Before proceeding, download and install the most current version of Calibration Control. Ensure the Minimum 
Requirements are present before installation. 

Deploy Database (Scenario A) 
Proceed to Scenario B (below) if the Application has already been used on this computer to access a database. 
Otherwise, continue with this section. 

1. Download & Unzip: Download, unzip, and place the imported database in the desired folder. This may either 
be on the local computer or a network location, if the database will be accessed by multiple users. 

2. Choose Database Format: Start the Application and select the [MS Access] button. If the Application does 
not start with the Choose Database Format dialog, proceed to the next section (below) Remove Old 
Database (Scenario B) 

https://www.apesoftware.com/calibration-control/help/sql-server-install
https://www.apesoftware.com/calibration-control/help/sql-server-install
https://www.apesoftware.com/calibration-control/help/sql-server-install


  
CALIBRATION CONTROL MANUAL 24 

 

 

 
3. Choose Database Type: Select [BROWSE to Existing Database] from the Choose Database Type window. 

 

 
 

4. Select Database: Navigate to the database you downloaded and unzipped (step 1), select, and click the 
[Open] button and the software should open with the imported data visible. 

5. Common Files Folder: If the database was placed in a network location and/or multiple users will access the 
software, refer to the Common Files Folder section of Creating a Multi-User Environment to setup the Files 
Folder. 

Remove Old Database (Scenario B) 
If the Application was previously used with a Blank or Sample database, the files already present should be removed 
or renamed before proceeding. 

1. Open Data Folder: After the Application is running, open the Data Folder by clicking [File] in the top-left of 
the screen and selecting "Open Data Folder". Confirm the existence of the database file (apecal.mdb or 
apecal_sample.mdb). This is the quickest and most accurate way of finding the current database. Leave 
this window open and proceed to the next step. 

https://www.apesoftware.com/calibration-control/help/multiple-users
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2. Open Settings Folder: In the File menu, open the Settings Folder. If the Settings Folder is the same folder 
location as the Data Folder, you can skip this step. Note that by default, the Data Folder and the Settings Folder 
are the same location unless the database is moved. 

3. Close Program: Close the Application so the database files can be moved, renamed, and/or replaced. 
 

4. Rename or Move Files: Although the data files can be renamed, it's easier to move ALL the files in the 
Settings and Data folders to a backup location (e.g., "Data Backup - Current Date"). Cleaning out these folders 
will create the conditions required for a clean first-run of the imported data and will prevent Calibration Control 
from automatically connecting to a database file in the Settings folder location. 

5. Scenario A: Proceed with Deploy Database (Scenario A). 

Additional Help 
If you have any general questions about the import process itself, refer to the Database Import Process 

article. Other useful help topics: 

Creating a Multi-User Environment 
 

Move Calibration Management Database 

Creating a Multi-User Environment 

Setting up Multiple Users 
Setting up access for multiple users to use Calibration Control (our Calibration Management Software ) is as easy as 
deleting or renaming the general.config file, starting the application (or hold CTRL while starting Calibration Control), and 
linking to the new file. Therefore, if you are using an Access database file, you should be familiar with the help topics for 
finding your database and moving your database. If you are using a SQL Server, then take a look at the help topics on 
Adding an Ape database to SQL Server and Connecting to a SQL Server Database. 

https://www.apesoftware.com/articles/database-import-process
https://www.apesoftware.com/articles/database-import-process
https://www.apesoftware.com/calibration-control/help/multiple-users
https://www.apesoftware.com/calibration-control/help/move-database
https://www.apesoftware.com/calibration-control/help/locate-database
https://www.apesoftware.com/calibration-control/help/move-database
https://www.apesoftware.com/calibration-control/help/sql-server-install
https://www.apesoftware.com/calibration-control/help/network-configuration
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Move Your Database (MS Access Database Only) 
Find your database and move your database to a network location where all users have read-write access. Most of the 
difficulties users experience with implementing a multi-user environment are related to network folder permissions. So if 
you experience any difficulties, you should first seek assistance from your network administrator. 

Set Up a Common Files Folder (Access & SQL) 
Calibration Control uses a Common Files Folder that contains four sub folders (i.e., Attachments, Emails, Labels, and 
Reports). Ensure each networked user is using the Common Files Folder so its sub folders are equally accessible to 
all users. Do this by: 

1. Common Mapping: Ensure each user has the same network mapping for the Files Folder. For instance, if a 
mapped drive (e.g., "M:\Server2\Common Files") is used for one user, the same path will be used for all 
users. 

2. Point Ape Database Software: Open the Advanced tab of the Options dialog and click the Folder & Path 

button. Change the 'Location of Files' (i.e., Common Files Folder) to the common network location (step 1). 
 

3. Move Folders: If custom files already exist in the old location(s) of the Files Folder, move those files to their 
new Common Files Folder locations (step 1). Specifically, move all attachments and custom templates (e.g., 
reports, labels, & emails). Otherwise, the default Reports and Labels templates will be copied to the new Files 
Folder Location. 

Add Additional Users 
When running the software on a client for the first time, it presents the option to create a database (blank or with 

https://www.apesoftware.com/calibration-control/help/locate-database
hhttps://www.apesoftware.com/calibration-control/help/move-database
https://www.apesoftware.com/calibration-control/help/folders
https://www.apesoftware.com/calibration-control/help/options
https://www.apesoftware.com/calibration-control/help/sample-database
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sample records) or to navigate to an existing database. Therefore, after starting the software on a new computer, 
check the 'BROWSE to Existing Database' option and [Continue] if a database already exists in a network location. 

Otherwise, if a database has already been created on a client that needs to be networked (i.e., linked to a database on 
the network), delete or rename the local 'apecal.mdb' file to prevent the program from automatically connecting to it. If 
already running Calibration Control, find the folder for this database file by selecting Open Data Folder from the Files 
dropdown menu. Otherwise, refer to the finding your database help topic. 

 

Add Ape Database to SQL Server 

Install Calibration Control on a SQL Server 
Before beginning, ensure you are signed into a SQL Server with enough permissions to create and update databases 
and their objects (e.g., system admin). 

Installing the apecal database on an existing SQL Server (2012 or higher) is a simple database restore from a 
provided backed up file. All SQL files needed to perform the install reside in the SQL Tools folder under the CC 
program folder located at Program Files (x86)\Ape Software\Calibration Control. 

There are two backup files (.bak) located in the SQL Tools folder. One is the sample database named 
apecal_sample_{structure/records versions}.bak (i.e. apecal_sample_s84_r86.bak) and the other is a blank database 
named apecal_{structure/records versions}.bak (i.e. apecal_s84_r86.bak). Copy the backup file you wish to restore to your 
SQL Server default backup location. 

Restore Back-Up Database 
Follow along with our Backup and Restore SQL Server Database help topic for more detailed instructions. From within 
SQL Server Management Studio with the SQL Server connected, right-click on the Database node and select 'Restore 

https://www.apesoftware.com/calibration-control/help/sample-database
https://www.apesoftware.com/calibration-control/help/sample-database
https://www.apesoftware.com/calibration-control/help/locate-database
https://www.apesoftware.com/calibration-control/help/backup-sql-database
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Database'. 
 

 
From within the Restore Database dialog, type the name apecal in the 'Destination' field, select 'Device' as the Source, 
and then click on the [. . .] button to the right of the ‘Device’ field. 

    



  
CALIBRATION CONTROL MANUAL 29 

 

 
 

From within the Specify Backup dialog, click the [Add] button. 
 

Locate the backup file by navigating to or pasting in the 'Selected path'. Paste or type the name of the file to restore from 
(e.g., apecal_s51_r52.bak). Then click [OK] to save and close the backup file and [OK] again to close the Specify 
Backup dialog. 

 

When the Restore Database dialog is on the top again, click the checkbox in the Restore column of the backup set 
(file) you just designated and then click the [OK] button to begin the restore. 

If successful, the following confirmation dialog should display: 
 

 
After closing the confirmation dialog, refresh the list of databases to see the new apecal database. 

Restore Failed 
If the restore failed, you may need to repeat the above steps and specify different file names or path statements. Use 
the Options Page of the Restore Database dialog to modify the Database (e.g., Rows Data) or Log file names or the 
Path statement (i.e., Restore As). 
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User Security 
Users can connect to the apecal SQL Server database using either Windows or SQL Server authentication. Each user 
will either need Database Roles or Explicit Permissions. 

When using Database Roles, ensure each user has db_datareader and db_datawriter roles. 
 
 

When using Explicit SQL Server Permissions, ensure each user is granted at least the Connect, Delete, Execute, Insert, 
Select, and Update permissions. 
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If you need help, contact Ape and we can setup a screen share and do this together. 

Connect to SQL Server Database 

Configure Calibration Control to Connect to a SQL 
Server 
After creating the Calibration Control database on your SQL Server, follow these instructions to connect Calibration Control 
(our Calibration Management Software) to your SQL database. 

Start Calibration Control 
When running Calibration Control for the first time, select MS SQL Server as the database type. 

 



  
CALIBRATION CONTROL MANUAL 32 

 

 
 

To connect to your database, select Custom DB. Alternatively, we offer cloud hosted databases (sample data or blank) 
that you can easily connect to without further configuration. 

 

 
If you are already connected to a SQL Server database or an MS Access database, you can select the 'SQL 
Connect' option from the Utilities tab in the ribbon menu. 

 
 

Enter the fully qualified name into the Server Name field, confirm the database name, and select your 
authentication method. Click the Test Connection button to confirm that you have entered the correct connection 
information. 

The Remember Login checkbox is automatically checked. If it is deselected, you will be prompted to verify your server 
authentication method the next time you start Calibration Control. Once your connection test is successful, click the Submit 
button. 
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Restarting the Process 
This entire process creates a configuration file in the Settings folder on the computer where the application is running. If 
a mistake is made during the process, the best way to restart from scratch is to delete the config file and start over. You 
can do this easily by holding down CTRL while starting Calibration Control (Version 9.1.2 and later). 

You can also delete the configuration file manually by closing the application and opening the Settings folder, which you 
can find at this path on your computer: C:\Users\Public\Documents\Ape Software\Calibration Control 

Then, delete the general.config file and restart Calibration Control. 

Connection Troubleshooting 
If needed, refer to the help topic on Troubleshooting a SQL Server Connection. 

 

Calibration Control Folders 
Each of the folders (Data, Files, Settings, & Web) are accessible from the File drop-down menu in Calibration Control (our 
Calibration Management Software). 

https://www.apesoftware.com/calibration-control/help/sql-server-connection-troubleshooting


  
CALIBRATION CONTROL MANUAL 34 

 

 

 
What They Do 
The DATA Folder is the location where the access database (when using MS Access) resides. Visit the Move Database 
Folder help topic for steps on how to move the Data Folder to a new location. 

The FILES Folder stores the Attachments folder and the Labels, Reports, and Emails template folders. 
 

The SETTINGS Folder stores the program settings that Ape Software requires to function normally. This is the only 
File Folder that cannot be moved from its original location and every user must have read/write access. 

The WEB Folder is the target location for publishing the reporting web pages. 
 

https://www.apesoftware.com/calibration-control/help/move-database
https://www.apesoftware.com/calibration-control/help/move-database
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Settings Folder 
The Settings folder is the only folder that cannot be moved. The location of the Settings Folder is: 

 
Windows 7 & Higher: C:\Users\Public\Documents\Ape Software\Calibration Control 

 
Although all Folders share the same default location as the Settings folder when the software is first installed, the 
other three Folders can be moved to different locations on the computer or local network for sharing and backup 
purposes. The location of the Files folder can be configured in program Options > Advanced tab > Folder & Path. 

 

Grid Features 

Features Common to All Data Grids 
Each grid in Calibration Control (our Calibration Management Software) shares the same interface and basic features. 
Navigate data with sorting options, filters, grouping, and more. 

Context Menu: Find more options by right-clicking anywhere in a grid for the context menu. Selections may vary by grid. 
 

Alternate Grid Views: Most Data Grids have additional context menu items located at the bottom of the menu. 
Commonly, these additional menu items will be alternate views of that data grid. For example, the Equipment Data 
grid has 4 additional menu items: All Equipment, All Equipment - Show Hidden, Equipment Due Cal and 

https://www.apesoftware.com/calibration-control/help/options
https://www.apesoftware.com/calibration-control/help/options-folders
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Equipment Maintenance Due which also can be accessed by pushing the corresponding key (e.g. F7). 
 

 
Export: Right-click in the grid and in the context menu, select the option to Export to either Excel or PDF. 
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Change Font Size: Change the grid's font size by clicking on the 'Row Sizing' option and entering the size value 
in the Font Size box. The default font size shows 0, but is actually equal to 8, and numbers larger than 8 will 
yield larger font sizes. 

Column Change: Drag any column header to change its placement on the grid. Alternatively, use the small down 
arrow next to each header to select which column you want changed to that space. 

Context Sort: Click directly on a column header to sort records in ascending or descending order for that column. 
Hold the shift key while clicking on additional column headers to create sorts with multiple columns. 

Refresh: Refresh the data by pressing [F5] or by right-clicking the grid and selecting Refresh Grid from the context menu. 
 

Add New: Create a new record by double-clicking in the gray area of the grid, pressing [Ctrl+N], or by right-clicking 
the grid and selecting New Record from the context menu. 

Open and Edit: Open a record by first selecting the record and then double-clicking, pressing [Ctrl+O], or by right-
clicking a record and selecting Open Record from the context menu. 

Delete: Delete a record by first selecting the record and then pressing [Ctrl+D] or by right-clicking the selected record 
and selecting Delete Record from the context menu. 

Display Count: Displays how many records are listed. In the Equipment grid, the count for Equipment Past Due will 
also be displayed. 

Records: The number of records contained within the grid is indicated in the Grid Header. 
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Filtered: The number of filtered records is also indicated within the Grid Header. 
 

 
Filter Row: The Filter Row is a helpful tool for searching and reorganizing data. 

 

When the Filter Row is enabled from the context menu, a blank row will appear at the top of each column. 
 

Filters can be added to multiple columns at the same time. 
 

Create custom (i.e., combination) filters within a single column by selecting 'Custom' from the drop-down menu. 
 

 
Clear Filters: Clear a single column filter by placing the cursor in the filter field for that column and pressing the clear 
filter button (looks like a crossed out filter). Clear all filters by selecting the clear filter button at the far left of the filter row. 

Pinned Sort Column: Click the Pinned Sort button (looks like a thumb tac) located at the top right corner of the column 
header and the selected column will be "pinned" to the left hand side of the grid. When horizontally scrolling through a 
grid, a pinned column will stay visible. 

Grid Splitter: Use the Grid Splitter to view multiple sections of the grid at the same time by dragging the Grid Splitter 
bar to the desired height of the grid. And the grid can be split as many times as needed. Remove a Grid Splitter by 
dragging the bar all the way to the top or bottom of the grid. 
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Show Fields: Add and remove columns (i.e., fields) by right-clicking and selecting Show Fields from the context menu. 
Check the desired field columns to [Add] from available fields or [Remove] from visible fields. 

 

Also, change the column order by selecting a visible field and clicking the [Move Up] or [Move Down] buttons. 
 

 
Grouping Data: The GroupBy Box view is great for on-the-fly organization with “mini-data sets”, giving you the ability 
to arrange records by their columns. 

When the GroupBy Box mode is enabled from the context menu, a gray 'Drag To' section (the GroupBy Box 
area) appears at the top of the grid. 

Select and drag column headers (fields) into the gray area to create custom groupings. 
 

Remove any fields from the header by simply dragging them up and out of the gray boxed area and releasing. 
 

And if desired, the GroupBy mode can be disabled with records still organized in custom groupings. 

Highlight Colors of the Equipment Grid 

Understanding the Highlighted Colors of 
Equipment Records 
The Equipment Grid currently uses five default colors to visually identify 'past due' (pink), 'calibration/maintenance due 
soon' (yellow), 'calibration standard' (green), 'calibration failed on receipt' (red), and 'received for calibration' (gray). Colors 
can be customized. 

Showing/Hiding Colors 
Show or hide highlights by right-clicking for the context menu in the Equipment grid and toggling any of the five options 
in the 'Highlight' section. 
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Default Colors 
Manage the default highlight colors by clicking the [Default Colors] button in the General tab of the Program 
Options dialog. Change the colors to ones that makes sense for your company, or click the [Reset] button to restore 
the default colors. 
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Highlight Past Due 
Equipment records with a Next Cal date less than the current date are highlighted Pink. Records marked as Calibration 
/ Test Standards (usually Green) are also marked as Pink when they are Past Due. 

Equipment records not past due but “due soon” are highlighted Yellow. Due soon is defined by the Reminder Lead 
Days field in Options > Advanced tab > Calibrations. By default the Reminder Lead Days field is set to 30. 
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Highlight Standards 
Equipment marked as Calibration / Test Standard are highlighted Green unless they are also Past Due or soon to be Due 
Cal. Mark Equipment as a Standard by checking the 'Is Calibration / Test Standard' check box in the Calibrations tab of the 
Equipment dialog. 
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Highlight Received Out of Tolerance 
If any of the past Calibrations of a given Equipment have an As Found status of Out of Tolerance (OOT), the record 
is highlighted red in the main Equipment grid. 

 

 
Remove the Red highlight of an Equipment record by marking all of the Calibration Events with an 'As Found OOT' 
status as 'OOT Investigated'. 
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Received for Calibration 
Equipment that has been received for calibration will have a gray highlight in the grid. 

 

Filtering Records Using the Filter Row 

How to Use the Filter Row in the Data Grids 
The Filter Row is a helpful tool for searching and reorganizing your data in Calibration Control (our 
Calibration Management Software). 

Display Filter Row 
By default, the filter row is already displayed at the top of the grid; it looks a bit like a blank row. If the filter row is 
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not displaying, right-click the grid and select Filter row from the context menu. 
 

 
When the Filter Row is enabled from the context menu, a blank row will appear at the top of each column. 

 

Filters can be added to multiple columns at the same time. 

Create New Filter 
Choose which column to add a filter to and either use the drop-down menu to search for the filter, or type it into the 
blank field. Results will immediately appear as you type. 

 
 

 

Clear Filter(s) 
Single Filter: Clear a filter within a single column by placing your cursor within that column's filter field (in the filter 
row) and clicking on the [clear filter] button on the right side of the field. The [clear filter] button is an icon of a filter with 
a line through it. 

All Filters: Clear all filters by clicking the [clear filter] button on the far left side of the filter row. 
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Filter Methods 
Additional filter operators (i.e., filter method) are available by clicking on the blue square to the left of each filter field. 

 

 
Custom Filters 
Create combination filters within single columns by clicking the drop-down button (downward arrow) within the filter field of 
that column and selecting (Custom). 
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Hiding Equipment Records by Status 

Use Equipment Status to Manage Visibility 
It's a good practice to not delete equipment records in Calibration Control even after the equipment is no longer in 
use. Keeping out-of-use equipment visible can clutter up the Equipment grid and Due Cal reports making them more 
difficult to use. To help fix this problem, choose which status codes should be visible and which should be hidden. 

Status Codes Visibility 
Select the Codes grid from the Data Grids tab of the ribbon menu. 

 

 
The status codes under the 'Equipment' grouping includes an [Is Hidden] checkbox that, when checked, hides the 
equipment records with this status code and they will no longer be visible in the Equipment grid or default Due Cal 
reports. Uncheck the checkbox to make the records with that status visible again. 
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Select a record's status by using the drop-down field in that record's main Equipment dialog. Adding a NEW status code 
is easy, just click on the shaded Status box and create a new status code. 

Show/Hide All Hidden Records 
From the Equipment grid, right-click for the context menu and toggle the [All Equipment - Show Hidden] option to show or 
hide all records with a hidden Equipment Status. The Equipment grid will show an [Equipment Including Hidden] status 
as the header to remind users that there are records being hidden. 

 

Manage Out-Of-Tolerance (OOT) Equipment 

Manage and Investigate OOT Equipment 
When performing calibrations on measuring equipment in Calibration Control (our Calibration Management Software), it 
is proper to check the condition of the equipment (aka unit-under-test or UUT) before calibration (As Found) and after 
calibration (As Left). If measurement equipment is found out-of-tolerance (OOT) before performing calibration, an 
assessment of the effect of the OOT condition on processes must be performed. If it has been 12 months since the last 
calibration of the UUT, all the product and processes the UUT measured in the last 12 months are suspect. For instance, 
were products or processes falsely judged good when they were bad? 

Calibration Event 
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In a Calibration record, if the As Found field is OOT, the OOT 'Investigated' checkbox and the [Print OOT Form] button 
become visible. Upon finding OOT equipment, conduct an investigation in accordance with your organization's corrective 
and preventive action (CAPA) or nonconforming material (NCM) processes. After the investigation is complete, check the 
'OOT Investigated' checkbox. 

If useful to your organization's CAPA or NCM processes, print the OOT Form from the Calibration record for use as 
an investigative tool. 

 

 
Red Highlighted Records 
Calibration Events with pending OOT investigations are highlighted red in the Equipment grid when the 'Highlight - 
Received Out of Tolerance' option is enabled from the context menu. Clear the red highlighting by checking the 'OOT 
Investigated' checkbox for all Calibration Events (see above) that have OOT conditions for a given Equipment record. 
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Calibration History 

Calibration Event Quick Reference and Filter 
Use the Calibration History Grid in Calibration Control (our Calibration Management Software) to quickly find Calibration 
Events without having to go through their Equipment record. 

Top N Records 
By default, Calibration Control limits the default display of Calibration records to the top 100 in descending Calibration 
Date order. 

Change the number of records displayed by selecting from the drop down menu showing 'Select Top 100'. Available 
fields: Select Top 100, 500, 1000, 2000, 3000, 4000, 5000, 10,0000 or Select All. 
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Filtering and Sorting 
Enter Filters and Sorts just like any other data grid. Refer to the Features Common to All Data Grids help topic for 
additional instructions. The difference here is to remember that the Calibration Grid is only displaying the Top N records 
(see above). This means that the Filters and Sorts only apply to the collection of records currently displayed. 

To apply a Filter or Sort the entire list of records, select "Select All" from the dropdown in the grid. 

Context Menu 
In the Calibration History grid, right-click a record to open the context menu and quickly Print Certificates or Open 
the Related Equipment record. 

https://www.apesoftware.com/calibration-control/help/grid-features
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Equipment Dialog 

Edit Equipment Records 
Use the Equipment dialog to edit all data related to the tool / test equipment. Change the name of any field to continue 
using words that make sense to your organization. If the field name* is in a shaded box, click on it to add new values in 
the drop-down list of available values (combos). 

Equipment Dialog Fields 
Equipment ID: The unique identification given to your own tools / test equipment and is often referred to as 
an Asset Number. This is the only required field for a new record. 

Serial Number: The unique identification the manufacturer gives their tools / test equipment. (You may periodically 
find that some manufacturers do not assign serial numbers or that a serial number label has fallen off.) 

Model*: The model number of the tool / test equipment usually assigned by the manufacturer. 
 

Size/Range*: The size or range of the equipment. 
 

Description: Description of the tool model number, which automatically changes to reflect the description of the 
model field (above). After a Model number is selected, the Description field can be edited. 

https://www.apesoftware.com/calibration-control/help/field-name-change
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Manufacturer*: The company that made the equipment/tool. This field is also automatically set if an existing 
Model Number from the Model combo box is chosen. 

Equip Type*: Classification system developed by you, the user of Calibration Control. (Examples of Equipment 
Types include Caliper, 6" Caliper, Thermatron, Oven, etc.) This field will automatically populate if an existing Model 
Number is chosen and has a Type field assigned. 

Alternate ID: This is a second ID field, the Equipment ID being the first. Use this field to record a company 
Asset number, if it is not the same as the Equipment ID, or a customer's Equipment ID. 

Site*: Company field for a geographic Site or Company. 
 

Department*: The department in the organization where the tool is currently located. 
 

Location*: The location within the department where the tool is currently located. (This could be a specific 
work area or even an engineer's desk.) 

Custodian*: The individual who has custody or possession of the Equipment/Tool. 
 

Status*: The status of the tool / test equipment (e.g., accepted, removed from service, failed calibration, or 
any other status needed). 

Notes: You can use the Notes field for notes about the Equipment itself or use for whatever purpose needed. 

 

 
 

Calibrations Tab of Equipment Record 
Calibrations Panel Grid: Click on the [+] button at the bottom of the dialog to create a new Calibration Event. 

 

[Calibration] Last: The date of the last calibration is set automatically when entering a new Calibration Event with 
a Status of Pass. The Calibration Last date can be set manually, which automatically updates the Calibration Next 
field based on the value of the Frequency field. 

https://www.apesoftware.com/calibration-control/help/departments
https://www.apesoftware.com/calibration-control/help/locations
https://www.apesoftware.com/calibration-control/help/status-change
https://www.apesoftware.com/calibration-control/help/calibration-event
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[Calibration] Next: The date of the next calibration is calculated automatically when entering a new passing 
calibration event or when manually updating the Calibration Last field. In either situation, the next calibration date 
is calculated based on the chosen Frequency and Units. 

Override Calibration Next [check box]: Manually extend or otherwise override the Calibration Next date by 
checking the box to the right of the Calibration Next field. 

Received [for calibration]: The date when equipment is received for Calibration. 
 

[Print Certificate] button: Click this button to send a Calibration Certificate worksheet straight to your 
default printer. 

Frequency / Units: The frequency between calibrations, like yearly or semi-annual. If choosing a frequency 
that requires a unit multiplier (e.g., weeks, days, or months), the Units field will enable to adjust the number of 
units (weeks, days, or months, etc.). The 'Month of' and 'Week of' frequencies set a general due date of an entire 
month or week. 

Calibration Standard [check box]: Check this box if the current equipment is used as a calibration standard 
for other equipment. 

Company*: The organization (Calibration Company) that regularly calibrates this instrument. This is a useful field 
when wanting to create a report of all the equipment due in a given period for a specific calibration resource. 

Technician*: The person who normally calibrates this equipment. 
 

Certificate: Number of the certificate issued by the organization responsible for the last calibration event. 
Used primarily to aid in traceability back to a national measurement standard, especially if this equipment is a 
Calibration/Test Standard. 

Template: Calibration Template used when creating new calibration events. 

 
 
Maintenance 
Use the Maintenance tab to add or link maintenance requests to an Equipment record. Keep track of equipment with 
maintenance due with grid highlights and/or the Equipment Maintenance Due grid (right-click the Equipment grid or press 

https://www.apesoftware.com/calibration-control/help/calibration-templates
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F12). 
 

 
Attachments|Documents|Notes|Parts Tab 
Use these panel grids to add, link, and edit the Attachments, Documents, Notes, and Part Numbers records related to 
an Equipment record. 

 
 

Misc (Miscellaneous) Tab 
The Miscellaneous tab contains groups of data that help organize information related to the Equipment record. 

 

Miscellaneous Group: 
Owner*: The Equipment Owner (Person field), if not the organization. 

 

[Equipment] System*: System that this Equipment belongs to. 
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Barcodes*: Use this field to add additional barcodes to the record that may already be on the equipment. 
This field is useful when no additional bar-coded labels are needed and Calibration Control will recognize 
the barcode labels already affixed to the equipment. 

Equip Cost: The purchase price or calibration cost of the Equipment. 
 

Acquired: Acquisition date of the equipment. 
 

In Service: In-Service date of the equipment. 
 

Cal Cost: The standard (normal) cost of calibrating this Equipment. 
 

Time: The standard amount of time required to calibrate this Equipment. 
 
 

Check Out Group: Using the Check In/Out dialog automatically populates the following fields: 
By*: The Checked Out By field shows the person who has checked out the Equipment. 

 

Date: The Checked Out Date field shows the most recent date this Equipment was checked out, and 
only populates if it is checked out. When not checked out, this field is blank. 

Use Count: Number of times this Equipment was checked out since its last Calibration. 
 
 

The Uncertainty Studies panel grid allows you to add or link and Uncertainty group to the equipment record. 

 
 

Other Tabs in the Equipment Dialog 
There are some extra tabs within the Equipment dialog that help organize data related to Equipment records. 

 
The Custom tab contains extra fields available in text, date, number, and checkbox format to easily rename and use 
for whatever needed. 

https://www.apesoftware.com/calibration-control/help/check-in-out
https://www.apesoftware.com/calibration-control/help/field-name-change
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The Image tab allows you to select one main image that represents that specific Equipment record. 
 

The Overrides tab, while default labels and reports are defined at a global (application) level in the Options 
dialog, overrides for the Labels and Reports listed here can be entered for this specific Equipment. 

The Meta tab is a READ-ONLY information tab used as a reference to view which user created the record and which 
user was the last to edit it, including the dates and times these occurred. 

Calibration Events 
In the Equipment dialog, the Calibration summary is displayed from the Calibrations tab.   To create or add a new 
Calibration Event record, click the green [+] icon, or right-click in the Calibrations records gray area to select "New 
Record" from the context menu. 

 

 
Create a Simple Calibration Event 
The following image shows a simple Calibration Event without any Measurements, as is often the case when 
recording calibrations handled by an external calibration laboratory. 

 

https://www.apesoftware.com/calibration-control/help/attachments-pictures
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The Calibration Results (As Found and As Left) can be selected when no Measurement Groups exist. The Technician, 
Temperature, and Humidity fields are usually not required in the outside lab scenario because this data would be included 
on the certificate the external organization provided. The calibration certificate provided by the outside calibration 
companycan then be attached to this Calibration Event. 

Calibration Event Fields 
Certificate: A sequential number is assigned to each Calibration Event. This number is automatically used as the 
Certificate number, unless another value is entered in this field, and it should be unique. To set the number value to 
automatically increment for this field, see the Number Masks topic for instructions. 

Date: Date the Calibration Event took place. This field defaults to today's date. 
 

Company: The organization that calibrated the equipment, like your own company (Internal) or a 
calibration laboratory (External). 

Temp (Temperature): Enter the ambient temperature of the room where the calibration is performed. If a THUM 
device (USB hygrometer) is plugged in and configured this field will auto populate. 

Humidity: Enter the Relative Humidity of the room where the calibration is performed. This field is also 
auto populated with a configured THUM device. 

Technician: The individual who performed the calibration. This field is auto populated from the Technician field on 
the parent Equipment record. 

As Found: Record the condition of the equipment when it was received for calibration (e.g., Out of Tolerance or In 
Tolerance). This field gets auto-populated when the results are tied to the results of the Measurement Groups. 

As Left: Record the condition of the equipment at the end of the Calibration Event. This field is auto-populated 
when using Measurement Groups because the results of the groups are tied to the overall result of the 
Calibration Event. 

Remarks: Use this field for any remarks related to the Calibration Event. 
 

Refer to Measurement Groups section. 

Attachments|Documents|Notes|Parts Tab 
This panel grid contains the Attachments, Documents, All Notes, and Part Numbers grids. Use the Add, Link, Edit, Unlink, 
and Delete buttons at the bottom of each panel grid to edit the information. Resize the panel grids by clicking and 
dragging the spacer bars. 

Attachments: Attach a certificate PDF provided by an external calibration company, a cal worksheet, or link other 
existing Attachments to this calibration record. 

Documents: Attach your Procedures to this calibration event, if it is not already linked to the Equipment record. 
 

Notes: Link other existing Note records to this calibration or add a new Note. 
 

Part Numbers: Link more information from Part Number records to this calibration. 

https://www.apesoftware.com/calibration-control/help/attachments-pictures
https://www.apesoftware.com/calibration-control/help/number-masks
https://www.apesoftware.com/calibration-control/help/companies
https://www.apesoftware.com/calibration-control/help/thum
https://www.apesoftware.com/calibration-control/help/thum
https://www.apesoftware.com/calibration-control/help/people
https://www.apesoftware.com/calibration-control/help/attachments-pictures
https://www.apesoftware.com/calibration-control/help/documents
https://www.apesoftware.com/calibration-control/help/notes
https://www.apesoftware.com/calibration-control/help/part-numbers
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Standards|Misc. Tab 
Calibration Standards can be tied to a calibration event in three tiers of traceability for the test/master gages used. 
You can select Standards at the Calibration record level, the Measurement Group level, and/or at the Nominal level. 

This tab allows you to identify the Standards used in the overall Calibration event level. 
 

 
Miscellaneous information related to the Cal Event is also available in this tab: 

 

Use Count: Shows how many times the equipment being calibrated has been used since its last calibration. 
 

Approval: Checking the box in this tab approves and locks the current Calibration Event record from future 
editing. If the current user is signed-in at the time the box is checked, that Person's name will be tied to the 

https://www.apesoftware.com/calibration-control/help/calibration-standards
https://www.apesoftware.com/calibration-control/help/sign-in
https://www.apesoftware.com/calibration-control/help/people
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approval of the Event and the name and date is signed on the Calibration Certificate stock report. 

Cal Cost: The actual cost of this Calibration Event. 
 

Cal Time: The actual time required to perform this Calibration Event. 
 

Last Due Date: This is the most recent Equipment Due for Calibration date, before this current event. 
 

Received for Calibration: Choose the date the equipment was received for calibration. This field auto-populates 
with the Equipment's Received for Calibration date if your setting is defined in Options with the Status Change 
feature. 

Calibration Due for Certificate 
At the bottom of the Standards/Miscellaneous tab are settings for the Calibration Certificate. 

 

Calibration Frequency: Choose the frequency of calibration, if this field does not auto-populate from the 
Equipment record. This displays on the Calibration Certificate stock report. 

Units: Choose the appropriate Frequency Units, if this field does not auto-populate from the Equipment record. 
This displays on the Calibration Certificate stock report. 

Next Cal: Select the date of the equipment's next calibration, if this field does not auto-populate from the 
Equipment record. This displays on the Calibration Certificate stock report. 

Measurement Groups: Structure and Fields 
Each Calibration Event can have several Measurement Groups or none at all. 

 

Each Measurement Group can have any number of Nominal Measurements in it. 
 

Each Measurement Group can have its own Tolerance, Unit of Measure, and Equipment Standards Used in 
Calibration. 

To illustrate, the diagram below is a single Calibration Event with three Measurement Groups with a different 
number of nominals in each Measurement Group. 

https://www.apesoftware.com/calibration-control/help/options-calibration
https://www.apesoftware.com/calibration-control/help/status-change
https://www.apesoftware.com/calibration-control/help/calibration-frequencies
https://www.apesoftware.com/calibration-control/help/calibration-frequencies#Calibration-Frequencies-tab
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Measurement Group Fields 
In the Edit Calibration dialog, under the Calibration tab, use the bottom panel grid to Add [+] Measurement Groups to 
the Calibration Event. Adding a Measurement Group presents the following terms from the Measurements tab: 

Group Number: Measurement Group Number auto-populates; change the number, if needed. 
 

Tolerance Type: Set as None, Percent (%), Manual Entry, Tolerance (+/-). The following is the result of each type: 
a. None: The Upper and Lower Limits are the same as the Nominal. 

 
b. Percent (%): [Upper Limit = Nominal + (Nominal x Plus Tolerance)] and [Lower Limit = Nominal - (Nominal 

x Minus Tolerance)] 

c. Manual Entry: Manually enter the Tolerance values. 
 

d. Tolerance (+/-): [Upper Limit = Nominal + Plus Tolerance] and [Lower Limit = Nominal = Minus Tolerance] 
 

e. Locked: Once Tolerance and plus/minus values are set, select to Lock the Tolerance Type to avoid 
accidental editing of upper and lower limits. 

Plus(+) and Minus(-): Choose the upper and lower tolerance limits when using 'Percent' or 'Tolerance' as the 
Tolerance Type. Then set the Tolerance Type to "Locked" to avoid changes. 

Mask: The Number Mask is used to set the Integer Spaces (number places to left of decimal) and Significant 
Digits (number places to right of the decimal). The first mask field controls only the Nominal Mask. The second 
mask field controls the general mask for all values other than the nominal. 

Group Name: Enter a group name for the Measurement, if needed. 
 

As Found: Automatically In Tolerance (green) or Out of Tolerance (pink) dependent on the value of the As Found 
Result column in the Measurement Grid below (yellow area). If any record has a failing result (red X), the 
Measurement Group As Found value will be Out of Tolerance. 
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As Left: Automatically Pass (green) or Fail (pink) dependent on the value of the As Left Result field in the 
Measurement Grid below (blue area). If any record has a failing result (red X), the Measurement Group As 
Left value will be Fail. 

Units: Select the Unit of Measurement for all number fields (e.g., measurements and tolerances) in the 
current Measurement Group. (When a different Measurement Unit is required for the same Calibration Event, 
create an additional Measurement Group in the Cal Event.) Edit all available Measurement Units in the combo 
box from the main Codes table. 

Measurement Notes: Add any notes specific to the current Measurement Group. 
 

 
Additional Measurement Group (MG) Features: 

Show Sequence: Check the box to enter a custom sequence order for each measurement. 
 

Show Description: Check the box to enter a custom description for each measurement. 
 

Auto Fill After: Check the box to copy As Found values and auto-fill as the As Left field values, too. 
 

Show Uncertainty: Check the box to enter Measurement Uncertainty values to the results. Double-click in the 
new Other column to enter "Expanded Uncertainty" and/or select an existing Uncertainy Study from the combo-
box. 

Show Standards: (Standards Used for Nominals) Check the box to tie standards to each measurement. 
Double- click in the new Other column Stds field to Edit Standards and select from available records. 

Sample Measurements: Double-click in the As Found or As Left fields for any measurement nominal to enter 
a range of sample measurements and use the average result as the As Found or As Left values. 
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Standards Used in Measurement Group 
Linking Standards in the Measurement Group is the most popular user method of traceability for Calibration Events. 
(You can link Standards at the Calibration record level, each Measurement Group level, and/or at the specific Nominal 
levels.) 

View the Standards Used tab to see a list of the Calibration Standards used for measurements in the current 
Measurement Group (MG). To link Standard Equipment in the MG, click on the [Edit Standards] button to bring up a list of 
available Standards to choose from. 

 

 
Check the "Use" box(es) of each Standard(s) record, and click OK. Equipment records identified as a Calibration 
Standard, and have a Calibration Due date greater than the current day, AND with its most recent (if any) Calibration 
Event as 'Passing', can be selectable from the Standards Used button. Standards that need calibration are shown in red, 
but cannot be selected. 
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Additional Tabs in the Edit Calibration Event Dialog 
There are three last tabs in the Edit Calibration dialog that help organize and display information related to the 
current Calibration Event. 

Custom Fields: Custom fields are available for adding Characters, Dates, Numbers, and Check boxes. Visit the 
Change Field Names help topic to learn how to edit these fields. 

Scatter Plot: This tab displays a Scatter Plot of the measurements entered for a given Measurement Group. 
In- Tolerance As Found measurements are displayed Green while Out-of-Tolerance measurements are Red. 

Meta: This is a READ-ONLY information tab used as a reference to view which user created the record and 
which user was the last to edit it, including the dates and times these occurred. 

Calibration Frequencies 

How do Calibration Frequencies Work? 
Calibration Frequency is the interval of time between required calibrations of any given piece of test equipment. Set 
the Calibration Frequency of Equipment in the Calibrations tab of the Equipment dialog (below). 

 

 
 
 
 
 
 
 

https://www.apesoftware.com/calibration-control/help/field-name-change
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 Calibration Frequencies 
 
The following are all the Calibration Frequencies in Calibration Control where 'n' is the number value in the Units field. 

Frequency Name Frequency Description 

Biennial Every 2 years 

Bi-Monthly Every 2 Months 

Bi-Weekly Every 2 Weeks 

Cal Not Required No Due Date . . . Not Calibrated 

 
Calibration Fields 
There are four fields involved in the Calibration Frequency function. They are: 

 

Last [Calibration]: Date of the last calibration. 
 

[Calibration] Frequency: How often the Equipment is calibrated. 
 

Units: Calculates the frequency automatically based on the unit selected. The Unit field is disabled 
with Frequencies like Yearly or Monthly because they have an inherent Unit value. 

Next [Calibration]: Due date of the next required Calibration. 
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Daily Every Day 
 

Days Every n Days 
 

Manual Set the Next Calibration (Due Date) manually 
 

Month End Every n Months due on the last day of the month 
 

Month of Every n Months due at any day within the calculated 

month Month Start Every n Months due on the first day of the month 

Monthly Every Month 
 

Months Every n Months 
 

Next Use No Due Date . . . Next Use 
 

Not Calibrated No Due Date . . . Not Calibrated 
 

Quarterly Every 3 Months 
 

Reference Only No Due Date . . . Reference 

Only Semi-Annual Every 6 Months 

Undefined No Frequency Defined 
 

Use Count Calibrate every n uses where n = Units. Use the Check In/Out dialog to 
automatically increment uses. 

 
Use Days Calibrate every n days where n = Units. Use the Check In/Out dialog to 

automatically increment uses. 
 

Week of Every n Weeks due at any day within the calculated week 
 

Weekly Every Week 
 

Weeks Every n Weeks 
 

Yearly Every Year 
 

Years Every n Years 
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“Month of” and “Week of” Frequencies 
Unlike the other Frequencies that calculate due dates on specific days, the "Month of" and "Week of" are special 
Frequencies that calculate the month or week a calibration is due. These Frequencies are also affected by two settings 
in the Options dialog for "First Day of Week" and "Due Date 'Week/Month of' Offset". By default, the "First Day of Week" 
is set to whatever is standard on your operating system. The default for the Offset is the Next Month or Week after the 
calculated due date. 

 

"Month of" Example 
• Frequency: Month of 
• Last Calibration: 04/27/2019 
• Units: 12 
• Offset: Next 
• First Day of Week: Monday 
• Calibration Due: 04/27/2020 
• Label Display: Due Month of 

Apr- 2020 

How the math works . . . 
1. Calculate 12 Months after Last Calibration, which yields 

04/27/2020 
2. The Offset is set to Next [Month] so the Due Month jumps to the 

next Month, which yields 05/1/2020 
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Referencing Calibration Standards 

How to Link Standards to Calibrated Equipment 
Linking Standards/Masters to Calibration Events in Calibration Control (our Calibration Management Software) is simple. 
They create a data trail (traceability) between national measurement standards and the Equipment Under Calibration. 

ID a Calibration Standard 
Before referencing in a Calibration Event, the Standard must exist as an Equipment record with the Calibration Standard 
checkbox checked. Find this checkbox in the Calibrations tab of the Equipment dialog. 

 

 
 
 

"Week of" Example 
• Frequency: Week of 
• Last Calibration: 06/01/2019 
• Units: 30 
• Offset: Next 
• First Day of Week: Monday 
• Calibration Due: 07/01/2019 
• Label Display: Due Week of 

07/01/19 

How the math works . . . 
1. Calculate 4 Weeks after the Last Calibration, which 

results in 06/29/2019. 

2. Since the Offset is set to Current [Week] and the First Day of 
Week is set to Monday, the Monday of the current week results 
in a due week starting on 07/01/2019. 

 

https://www.apesoftware.com/calibration-control/help/calibration-event
https://www.apesoftware.com/calibration-control/help/measurement-standards
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Grid Highlight 
By default, Calibration Standards display with a green highlight in the Equipment grid. Refer to the Highlight Colors 
help topic for more information. 

 

Link Calibration Standards 
After Equipment records for Calibration Standards are created and identified as Standards, they can be linked to 
individual Calibration Events. Double-click on a Calibration Event within the Edit Equipment dialog and click on the 
Standards/Misc tab. From there, click on the [Edit Standards] button to select Standards. Refer to the Calibration help 
topic for more information on creating a Calibration Event. 

 

 
 

https://www.apesoftware.com/calibration-control/help/color-coding
https://www.apesoftware.com/calibration-control/help/color-coding
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Available Standards 
Clicking the [Standards] button in the Measurement Group of 'Calibration Details' displays a list of available Standards. 
Unavailable Standards are those (a) standards currently out of calibration, (b) standards with their last calibration event 
with an As Left result of "Failed" or "Unknown", or (c) is the current equipment under calibration. 

 

 
Results 
The process of linking a Standard to a Calibration Event makes a copy of the calibration information for that Standard 
and stores it in the Calibration Event record. This means that when the calibration information for the Standard changes 
(after the Calibration Event), a snapshot of the Standard at the time of Calibration is preserved, which helps maintain 
accurate traceability. 

Note: If the Due Cal date has passed the present Calibration date, then the Standard is red and unavailable because it 
is past due for Calibration. 

Calibration Templates 

How to Use Calibration Templates 
A Calibration Template in Calibration Control (our Calibration Management Software) is a collection of Measurement 
Groups (without final measurement data) and other information such as calibration company, technician, remarks. 
Therefore, a Template can have multiple groups. A Measurement Group is a collection of information and standard 
measurements required each time the template is used. For more information on each of the fields within a Cal 
Template or Measurement Group, see the Calibration Event help topic. 

Default Calibration Templates 
There is a setting in program Options: 'Use Last Calibration as Template if No Template Linked' and this box is checked 
by default. When this option is checked AND if there are no other user-defined Calibration Templates linked to an 

https://www.apesoftware.com/calibration-control/help/calibration-event
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Equipment record, Calibration Control will use the most recent Calibration Event record of that Equipment as a Calibration 
Template when creating new Calibration Events. Therefore, if any history of Calibrations exist in an Equipment record, 
the next Calibration Event automatically uses the previous Calibration Event's measurements as its template. 

 

Create User-Defined Calibration Templates 
Calibration Templates can be created, edited, and managed by clicking on the Calibration Templates icon in the Calibration 
tab of the ribbon menu. 

 

 
Alternatively, a template can be created from any existing Calibration Event, by selecting the 'Make Template' button under 
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the Calibrations tab of the Calibration Event dialog. That way, you can easily create a copy of an existing template by 
opening the template you'd like to copy and simply click the [Make Template] button. Then, enter a unique template name 
and Submit. Refresh the Calibration Templates Grid (right-click and click Refresh Grid or press F5). This will show the full 
template copy as a new template record. 

 

 
Calibration Template Structure and Hierarchy 
A Calibration Template needs to be linked to an Equipment record to be useful. When linked, new Calibration Events will 
automatically contain the structure of the linked Calibration Template so that only Measurement data (As Found / Left 
results) will need to be entered and Calibration Standard(s) will need to be linked for the record. Note: Calibration 
Worksheets also replicate the measurement structure of user-defined or default templates for consistent data collection. 

Link Templates (Hierarchy) 
Multiple methods for links exist to provide the choice of how an organization chooses to manage its calibration data. 
Therefore, choose the method that works best for your team. Referring to the diagram below, a Calibration Template can 
be linked to an Equipment record in four ways. It is even possible to link four different Templates to an Equipment record 
although only one template will be used and in the following priority: 

1. Direct (blue line): Link a Template directly to an Equipment record by selecting the Template in the Calibrations tab 
of the Equipment record. A Template directly connected to an Equipment record in this way supersedes all other 
methods. Therefore, this direct link overrides all other indirect links. 

2. Equipment Type (red line): Link a Template to an Equipment Type record and then link the Type to an Equipment 
record in the Equipment tab of the Equipment's dialog. This link overrides the two that follow. 

3. Model Number (green line): Link a Template to a Model Number record and then link the Model Number record to 
the Equipment record in the Equipment tab of the Equipment's dialog. 
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4. Equipment Type – Model Number (yellow line): Link a Template to an Equipment Type, which is linked to a 
Model Number, and then is finally linked to an Equipment record. This is the lowest priority. 

 

Attachments 

Add Attachments to Equipment and Calibration Records 
Add attachments to an Equipment record by double-clicking on a record and navigating to the 'Attachments | Documents | 
Notes |Parts' tab, where you will find the [Attachments] panel grid. Use this panel grid like you would any other grid: 
Add, Link, Edit, Unlink, or Delete attachments. To add a new attachment click on the green [+] button and choose whether 
to add a File, Link to File, add a Folder path, or a URL path. 
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Add File, Link to File, Folder or URL 
[Add File] means a copy of the attachment will be made and saved in the Attachments folder (located in the Files 
Folder). The [Link to File] selection means the file being attached will stay at its current location and a link to that location 
will be saved in the database. Adding a link to a specific folder is helpful if more than one file is being attached. The [Add 
Folder] and [Add URL] buttons allow a user to copy and paste a path to a specific folder (directory) or website. 

 

Edit Attachment 
Within an Equipment record or in the Attachments grid, you can double-click on an attachment to edit the record and 
add information related to it such as title, category, owner (if the image is of a piece of equipment), and a description. 

 

 
In the Equipment |Calibrations | Companies | People tab, you can view all records linked to the attachment. You can also 
add, link, and unlink records to the attachment. Similiarly, in the Models tab, you can add, link, and unlink Model records 
to the attachment. 
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Attachments Grid 
The Attachments grid, located in the Data Grids tab of Calibration Control, displays all attachment records information such 
as file name, size, title, description, etc. 

 

 
Right click anywhere on the grid to open the context menu and click Verify All Attachments Exist. If the Attachments 
were verified, a green checkmark will appear under the Present column along with the Confirmed Present date. If an 
attachment was not verified, it likely was moved to a different location, renamed, or is otherwise not accessible to 
Calibration Control. If all attachments were not confirmed present, your Files Folder was likely changed but your 
Attachments folder was not moved to the new location. When an attachment is verified to be present, you can quickly 
open the attachment file itself by right clicking a record and select Open Attachment. 
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Additionally, in the Attachments context menu, you can select different views of the Attachments such as all 
attachments, attachments linked to Equipment, Calibrations, People, Companies, or attachments not linked to anything. 

 
 

Image in Equipment Dialog 
To add a default image for an equipment record, click on the [Image] tab within a selected Edit Equipment dialog. If no 
image is linked, you'll see a message "Right-click, Double-click or Drag & Drop to Link an Image." Double clicking will 
open a grid of existing attachments that are image files. Alternatively, you can drag and drop any image file and 
Calibration Control will create an Attachment record for that image and link to the Equipment record. Once you have an 
image linked, you can right-click to open the image, unlink the existing image or link a different an existing image. 
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Companies 

Manage Companies within Calibration Control 
Keep track of all the companies you do business with, link them to other records, and manage report overrides using 
the Company grid and dialog. Find the Companies grid in the Common tab of the menu ribbon of Calibration Control 
(our Calibration Management Software). 

 

 
The grid header shows a count of your number of Company records (or how many filtered records). Right-click in the 
Companies grid for an alternate grid view to include the Company Types from the context menu. Note the grid header will 
show a higher count if any records have more than one linked Company Type. 

 

https://www.apesoftware.com/calibration-control/help/filter-row
https://www.apesoftware.com/calibration-control/help/company-types
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Company Dialog 
Use the Main tab to organize all information related to the company itself. 

 

Name: The name of the Company. This is the only required field for a new Company record. 
 

ID Number: Assign an identification number to a company record. 
 

Web: The company's website URL. 
 

Status: Select the status of the company (Active, Approved, Inactive, etc). 
 

Next Onsite: Select the date that a technician will return on site again. 
 

Do Not Auto Email: Select this checkbox to exclude this company from Auto Email Notifications. 
 

Primary and Alternate Addresses: Enter mailing, billing, or physical address(es). 
 

Notes Field: Enter short notes or remarks related to this Company record. 
 

 

Email, Phones, People, and Types Dialog 
Use these panel grids to keep track of the email addresses, phone numbers, people, and company types associated 
with the Company record. 

Email Addresses: Click on the chain link icon to link an existing email address to a company record or click on 
the green [+] icon to create a new record. Within the email address dialog, select the Type (i.e., Personal, Work, 
Other) and choose whether the email is Primary, Opted Out, or Invalid. You are also able to easily link or add 
Company and People records to the email address record right from the dialog. 

Phone Numbers: Add and link phone and fax numbers to a Company record. Within the phone numbers 

https://www.apesoftware.com/calibration-control/help/auto-notify
https://www.apesoftware.com/calibration-control/help/email-addresses
https://www.apesoftware.com/calibration-control/help/phone-numbers
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dialog, select the Type (i.e., Direct, Fax, Office) and choose whether the number is Primary, Opted Out, or Invalid. 
You are also able to easily link or add Company and People records to the phone number record right from the 
dialog. 

People: Use this tab to link a Person record to a Company. (Use the chain link and green [+] icons, just like the 
other panel grids.) You can designate someone as the 'Due Cal Contact' at this company for auto-emails. To select 

a person as the 'Due Cal Contact', open their Person record and within the Main tab check the 'Company Due 
Cal Contact' checkbox. 

Company Types: Link a Company Type using the 6 checkboxes to specify if it is a Site, Manufacturer, Calibration 
Service or Maintenance Provider, Client, Supplier, or Other. 

 

 
Notes and Attachments Tab 
Keep track of all notes, certificates, file documents, and/or pictures related to a Company record by using these panel grids. 

 

Notes: Create new or link existing Notes associated with the Company record. 
 

Attachments: Add new or link existing Attachments to a Company record, such as documents or images. 

https://www.apesoftware.com/calibration-control/help/people
https://www.apesoftware.com/calibration-control/help/auto-notify
https://www.apesoftware.com/calibration-control/help/company-types
https://www.apesoftware.com/calibration-control/help/notes
https://www.apesoftware.com/calibration-control/help/attachments-pictures
https://www.apesoftware.com/calibration-control/help/documents
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Other Tabs 
Overrides Tab: While default labels and reports are defined at a global (application) level in the Options 
dialog, overrides for the Labels and Reports listed here can be entered for a specific Company. 

Custom Tab: Custom fields are available for adding Characters, Dates, Numbers, and Check boxes. Visit the 
Change Field Names help topic to learn how to edit these fields. 

Meta Tab: This is a READ-ONLY information tab used as a reference to view which user created the record 
and which user was the last to edit it, including the dates and times these changes occurred. 

https://www.apesoftware.com/calibration-control/help/field-name-change
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Company Types 

Edit Company Type Codes 
Although any number of Company Type codes can be created, there are six types important to Calibration Control (our 
Calibration Management Software). These six Company Types are: Site, Manufacturer, Calibration Service (or 
Maintenance Provider), Client, Supplier, or Other. These six types will identify which categories that a Company record 
of that Type can show up as combo-box choices in a drop-down selection for other records, (e.g., as a Calibration 
Company for a Calibration Event, etc.) 

Display this grid by clicking on the Company Types icon in the Data Grids tab of the ribbon menu. 

https://www.apesoftware.com/calibration-control/help/companies
https://www.apesoftware.com/calibration-control/help/calibration-event
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Company Types Dialog 
Create a Company Type name and mark check-boxes to specify if that Type is a Site, Manufacturer, Calibration Service 
or Maintenance Provider, Client, Supplier, or Other. 

 
 

Link to Company Records 
Under the Companies tab of the Edit Company Types dialog is a panel grid where you can add, link, edit, or 
unlink Companies that fall under a specific Company Type. 
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Other Tabs 

Custom Fields: Custom fields are available for adding Characters, Dates, Numbers, and Check boxes. Visit the 
Change Field Names help topic to learn how to edit these fields. 

Meta: This is a READ-ONLY information tab used as a reference to view which user created the record and 
which user was the last to edit it, including the dates and times these occurred. This tab is populated 
automatically for security purposes and is not editable. 

Equipment Systems 

Groups of Equipment Records 
Combine separate equipment records in Calibration Control (our Calibration Management Software) into a group 
(system) for any purpose, such as creating a single test system. 

View Systems Grid 
Select the Systems feature from the Calibration tab of the menu ribbon. 

 

 
 

https://www.apesoftware.com/calibration-control/help/field-name-change
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Equipment System Dialog 
From the Systems grid, double-click to open a record or right-click to use the context menu. Use the Equipment 
System dialog to enter and edit information related to Equipment Systems. 

 

 
System Name: Name of the System. This is the only required field for a new Systems record. 

 

System Code: Shorter code name of the System 
 

Site: Company field for geographic Site or Company. 
 

Department: The department in your organization where the System is currently located. 
 

Location: The location within the department where the System can be found. This could be a specific area or work 
place, even an engineer's desk. 

Status: Select the system's current Status from the combo box. 
 

Custodian: Select an individual who has possession or custody of a System. 
 

Technician: The person who normally calibrates this System. 
 

Owner: The System Owner (Person field), if not the organization. 
 

Checked Out By: This field will auto-populate if a Person was required or identified during check out. 
 

Checked Out: This field will auto-populate with the date if the System is currently checked out. 
 

Certificate: Certificate number that was issued by the organization responsible for its last Calibration 
event. Primarily used as an aid for traceability back to a national measurement standard, especially if this System 
is a Calibration/Test Standard. 

Notes: Add short descriptions to an Equipment System record. 

 

https://www.apesoftware.com/calibration-control/help/companies
https://www.apesoftware.com/calibration-control/help/departments
https://www.apesoftware.com/calibration-control/help/codes
https://www.apesoftware.com/calibration-control/help/status-change
https://www.apesoftware.com/calibration-control/help/people
https://www.apesoftware.com/calibration-control/help/people
https://www.apesoftware.com/calibration-control/help/people
https://www.apesoftware.com/calibration-control/help/check-in-out
https://www.apesoftware.com/calibration-control/help/check-in-out
https://www.apesoftware.com/calibration-control/help/notes
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Equipment Tab 
To assign Equipment records to an Equipment System, select the Equipment tab in the System dialog. Click the link button 
to choose which Equipment records belong to this System. 

 

 
 

(An alternative method to link Equipment records to an Equipment System is shown in the next section below.) 

Notes Tab 
Create a new Note record or link existing Notes related to this Equipment System. 
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Custom Fields Tab 
Customizable fields are available to rename and utilize Characters (text fields), Dates, Numbers, and Check boxes 
(booleans). Visit the Change Field Names help topic to learn how to edit these field names. 

 
 

Meta Tab 
This is a READ-ONLY information tab used as a reference to view which user created the record and which user was 
the last to edit it, including the dates and times these occurred. 

Mass Update Function 
Update Equipment Records: Edit System fields and apply those changes to all related Equipment records tied to that 

https://www.apesoftware.com/calibration-control/help/field-name-change
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System with the [Update Equipment Records] button of the System dialog. 
 

 
From the pop-up dialog, confirm which fields should update for all linked Equipment. All fields are checkmarked by 
default. Blank fields are empty values that will also update (and clear those fields in) the related Equipment 
records. 

 
 

Link System to an Equipment Record 
An alternative method to assign an open Equipment record to an existing Equipment System is in the Misc tab of 
the Equipment dialog. All Equipment Systems will be listed in the combo box to choose a System Name to which 
the Equipment belongs. 
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Print Asset Label 
Configure default System Asset Labels in program Options > Report & Label. 

 
Print System asset labels with barcodes to Use Scanner in the Check Out feature dialog. 

Check Out an Equipment System 
Enter a valid Equipment System Name in the Check Out dialog to check in and out the group collection of equipment at 
one time. The 'Equipment ID' field n the Check Out dialog reflects 'System ID' once a System is validated. 

https://www.apesoftware.com/calibration-control/help/options
https://www.apesoftware.com/calibration-control/help/options-report-label
https://www.apesoftware.com/calibration-control/help/check-in-out
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The Equipment System record will update to show the recent check out date and/or person, and all related 
Equipment records linked to that System will update as well. 
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Equipment Types 

Classify Equipment and Link to Calibration Templates 
Although the Equipment Type in Calibration Control can be used for any classification, its intent is specifically related to 
ease of equipment selection and the management of Calibration Templates. For instance, even though generic 6 inch 
calipers are made by several manufacturers, their use and calibration is usually the same. Therefore, creating an 
Equipment Type of "6 Inch Caliper" can be a useful grouping. 

Additionally, a single Calibration Template (calibration method) for 6 inch calipers can be linked to one Equipment Type 
record, which in turn is linked to all the Equipment records of the same type. Using Equipment Types and Calibration 
Templates together like this provides calibration management with the ability to define and apply more consistent calibration 
controls. 

Equipment Types Grid 
Display the Equipment Types grid by clicking on the 'Equipment Types' icon in the Data Grids tab of the ribbon menu. 

https://www.apesoftware.com/calibration-control/help/calibration-templates
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Equipment Types Dialog 
Double-click on a record to open and edit or double-click in the gray space to open a new record dialog box. Right-
click inside the grid for the context menu. 

Type Name: The name of the Equipment Type or group of equipment. This is a required field. 
 

Type Code: The unique code for the Equipment Type or group of equipment. This is a required field. 
 

Size/Range: Select the Size and Range of the equipment. 
 

Calibration Template: Though not required, Equipment Types can be linked to a corresponding Calibration 
Template . This may influence the naming convention for the Equipment Type. 

Procedural Group: Allows users to define step-by-step procedures that appear on Calibration Worksheets or within 
Custom Reports. 

 
 

 

https://www.apesoftware.com/calibration-control/help/calibration-templates
https://www.apesoftware.com/calibration-control/help/calibration-templates
https://www.apesoftware.com/calibration-control/help/calibration-worksheets
https://www.apesoftware.com/calibration-control/help/custom-report
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Other Tabs 
There are four other tabs within this dialog to help manage the Equipment Type records. 

 

Equipment Tab: Use this panel grid to link equipment to an equipment type record. 
 

Uncertainty Tab: Use this panel grid to add or link an Uncertainty Study to an Equipment Type record. 
 

Overrides Tab: While default labels and reports are defined at a global (application) level in the Options 
dialog, overrides for the Labels and Reports listed here can be entered for a specific Equipment Type. 

Meta Tab: Shows a READ-ONLY log of who created the record and when, as well as who updated the record 
and when. This tab is populated automatically for security purposes and is not editable. 

 

Size and Range in Calibration Control 

Edit the Size and Range Combo Values of Equipment 
Add, edit, or delete the selectable values for the "Size/Range" field for Equipment in Calibration Control. Using 
these standardized values for size and range provide for more consistent data entry and Equipment searches. 

Menu 
Find the Size and Range values within the Codes grid, which is located in the Data Grids tab of the ribbon menu. 
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Dialog 
Use the Size/Range dialog to edit all information related to the different sizes and ranges of equipment that will appear 
under the Size/Range combo box in Calibration Control Equipment Records. This dialog includes custom fields and Meta 
data. 
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Model Numbers 

Keep Track of Equipment Model Numbers 
Model Numbers are specific to each piece of equipment and the Model Numbers grid keeps them organized within 
Calibration Control (our Calibration Management Software). Find this grid in the Data Grids tab of the ribbon menu. 
The Model Numbers' dialog can also be accessed within the "Edit Equipment" dialog by clicking on the [Model] button in 
the Equipment tab. 

 

 
Model Number Dialog 
Double click on a selected record to edit it or double-click within the gray area to create a new record. 

 
Within the dialog, specify the model number, model description, and notes. Add information like Manufacturer, Equipment 
Type, Measurement Template, Procedure Group, and its Size/Range using the drop down menus. Check or uncheck the 
[Active] box to show if it is in use or not. 
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Uncertainty Tab 
Add or link an uncertainty study to a model number record. 

 

 

Overrides Tab 
Use the Overrides tab to choose a different equipment label or equipment report. Click on a blue hyperlink and select 
the desired file name then click [Open]. Remove an override by clicking on its corresponding red [X]. Examples of all 
the labels can be found in the "Labels" section of our Help Topics page. 
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Custom Tab 
The Custom tab allows you to create unique fields that pertain to your company. Edit these using the "Edit Form 
Labels" feature under the Admin tab of the Program Options dialog. Select the dialog to be edited (i.e., "ModelNumber") 
from the drop down menu and create your custom content by editing the Control Text. Make sure to click the [Close] 
button in order to save changes. 

 

 

Meta Tab 
This is a READ-ONLY information tab used as a reference to view which user created the record and which user was 
the last to edit it, including the dates and times these occurred. 

 

Departments 
Use the Departments grid and dialog to edit data related to Departments that appear in Calibration Control (our 
Calibration Management Software) Equipment Records. Display the Departments grid by clicking on its icon in the Data 
Grids tab of the ribbon menu. 
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Edit Department Dialog 
Manage information related to a Department record: 

 

Department: The name of the department. This is a required field. 
 

Code: A short identifier or acronym for the Department. This is a required field. 
 

Type: The department type (i.e., Fabrication, Engineering, etc.). 
 

Manager: The Department Manager; Person to whom Calibration Control can send emails. 
 

Contact: The Department Contact; Person to whom Calibration Control can send emails. 
 

Is Active Checkbox: If checked, this shows that the Department Code is actively being used in the database. 
 

Notes: A notes field for the department record. 
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Other Tabs 
Within the Departments dialog there are three other tabs besides the main Department tab. The first is for Notes related 
to the Department dialog that can be added or linked from other records. 

The Custom tab contains fields that can be customized to add Characters, Dates, Numbers, and Check boxes. Visit 
the Change Field Names help topic to learn how to edit these fields. 

The Meta tab shows a READ-ONLY log of who created the Department record and when, as well as who updated 
the record and when. This tab is populated automatically for security purposes and is not editable. 

Part Categories 

Create Part Category Codes to Assign to Parts 
Open the Part Category grid by clicking on its icon in the Data Grids tab of the ribbon menu. Double-click in the gray 
area to create a new record or right-click and select 'New Record'. Type out a short category code (usually an 
acronym) and then a short description of the part. Check the Active checkbox if this part category is active, and check 
the Taxable checkbox if this part is taxable. 

 

https://www.apesoftware.com/calibration-control/help/field-name-change
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Other Tabs 
Custom Fields: Custom fields are available for adding Characters, Dates, Numbers, and Check boxes. Visit the 
Change Field Names help topic to learn how to edit these fields. 

Meta: This is a READ-ONLY information tab used as a reference to view which user created the record and 
which user was the last to edit it, including the dates and times these occurred. 

Assign a Part Category to Part Number Record 
Within the General tab of the Edit Part Number dialog, select the Part Category from the 'Category' drop-down menu. 

 

Part Numbers 

Manage Part Numbers Related to Equipment 
Part Numbers are specific to each piece of equipment and the Part Numbers grid keeps them organized within 
Calibration Control (our Calibration Management Software). Find this grid in the Data Grids tab of the ribbon menu. 

 

https://www.apesoftware.com/calibration-control/help/field-name-change
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Edit Part Number Dialog 
Use the General tab to organize all information related to part numbers. 

 

Part Number: Unique number assigned to the part record. 
 

Part Name: The name of the part record. 
 

Description: A physical description of the part. 
 

Category: The category that a part is assigned to. 
 

Standard Cost: The standard cost of the part. 
 

List Price: The listing price of the part. 
 

Discontinued: If the part has been discontinued, select the appropriate date. 
 

Taxable and Active Checkboxes: Check the corresponding box if a part is taxable or active. Leave the boxes 
unchecked if it is not. 

Notes: Add any notes related to the part number. 

 
 

Part Number Sources 
The Sources tab provides a list of the top 3 suppliers that your company uses to purchase specific parts and their 
specific part numbers. It also includes a drop-down to choose their manufacturer. 

Note: Designate a 'Supplier' by navigating to the Companies grid, opening a record, and clicking on the 
[Email/Phones/People/Types] tab. Once there, within the Company Types panel grid click on the [Link] icon and select the 
"Supplier" status. 
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Equipment & Calibrations 
This tab contains panel grids used to link Equipment and Calibrations to a Part Number record. Use the buttons at 
the bottom of the dialog to link, edit, and unlink records. Click and drag on the middle gray bar to resize the panel 
grids. 
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Work Orders 
Create and manage work orders related to a part number. Click the green [+] icon to add a new Work Order record. 
Within this new dialog, add information related to a part number's 'Requestor', 'Department', 'Location', which account it's 
linked to, which category it's in, the priority level, and a space for a description. Link equipment to the work order if 
necessary. 

 
 

Other Tabs 
Custom: Visit the Change Field Names help topic to learn how to customize this tab for your company's needs. 

 

Meta: This is a READ-ONLY information tab used as a reference to view which user created the record and 
which user was the last to edit it. 

People 
Find the People grid in the Data Grids tab of the ribbon menu. Use the Edit Person dialog in Calibration Control (our 
Calibration Management Software) to edit all information related to the People you interact with for your company and 
link them to other records using the panel grids. 

https://www.apesoftware.com/calibration-control/help/field-name-change
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Person Dialog 
Add information to a Person record: 

 

Salutation/First Name/Last Name: First and Last Name of the Person, Salutation when applicable. These are 
the only required fields for a new Person record. 

Display Name: Auto-filled by First and Last Name fields. 
 

Title: The Person's job title, if available. 
 

Department: The Department the Person is currently assigned to in their Company. 
 

Location: Use this drop-down when applicable. 
 

Status: The Person's status within the company they work for. 
 

ID Number: The Person's unique company ID, if applicable. 
 

Is Active: Select whether or not the Person has an active account in your records. 
 

Primary and Alternate Addresses: The Person’s address(es), if applicable. 
 

Notes: A blank space for notes related to the Person record. 
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Update Equipment Locations 
Click on the [Update Locations] button at the bottom of this dialog to synchronize the Department and Location fields of 
all Equipment records to include the selections chosen for this Person. 

 

 
Grids Dialog 

Email Addresses: Add or link an Email address to a person record. 
 

Phone Numbers: Add or link phone and Fax numbers to a person record. 
 

Companies: Add or link a person record to an existing company record. 
 

Attachments: Add or link attachments to a person record. 
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Other Tabs 
Notes Tab: Add and link Notes to a Person record. 

 

Custom Fields Tab: Custom fields are available for adding Characters, Dates, Numbers, and Check boxes. 
Visit the Change Field Names help topic to learn how to edit these fields. 

Meta Tab: This is a READ-ONLY information tab used as a reference to view which user created the record 
and which user was the last to edit it, including the dates and times these occurred. 

Documents Dialog 

Procedures Are Now Known as Documents 
Easily link company Documents (e.g., Calibration Procedures) and related Equipment in Calibration Control (our 
Calibration Management Software). Find the Documents icon under the Data Grids tab of the ribbon menu. 

https://www.apesoftware.com/calibration-control/help/field-name-change
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Edit Document Dialog 
Double-click on a Document record to open and edit it. The Edit Document dialog contains 4 tabs: 

 

Document: Add information related to the Document including its number, title, active status, type, class, subject, 
Document URL, and a space for notes. Click on any of the grey shaded boxes to add a new field for that drop- 
down. 

Equipment/Calibrations Panel Grids: Use the panel grids for adding and linking equipment and calibrations to a 
Document record. These panel grids can be filtered and sorted using the Filter Row at the top of each grid. 

Custom Tab: Visit the Change Field Names help topic to learn how to customize this tab for your company's needs. 
 

Meta Tab: This is a READ-ONLY information tab used as a reference to view which user created the record 
and which user was the last to edit it. 

https://www.apesoftware.com/calibration-control/help/field-name-change
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Link Documents to Equipment Records 
From the Documents Grid: Within the Grids tab of the Document dialog click on the 'chain link' icon to link 
a specific piece of equipment to that Document. 

 

 
From the Equipment Grid: Within the Grids tab of the Edit Equipment ID dialog click on the 'chain link' icon 
within the Documents panel grid. 
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Link an existing Document or Equipment ID by highlighting its row and clicking the [Select] button. 

 

Email Addresses 
Organize email addresses related to Companies and People within Calibration Control (our Calibration Management 
Software). Find the Email Addresses grid in the Data Grids tab of the ribbon menu. 
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Email Address Dialog 
Add a new email address by clicking in the gray area of the grid, or right-click for the context menu and select [New 

Record]. Enter the email address and select the 'Type' (i.e. personal, work, or other). Check boxes are available 
for selections of 'Primary', 'Opted Out', and 'Invalid' which display as green checkmarks in the grid. 

 

Companies Tab 
Use the Companies panel grid to link email address records to a specific Company. Use the icons at the bottom of 
the panel grid to add, link, edit, or break a link (i.e. remove a linked record without deleting it from the database). 
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People Tab 
Use the People panel grid to link email address records to a specific Person. Alternatively, double-clicking in the gray 
area of the panel grid will open a New Person dialog, and clicking on an existing record will open the Edit Person dialog. 

 

 

Other Tabs 
Custom Tab: Custom fields are available for adding Characters, Dates, Numbers, and Check boxes. Visit the 
Change Field Names help topic to learn how to edit these fields. 

Meta Tab: This is a READ-ONLY information tab used as a reference to view which user created the record 
and which user was the last to edit it; including the dates and times these occurred. 

Phone Numbers 
Organize phone numbers related to Companies and People within Calibration Control (our Calibration Management 
Software). 

https://www.apesoftware.com/calibration-control/help/field-name-change
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Phone Number Dialog 
Add a new phone number by double-clicking in the gray area of the grid, or right click for the context menu and select [New 
Record]. Enter the phone number with area code in the desired format and then select the number type from the drop- 
down menu (i.e., Office, Main, Fax). Check boxes are provided to designate the phone number as 'Primary', 'Opted Out', 
or 'Invalid'. 

 

 
Companies Tab 
Use the Companies panel grid to add and link Companies to a specific phone number record. Double-click in the gray 
area within the panel grid to add a new Account record, or double-click on an existing record to edit. 
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People Tab 
Use the People panel grid to add and link People to a specific phone number record. Double-click in the gray area 
within the panel grid to add a new Person record, or double-click on an existing record to edit. 

 

 

Other Tabs 
Custom Tab: Custom fields are available for adding Characters, Dates, Numbers, and Check boxes. Visit the 
Change Field Names help topic to learn how to edit these fields. 

Meta Tab: This is a READ-ONLY information tab used as a reference to view which user created the record 
and which user was the last to edit it; including the dates and times these occurred. 

Notes 
Create a note within an existing record to organize extra information. Changes such as an asset transfer, asset issue, 

https://www.apesoftware.com/calibration-control/help/field-name-change
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asset receive, check out, and status change are also recorded as note records. 

Notes Grid 
Access the Notes grid by clicking on the notepad icon in the Data Grids tab of the ribbon menu. 

 

 
Notes Dialog 
Use the Notes dialog to organize information related to the Note and its relationship to Equipment, Companies, 
and People. This dialog also includes a Custom and Meta tab. 

 

Easily keep track of all the equipment records associated with a specific Note by linking them using the panel grid in 
the Equipment tab. From within the 'Edit Equipment' dialog (in the Equipment grid), add a new Note to a record and it 
will automatically be available in the Notes grid. 
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In the Companies tab, add or link Companies to a Note record. When a Note is added to a Company record it will 
be available in the Notes grid. 

 

 
Add and link People to a Note record using the People tab of the Notes dialog. When a Note is added to a Person record 
it will show up in the Notes grid. 
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Other Tabs 
Custom Tab: Custom fields are available for adding Characters, Dates, Numbers, and Check boxes. Visit the 
Change Field Names help topic to learn how to edit these fields. 

Meta Tab: This is a READ-ONLY information tab used as a reference to view which user created the record 
and which user was the last to edit it; including the dates and times these occurred. 

Application Codes 
All of the simple codes (used in drop downs and other locations) are kept in a single Codes grid for easy reference 
and update. To edit a Code record, click on the Codes icon within the Data Grids tab of the ribbon menu. 

By default the Codes grid is in groups for ease of use; click on a [+] icon from the left side to expand each category 
and double-click on a record to edit it. 

https://www.apesoftware.com/calibration-control/help/field-name-change
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Codes List 
To view a full list of Code groups, open the Codes grid in the Data Grids tab. You can also visit our Codes help page. 

Adding a New Code 
Right click in the Codes grid to bring up a new Add Code dialog. Required fields are highlighted PINK by default. 

 

Code: The code name that appears in the drop down menu. 
 

Code Short: Acronym or a shortened version of the code name. 
 

Group: The category that the code belongs to, such as Locations. 
 

Sequence: The number order this code will appear in the drop down menu. 
 

Is Active checkbox: Allows you to show or hide a code in the dropdown menu. 
If you select the Locations group, you will have a Sub Location dropdown menu to allow you to add a sub 
location. To do this, create a new code record and choose the Location Types group. Save the record and it will 
become an option for Sub Locations. 

If you select the Status - Codes Equipment group, selecting the Is Hidden checkbox allows you to hide 
an Equipment record if the status code is marked Is Hidden. 

https://www.apesoftware.com/calibration-control/help/codes
https://www.apesoftware.com/calibration-control/help/required-fields
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Custom Tab 
Custom fields are available for adding Characters, Dates, Numbers, and Check boxes. Visit the Change Field Names help 
topic to learn how to edit these fields. 

 

https://www.apesoftware.com/calibration-control/help/field-name-change
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Meta Tab 
This is a READ-ONLY information tab used as a reference to view which user created the record and which user was 
the last to edit it, including the dates and times these occurred. 

 

Program Options 

Modify Application Settings 
You can modify Calibration Control (our Calibration Management Software) program options by going to the File menu 
and selecting Options or access the Options dialog in the Utilites tab of the ribbon menu. 

 

 
General Tab 

First Day of Week: By default, Calibration Control uses the System defined first day of the week. Otherwise, you 
can define the first day of the week using the dropdown. This setting determines the due date for calibrations using 
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the 'Week of' Frequency. 

Due Date 'Week/Month of' Offset: When calculating the calibration due date for the 'Week of' and 'Month of' 
frequencies, the Calibration Due Date is calculated by adding the Week of/Month of units to the Last Calibration and 
then choosing the first day of the Current OR Next week/month. 

Check for Program Updates: Calibration Control can notify you of available software updates on a Daily, Weekly, or 
Monthly cycle when the application is first opened. By default, you will receive daily updates. 

Measurement System: Use the drop-down to switch the default measurement system between U.S. and Metric. 
 

Equipment ID of Default Template: Enter the Equipment ID of an existing Equipment record to be used as a 
template when creating new Equipment records. 

Unique Alternate Equipment ID: Determine whether Alternate Equipment ID's should be unique or not, or be unique 
within a given Site. Note that Equipment ID's are required to be unique. 

Language: Select the language displayed. Changing the language requires a program restart. Alternatively, you may 
select a language for each specific User. 

Label Printer: When multiple label printers are installed on a single computer, identify the default label printer in this 
field. 

Start Screen: Select your default start screen when opening Calibration Control. By default and when no selection 
is made, the Equipment grid will be the start screen. To have no start screen, select "None" from the dropdown. 

Do Not Copy Default Labels, Reports & Emails on Start: If any default labels or reports are missing, 
Calibration Control will add the missing files to your files folders. Check this box to prevent the action. 

Use Active Equipment as Default for Asset Transfer: If this box is checked, any selected Equipment record 
will automatically be populated in the Asset Transfer dialog. 

Dialog Font Size: Define the size of all dialogs with 0 being the default. You can also use negative values to shrink the 
dialog size. 

https://www.apesoftware.com/calibration-control/help/users
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Calibration Reference Records - Add Missing 

Check Out Reference Records - Refresh All 

Email Report & Label 

Folder & Path Security 

Highlight Colors Switch to Sample Database* 

 

 

Advanced Tab 
The Advanced tab is split up into separate dialogs for each category. Click each link below to learn more about each option. 

 

 
 

 
 

https://www.apesoftware.com/calibration-control/help/options-calibration
https://www.apesoftware.com/calibration-control/help/options-ref-records
https://www.apesoftware.com/calibration-control/help/options-checkout
https://www.apesoftware.com/calibration-control/help/options-ref-records
https://www.apesoftware.com/calibration-control/help/options-email
https://www.apesoftware.com/calibration-control/help/options-report-label
https://www.apesoftware.com/calibration-control/help/options-folders
https://www.apesoftware.com/calibration-control/help/options-security
https://www.apesoftware.com/calibration-control/help/color-coding
https://www.apesoftware.com/calibration-control/help/sample-database#SwitchtoSampleDB
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* When using the sample database, this button will show "Refresh Dates in Sample DB" which will update sample calibration due dates to 
more recent dates. 

Allow Multiple Equipment Browse Grids: When this option is selected, you have the ability to open 
additional equipment tabs at once. 

Remember Grid Layouts: When this option is selected, your layouts for all grids are saved and stored as a layout 
file. When you sign back in to Calibration Control, your grid layouts will remain as you left them, otherwise, they are 
reset to default. 

Show and Hide Fields in Grids: When this option is selected, you can right click any grid and select the Show 
Fields dialog which allows you to show or hide fields in the specified grid, otherwise, the Show Fields item will be 
greyed out and inactive. 

 

Masks - Number 

Visibility Masks - Date 

Spell Checker Label Edit 

https://www.apesoftware.com/calibration-control/help/number-masks
https://www.apesoftware.com/calibration-control/help/feature-visibility-options
https://www.apesoftware.com/calibration-control/help/date-masks
https://www.apesoftware.com/calibration-control/help/options-spellcheck
https://www.apesoftware.com/calibration-control/help/field-name-change
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Options - Calibration 
Within the Option dialog's Advanced tab, modify Calibration Control's Calibration settings to fit your company's standards. 

 

Status on Calibration Pass: Select a status that will be applied to an Equipment record when a new Calibration 
event has Passed. 

Status on Calibration Fail: Select a status that will be applied to an Equipment record when a new Calibration 
event has Failed. 

Received for Calibration Status: When using the Status Change dialog, if the selected status is set, three changes 
are made to the related Equipment dialog: (a) the Status is changed to the selected status, (b) the Received field is 
set to TODAY, and (c) a note record is created describing the event. 

Reminder Lead Days: The number of days that determine which equipment is "soon due" and will appear in the 
Due Cal report and when browsing equipment that is due for calibration. 

Max Measure Groups to Submit at Once: The maximum number of measurement groups you can submit at once. 
By default, the value is 0 which indicates there is no max. 

Second Pause between MG Submit: The number of seconds to pause between each measurement group being 
submitted. By default, the value is 0 which indicates there is no pause between submitting measurement groups. 

Manually Set Due Dates in Equipment Dialog: Normally, the Calibration Due (Next Cal) is automatically calculated 
based on the Last Calibration and the Calibration Frequency. Therefore, checking this option for manual set will 
disable the automatic calculation. 

Ask to Print OOT Worksheet When Received OOT: With this option checked, the User who saves a Calibration 
Event with the Received Out-Of-Tolerance (OOT) condition will be asked if the OOT Worksheet should be printed. (Works 
with the next option below.) 

Null Cal Received Date on Successful Cal: (Usually used in conjunction with the above Received for Calibration 
Status feature) With this option checked, when a new Calibration is saved with a 'Passed' Status then the Received 
[for Calibration] field in the Equipment record is automatically nulled. 

Use Last Calibration as Template if No Template Linked: With this option checked, creating a new Calibration Event 
uses the most recent Calibration Event as the Measurement Template if no Template is otherwise linked for that 
Equipment. 

Prevent Entry of Future Date for Calibration Dates: Prevent the manual entry of a calibration due date in the future. 
 

Work Days: Select which days of the week are considered work days for calibrations. 

https://www.apesoftware.com/calibration-control/help/status-change
https://www.apesoftware.com/calibration-control/help/calibration-templates
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Options - Check Out 
Configure settings for the Check Out dialog in Calibration Control and CC Terminal. 

 

Prevent Check Out if already Checked Out: Users will be required to Check In an equipment before attempting 
to Check Out. 

Default Use Count Check In/Out Quantities: Define the Default Use Count quantity for Check In and Check Out 
using the corresponding fields. 

Auto Assign Authenticated User in Check Out Dialog: When using User Authentication (Sign-in mode), the user 
currently signed in will automatically populate the Person field. 

Do Not Allow Check Out of Hidden Equipment: Prevent Equipment with a hidden Status from being checked out. 
 

Only Current User Can Check Out Equipment: When using User Authentication (Sign-in mode), the user currently 
signed in will be the only user allowed to Check Out equipment. 

Require Fields: 
Person Field During Check Out 

 

Work Order Field During Check Out 
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Status Field During Check In AND Out 

 

Options - Email 
Use the fields in the Email tab to setup a connection to your company or personal email server. Calibration Control makes 
use of these settings in the Auto Notify feature that sends scheduled Email notifications or messages to People identified 
in the Calibration Control. 

SMTP Server: An SMTP server address usually looks something like SMTP.YOURDOMAIN.COM . 
 

Email/Password: This is the email address (or user name) and password of the email account Ape will be sending 
mail from. 

Seconds Between Emails: Enter the number of seconds to wait between sending each email. By default, this value 
is zero. 

Port: By default, the port number is 0. Otherwise, enter the port number required by your email server. 
 

Disable CSS in Emails: The default Email templates use embedded cascading style sheets (CSS) to format text 
with colors, backgrounds, decorations, etc., especially in the table of Equipment If the email services you send 
emails to blocks some CSS, like Gmail , check this box to get a list of some minimal coloring back into the Equipment 
grid. 

Connection Settings: 
 

Connect Asynchronously 
 

Secure Socket Options 
 

https://www.apesoftware.com/calibration-control/help/auto-notify
https://www.apesoftware.com/calibration-control/help/smtp-test-procedure
https://www.campaignmonitor.com/css/
https://www.campaignmonitor.com/css/
https://www.campaignmonitor.com/css/


  
CALIBRATION CONTROL MANUAL 125 

 

Use Legacy Email (pre 9.2): Check this box if you require the "Use Secure Connection" checkbox previously used 
in versions prior to 9.2. Alternatively, you can try using a Secure Socket Option of SSL on Connect. 

Output Folder: Optionally, select a folder path for a copy of all emails sent out. The Enabled checkbox must be 
checked for emails to be copied to the selected path. 

Email File Mask The default file mask can be slightly edited to your liking. {RND32} will contain the unique identifier 
of each email. 

Send Test Email to: Solely for the purpose of testing your email settings, enter an email address to send a test 
message to. Alternatively, you can choose to Send to Email Output Folder. 

 

Options - Folder & Path 
The Files Folder contains the three important sub folders of Attachments, Labels, and Reports. While the 
Attachments folder is the location where Calibration Control stores the actual folders, the Labels and Reports folders 
store templates (how the labels and reports are printed). 

Location of Files: It is important to move the Files Folder to a location where it will be backed up regularly and can be 
accessed by other Calibration Control users. Click the Edit button to browse to your desired location. Note: If you 
cannot find your desired location through this dialog, you can manually enter the path in your database. Take a look at 
the Folders help topic for more detailed information. 

Location of Auto Generated Website: This is the location where a simple website listing all equipment grouped by 

https://www.apesoftware.com/calibration-control/help/folders
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Department. It can be created manually by clicking on the 'Publish Website' icon in the Utilities tab of the ribbon menu 
or scheduled via the Auto Notify utility. 

THUM Database: The THUM (Temperature and Humidity USB Monitor) database is the location where the THUM 
device stores its data. If the device is used and the database exists, then Ape needs to know where this database is 

so temperature and humidity data can be added automatically to Calibration Event records. 
 

Change Field Names 

Change the Text of Field Labels 
Rename any field of Calibration Control dialogs or forms for better usability. 

Edit Form Labels 
From Options (located in the Utilities or File tabs) navigate to the 'Advanced' tab and select the [Label Edit] button. 

https://www.apesoftware.com/calibration-control/help/auto-notify
https://www.apesoftware.com/calibration-control/help/thum
https://www.apesoftware.com/calibration-control/help/thum
https://www.apesoftware.com/calibration-control/help/options
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From the Edit Forms Labels dialog (shown above), use the 'Select Dialog' drop-down to select which dialog screen 
to modify. In the example below, selecting Company will display all fields within the Company dialog. 
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Edit Fields and Labels 
After finding the label to modify, manually edit the Control Text (what the field says), Updated By (who modified it), and 
Record Updated (when it was modified). 

 

 
Change the 'Help Tip' field to edit the text shown while the cursor hovers over the control. (Note: Not all controls have 
the ability to display 'Help Tip' text, like column headers in data grids.) 
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Reset Changes 
If a mistake is made, set all the values back to default by clicking the [Reset THIS Dialog to Default] for the single dialog 
displayed, or by clicking [Reset ALL Dialogs to Default] for all dialogs. Additionally, double-click on any single record and 
right-click to select the [Reset THIS Record] option. 

Modifications of Form Labels are highlighted green to show the custom changes. 
 

 

Custom Fields 
The Custom Tabs in dialogs are very useful. Rename these available fields with the same 

steps. For example, here is the default Custom Fields tab in the 'PersonEdit' dialog: 
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And after renaming the Custom fields, it could display as shown below: 

 
 

Options - Reference Records 
Calibration Control's reference tables include: Auto Emails, Charts, Code Groups, Codes (only required codes),Company 
Types, Coverage Factors, Grid SQL (non-custom), Permissions & Roles. You can add missing reference records or refresh 
them (replace with default) with a simple click through the Options dialog's Advanced tab. 
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Add Missing 
Any missing reference records will be added. If one or more records is accidently deleted from tables like Language 
(used for field names), Roles (defines Admin, Supervisor, etc.), or Permissions (which Roles are required for each 
Permission), then pressing this button will re-add all missing records. You'll see a message that states how many records 
were added. Otherwise, you'll see a message that all reference records are up to date. 
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Refresh All 
Refreshing all reference records will delete and readd the contents of all reference tables (listed in the screenshot below). 
Note the warning that this may overwrite some customizations in those tables. 

 

Reports & Labels 
Calibration Control uses the default Reports and Labels, however you have the ability to set any report as your 
default certificate, worksheet, etc. You can copy and customize any report or label and use it as an override with a 
specific equipment record or set is as a default report/label to use with all records. 

Default Reports 
These settings determine which reports are used by default. While most reports can be previewed using the Reports 
Print Menu, the Cal Certificate includes specific data so that it can only be previewed through an Equipment record. 

Calibration Cert: Template used when printing a Calibration Certificate. 
 

Due Cal Report: Report template used when printing the Calibration Due Report from the ribbon menu. 
 

Cal Worksheet: Calibration Worksheet that prints when the Equipment record has a Measurement Template or a 
previous Calibration Event. 

Blank Worksheet: Calibration Worksheet that prints when the Equipment record has neither a Measurement Template 
nor a previous Calibration Event. 

Uncertainty: Default report for the Measurement Uncertainty Budget. 
 

OOT Investigation: Designates the Out-Of-Tolerance (OOT) Investigation worksheet used when Equipment 
received for calibration is found OOT. 

Custom Report: Custom report for a single Equipment record, which can print from the context menu in the 
Equipment grid. 

Note: All reports can be edited using Ape software's built-in Report Designer. Custom changes made to default 
templates should be renamed, (e.g. "CalibrationCertificate - COMPANY"). 

https://www.apesoftware.com/calibration-control/help/custom-report
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Default Labels Tab 
Default Equipment Labels: These settings determine which label templates are used by default when using the 'Print 
Label' button from the Equipment dialog. (Default label settings can be overridden for a specific Equipment, Type, or 
Model record.) 

Calibration Due: Prints when the calibration frequency generates a due date and uses labels with the 'Due 
Cal' string in their file name. 

Asset: File templates are identified as Asset labels by the 'Asset' string in the file name. 
 

Cal Not Required: Prints in place of the Calibration Due label when the Calibration Frequency is 'Cal Not 
Required' and is identified as CNR label by the 'CNR' string in the file name. 

Next Use: Print in place of the Calibration Due label when the Calibration Frequency is 'Next Use' and the labels 
are identified by a 'Next Use' string in their file name. 

System: Prints with information relating to an Equipment System. 
 

Note: The number at the beginning of the file name indicates the width of the label tape in millimeters. The number at 
the end of the file name indicates the sequence. Any custom labels should be given a unique sequence. All labels 
can be edited using the Brother P-touch Editor software that comes free with your Brother P-touch label printer. For 
a preview of all default label templates included in Ape Software, visit our Label Fields topic. 

https://www.apesoftware.com/calibration-control/help/brother-software
https://www.apesoftware.com/calibration-control/help/label-printers
https://www.apesoftware.com/calibration-control/help/label-fields
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Options - Security 
Modify Calibration Control's advanced Security settings in the Options dialog. Easily activate User Authentication (sign-in 
mode) with just a click of a button, disable CC Terminal features, and more. 

Activate/Deactivate Sign-In Mode: Enable or disable the User Authentication Mode (Sign-In Mode). At least one User 
must have Administrator privileges to Enable User Authentication and, by default, only an Administrator can disable 
Authentication. 

Password Security: Edit User password strength, rules, and expiration times. 
 

Inactivity Exit: Adjust how many minutes pass before Calibration Control prompts a user to sign-in again. 
 

Sign In with Windows User Name: For ease of use, use a Windows account to sign in to Calibration Control. 
 

Only Current Users Can Check Out Equipment: Prevents anyone but the currently signed in user from checking 
out Equipment. 

Prevent Users From Saving Passwords on Client PCs: When the Authentication mode (sign-in) is enabled and 
a User signs in, they are given the option of saving their User Name and Password for future automatic sign-ins. 
Checking THIS option prevents the ability to save their User Name and Password. 

 

Require Re-Entry of Password When Signing In: Requires users to enter their password twice in order 
to successfully sign in. 

No Authentication for Auto-Notifications: Allows email notifications to be sent without prompting the user sign-in 
authentication dialog. 

https://www.apesoftware.com/calibration-control/help/sign-in
https://www.apesoftware.com/calibration-control/help/sign-in
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Disable Terminal Features for All Users 
Disable Terminal Equipment Grid: Prevents any user from seeing the main list of Equipment from the Terminal dialog. 

 

Disable Check In/Out Dialog: Prevents the use of the Check In/Out dialog when Terminal mode is activated. 
 

Disable Status Change Dialog: Prevents use of the Status Change dialog when Terminal mode is activated. 
 

Disable Asset Transfer Dialog: Either disable the Asset Transfer dialog completely or disable one or more of the fields 
that can be edited. 

 

Feature Visibility Options 
Simplify Calibration Control's ribbon menu by hiding features your company is not using. 

Make Features Invisible 
Feature Visibility is found under the Advanced tab in the program Options. Find the Options dialog under the Files tab 
or under the Utilities tab of the ribbon menu. 

https://www.apesoftware.com/calibration-control/help/terminal
https://www.apesoftware.com/calibration-control/help/asset-transfer
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Click on Feature Visibility to view the available features you can hide. Select a feature (or group of features) to 
become invisible on the ribbon menu. 

Note: Restart Calibration Control to apply these changes. 
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In the above image, notice how the feature group 'Advanced Tools' is marked to be invisible. 

The ribbon with the 'Advanced Tools' feature group visible looks like: 

 
The ribbon with the 'Advanced Tools' feature group hidden looks like: 

 

 
When it is made hidden or invisible, a feature or a feature group is simply removed from view. To make a hidden feature 
visible again, return to the Feature Visibility dialog in Program Options and remove the feature's checkmark, then restart the 
program. 
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Minimize Ribbon 
For a better view of the open windows, right-click on the ribbon and select the 'Minimize the Ribbon' option. Bring it 
back the same way, by right-clicking where the ribbon would normally appear. 

 

Options - Spell Checker 
You can enable spell check mode in Calibration Control through the Spell Checker dialog (Advanced Options). There are 
several spell check modes to choose from plus further configuration options in the checkboxes shown below. 

Mode: Choose from the following spell checker options: 
 

None: By default, Calibration Control does not use the Spell Check mode. 
 

As You Type: Underlines incorrectly spelled words in red as you type. This option does not offer suggested 
correct spelling. 

Dialog On Validating: Upon submission of any dialog, a spell check window will appear if any spelling errors 
are found, which includes correct spelling suggestions. 

Dialog On Validating And As You Type: This option shows a red line under incorrectly spelled words and a spell 
check window upon submiting any dialog with spelling errors. 

Enable the User dictionary when spell check mode is active. 
 

Enable the option to ignore words in UPPERCASE, MixeD CaSe and words that contain numbers. 
 

Enable spell check on Compound Words and Hyphenated words 
 

Maximum Word Length to Check: Enter the maximum word length to check. By default the value is 80. 
 

Language: Select the language for the spell checker. Available languages: English, Dutch, French, German, Italian, 
Portuguese or Spanish. 
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Measurements in Metric or Imperial 

Display Metric or Imperial as Default 
Measurement Units 
Use the Options dialog to change the default measurement system to either Metric or Imperial (US) units in 
Calibration Control (our Calibration Management Software). 

Go to File > Options and in the General tab of the Program Options dialog, select either 'Metric' or 'US' as the 
default measurement system from the drop down menu. 
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Asset Transfer Dialog 
Transfer Assets quickly to new Sites, Departments, Locations, Custodians, or change the Status in Calibration Control 
(our Calibration Management Software ). Administrators can control which fields are shown by adjusting permissions in 
the Options dialog under the Security tab. Transactions made using the Asset Transfer dialog are automatically logged in 
that Equipment dialog's Notes tab. 

 

 
Open the dialog by clicking on the Asset Transfer icon in the Tools tab of the ribbon menu. This dialog can also be opened 
directly from the Equipment grid by right-clicking on the Equipment record to be changed and selecting 'Asset Transfer'. 

Use the Asset Transfer Dialog 
First type an Equipment ID, Master ID, or Serial Number in the 'Equipment ID' box or select the [Use Scanner] button 
first when using a barcode scanner. Then select the desired fields for a new Site, Department, Location, Custodian, or 
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Status and click [Validate], then the [Submit] button. Fields left blank will not be changed. 

 

Asset Issue & Receive Dialogs 

Asset Issue Dialog 
The Asset Issue dialog quickly issues equipment using specified values and saves a history note to that specific 
equipment's Notes tab. Open the Asset Issue dialog by clicking on the red arrow icon in the Tools tab of the ribbon menu. 
For convenience, the Site, Department, Location, Custodian, and Status selections will be remembered by the software 
until they are changed. 

 

 
3-Step Process to Issue Equipment 

STEP 1: Select the Site, Department, Location, Custodian, or Status that the equipment is going to be issued 
to. Unused selections may be left blank. 

STEP 2: Check the box next to the desired Print and Update selections. 
 

https://www.apesoftware.com/calibration-control/help/notes
https://www.apesoftware.com/calibration-control/help/limit-equipment-visibility-by-site
https://www.apesoftware.com/calibration-control/help/departments
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STEP 3: Type the equipment ID in the provided box or check the 'Scanner' box to scan an asset tag, and then 
click [Submit]. 

The new information will be displayed in the info box once the Asset Issue has been submitted. 

 

Asset Receive Dialog 
The Asset Receive dialog has all the same features as the Asset Issue dialog. Open the Asset Receive dialog by 
clicking on the green arrow icon in the Tools tab of the ribbon menu. 

 

 
3- Step Process to Receive Equipment 

STEP 1: Select the Site, Department, Location, Custodian, or Status that the equipment is going to be received 
to. Unused selections may be left blank. 

STEP 2: Check the box next to the desired Print and Update selections. 
 

STEP 3: Type the equipment ID in the provided box or check the 'Scanner' box to scan an asset tag, and then 
click [Submit]. 

The new information will be displayed in the info box once the Asset Receive has been submitted. 
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Status Change Dialog 

Quickly Change Status of Multiple Equipment 
Change the status of multiple pieces of equipment quickly and accurately in Calibration Control. For instance, when 
receiving several pieces of equipment for calibration (or any other status), change the status of each tool with a 
single barcode scan after setting the "Change to What Status?" field. 

Status Change in Ribbon 
Open the Status dialog from the Status Change option. 

 

 
Using the Status Change Dialog 
Select a new status code for a piece of equipment in the “Change to What Status?” field combo-box. If entering the 
Equipment ID manually, uncheck the "Use Barcode Scanner for Data Entry" checkbox, and manually type in the Equipment 
ID and click [Submit]. Repeat with as many pieces of equipment that require the new status. When all necessary status 
changes are completed, click [Finished] to exit the Status Change dialog. 
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If using a barcode scanner, ensure the "Use Barcode Scanner for Data Entry" box is checked and scan the barcode on 
the asset label previously printed from Calibration Control. There is no need to click the [Submit] button when using a 
barcode scanner (due to carriage return setting in scanners). Repeat the equipment scan, or data entry, until all 
necesssary status changes are complete. Click [Finished] to close out of the Status Change dialog. 

Received for Cal with Status Change Dialog 
By default, using the Status Change activity dialog will (a) update the Status code in the Equipment record and (b) save 
a Note in the Equipment record and Change Log describing that this status change took place. 

Additionally, if a specific Status code is defined in the Options dialog (Advanced tab/Calibrations), then the Received 
Date auto-populates in the Equipment record when this Status code is used in the Status Change dialog. Check the box 
to null the Received (for Cal) Date field in the Equipment record whenever a new Calibration Event is saved with a 
'Passed' Status. 

https://www.apesoftware.com/calibration-control/help/options
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Alternatively, if the Equipment Status code is changed from its designated Received status using the Status Change dialog, 
then the Received (for Cal) Date automatically clears in the Equipment record. 

 

Equipment Check In/Out 
Use the Equipment Check Out feature to quickly issue out items while automatically creating an audit trail, tracking 
Use Count or Use Days, linking to a Person, and connecting to a Work Order. 

Opening the Check Out Dialog 
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Select the Check Out feature icon from the Tools tab of the ribbon menu. This option is best when you are using a 
barcode scanner. 

 

 
Alternatively, you can right-click on an Equipment record from the Equipment grid and select [Check Out/In] from the 
context menu. Checking Out equipment directly from the Equipment grid will automatically generate the Equipment ID 
number in the Check Out dialog. 

Check Out 
To check out Equipment, select the 'Out' checkbox, enter a valid Equipment ID, and click the [Submit] button. 

 
Enable the checkboxes next to optional fields to track the Person, Work Order, or Status Change related to the 
current Equipment Check Out. 

 

Confirmation of Check Out will appear in the Response Area of the dialog: 
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Check In 
To return the Equipment, select the 'In' checkbox, enter a valid Equipment ID, and click [Submit]. Confirmation of Check 
In will appear in the Response Area of the dialog: 
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Check Out by Equipment System Name 
Equipment System names can be used in place of an Equipment ID, making it appear like an Equipment Master ID, and 
it does NOT have the same name of an Equipment ID. This will check in/out all equipment in that system. 

Check Out with Barcode Scanner 
Enable the checkbox for "Use Scanner" to enable barcode label scanning. Using a scanner for field input will 
disable manual entry. 

 

 
Using Scanner for Barcoded Equipment ID 
The default barcode used in Calibration Control is the Equipment Master ID (a unique sequential number for 
each Equipment). 

However, the Equipment Master ID can be overridden in barcode labels for an Equipment ID or Equipment System Name 
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using the following format: 

Upper Case A-Z (Capital Letters) 
 

Integers 0-9 (Numbers) 
 

Special Characters: Plus (+), Minus/Dash (-), Period (.), Forward Slash (/), Space ( ). 
 

Note: Barcodes must begin and end in alpha-numeric form, surrounding special characters. 

Barcode Recognit ion Order 
Sometimes scanning barcodes in Check Out can reveal data conflicts, so it is helpful to know the barcode recognition 
order in Calibration Control. When a barcode is scanned, Calibration Control performs database tests to determine what 
information (string) the barcode contains. The string is searched for in the following order: 

1. Is it an Equipment Master ID? (Default in Calibration Control) 
 

2. Is it an Equipment ID? 
 

3. Does the string appear in the Barcodes field of an Equipment record? 
 

4. Is it an Equipment System Name? 
 

5. Is it the ID of a Person? (if a Person entry is required) 
 

6. If none of the above, the string will be placed in the Work Order field. 

Equipment Use Count or Use Days 
Some equipment or tools require calibration after a certain number of uses or days used, as opposed to a time interval 
(e.g., by units of months or years). We refer to tools with this kind of Calibration Frequency as 'Equipment Use Count' 
or 'Equipment Use Days'. 

Tracking Uses: The Increment field in the Check Out dialog only affects Equipment Use Count and Equipment Use Days, 
and only if its Next Calibration date is not overridden. 

Increment Value: By default, the Use Count Increment during Check Out equals zero (0), and Check In equals one (1). 
 

Manual Override: Increasing the Increment that automatically appears in the Check Out dialog will override the default 
values to apply the new value to that Equipment Use Count. 

 

 
Default Increments in Check Out 
The Response Area of the Check Out dialog will recognize Equipment Use Count / Days. 
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Equipment Use Count (+1 per Use) 
 

The default Increment during Check Out is zero (0), increasing the Use Count by nothing. Equipment Use Count updates 
during Check In to increase by one (1), the default value. In other words, return the tool or check it out again (if 
applicable) to add one count of usage in the Equipment record. 

Equipment Use Days (+1 per Day) 
 

Check In increases the Use Count (Days) by one (1) Increment for each day the Equipment was checked out. The 
nature of this calibration frequency is time sensitive so tracking days of usage also occurs during Check Out and may 
update the Use Count (Days): 

If the tool is checked out multiple times (before Check In), then Calibration Control will apply its automated 
algorithm to count the number of days this tool has been out and used. 

If the previous Check Out occurred on another date, then the Use Count (Days) adds one (1) Increment for 
each day, just like Check In would. 

If the previous Check Out occurred on the same date, then there is nothing to change. 
 

Note that if Check In occurs on the same day as Check Out, by default, it counts as one day of use. 
 

Options: Check Out options are available in the Advanced tab of the Program Options dialog. 

https://www.apesoftware.com/calibration-control/help/options-checkout
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Verify Check Out Status 
 

 
Current Status: In the Equipment dialog, select the 'Misc' tab to verify the current Check Out status with the Person 
(if applicable) and date. The Use Count is also visible, which resets to 0 after calibration. 

Override Count: You are able to override any of these fields to include current and accurate information. 
 

Check Out History: All Equipment Check Out activity is automatically logged in the Notes panel grid of the 
Equipment dialog located under the Grids tab. Double-click any note to view or edit. 
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Check Out Log 
In Version 9 and later, all check in/out history is available in the Check Out log in the Data Grids tab. By default, the top 
100 records are shown. Use the dropdown to change the number of records that appear. In addition, you can use the 
search bar plus any of the filter rows to show only the data you want to see. 
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Recording and Researching Jobs 

Record  Equipment  Used  on  J obs  for  Traceabil i ty 
The following dialog ('Record Job' in Tools tab) is available for quick recording of equipment used on Jobs or Work 
Orders and can be used with barcode scanners for increased data accuracy. Any string can be entered in the Job field 
while the Equipment field will recognize the label barcodes printed by Ape Software or the Equipment ID. 

 

 

Browse  J obs 
The "Job Browse" grid is now the Check Out Log grid, which contains past Job entries. You can be filter jobs by 
Equipment ID, Job, Dates, and several other fields. The results of a search / filter can then be printed or exported to Excel 
or PDF. To filter for Jobs, simply type "Job" in the search bar or filter for Job in the Check Out To column. 
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Auto Notify Utility 

Send Emails and Desktop Notifications Automatically 
Configure one or several Notification Events for scheduled reminders through email, desktop, or website publishing in 
Calibration Control. Send email notifications to specific groups of people such as Custodians, Technicians, Owners, 
Department Managers, etc. Receive a desktop notification of Equipment due for calibration. 

Note: Auto notify only needs to be set up on ONE computer in order to avoid duplicate emails. 

Email Settings 
Before sending automatic Emails, you will need to add your email settings in the Options dialog . The database will 
need additional related data discussed at the bottom of this page. 

User Authentication 
With user authentication turned on, when an Auto Email is scheduled, Calibration Control will require you to enter your 
credentials and will not send the scheduled emails until you sign in. To prevent this from happening, go to File > Options 
> Advanced tab > Security. Then, ensure the checkbox for No Authentication for Auto Notifications is checked. 

Auto Notify Grid 
The Auto Notify utility is located in the Tools tab in the ribbon menu. Currently, 17 Auto Notify events are defined by default. 

 

DueCal_[Person]: Auto email notifications for the Person identified after the "DueCal_" string. 
 

DueCal_Desktop: Auto desktop notifications on the current computer. 
 

DueMaint_[Person]: Auto email notifications for the Person identified after the "DueMaint_" string. 
 

Website_General: Auto publication of a simple website listing all equipment in Department groups. Set the 
publish location in the Folders tab of the Options dialog. 

 

https://www.apesoftware.com/calibration-control/help/options-email
https://www.apesoftware.com/calibration-control/help/options
https://www.apesoftware.com/calibration-control/help/options
https://www.apesoftware.com/calibration-control/help/options-security
https://www.apesoftware.com/calibration-control/help/people
https://www.apesoftware.com/calibration-control/help/people
https://www.apesoftware.com/calibration-control/help/options-email
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Auto Notification Dialog 
Email Subject: The text that appears in the Subject line of the Auto Email Notifications. 

 

Signature File: Defines which HTML file is used as the email signature (Optional). 
 

BCC: Whenever an Auto Email is sent, a copy of the email can be sent to an additional email or list of emails. If 
more than one email in added to the BCC field, separate those emails with a comma, semicolon, or a hard 
return. 

Schedule: There are three frequency options available: Daily, Weekly and Monthly. For a Monthly frequency, select 
which Day(s) of the month from the Calendar. For a Weekly frequency, select which Day(s) of the Week. 

Additionally in this section, Select the Is Active checkbox to automatically create a Task in your Task 
Scheduler which you can now easily navigate to using the Open Task Scheduler button. 

Date & Time: Select the starting date for this event and the specific hour and minute at which you would like 
the emails to be sent. 

 

 
Send Message(s)/Send Test Message(s) 

 

Send Message(s): Pressing sends all the email notifications to the defined Person group (e.g., 
Custodian, Technician, Manager), displays the desktop notification, or creates the default website. 

Send Test Message(s) to BCC: Sends the email notifications to the email(s) listed in the BCC field only as a test 
run. 

SQL tab 
SQL Statements 

 
Previously located in your database, all required SQL statements can be viewed/edited here. 
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Table Previews 
View a preview of the current email data. Double-click each user from the Recipients list to view their Equipment Due 
that will be included in their emails. 

 

 
Body Template tab 
Previously located in your database, all HTMl Email Templates can be viewed/edited here. 
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Note: Prevent specific users from editing SQL/HTML by defining these skills/permissions in the User dialog 
(Advanced Skills section). 

Email Activity Log 
Under the Data Grids tab, in the Logs section, you'll find the Email Activity log. Here you can review details of all emails 
that were sent out. 

Troubleshooting 
The Auto Email Notifications require related data in the following tables: 

 

People Fields in Equipment Record: Identify the Custodian, Technician, Owner, or Checked out By fields so 
Calibration Control knows which equipment is related to who. 

Department Field in Equipment Record: Identify the Department in the Equipment dialog and then, in the 
Department record, identify the Manager and Contact people. 

Site in Equipment Record: Identify the Site (e.g., Customer or Company Site) in the Equipment record and then, 
in the People records, connect them to Companies. 

Emails in People Records: Ensure the People identified in other locations (e.g., Equipment or Department 
records) have valid email addresses and ensure they do NOT have "Do Not Email" checked in their person 
record. 

Equipment Emails 
In the tools tab, go to the Equipment Emails grid. Right-click and select which Auto Notify event you are 
troubleshooting from the bottom of the menu. 

Easily filter all equipment that won't be included in that email notification by utilizing the Passed checkbox 
column. Additionally, all pink highlighted text indicates why an email is not being sent out. 

 

https://www.apesoftware.com/calibration-control/help/users
https://www.apesoftware.com/calibration-control/help/people
https://www.apesoftware.com/calibration-control/help/edit-equipment
https://www.apesoftware.com/calibration-control/help/departments
https://www.apesoftware.com/calibration-control/help/companies
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Also, take a look at the SMTP Test Procedure help topic if you are having difficulties with sending Auto-Notify emails. 

Terminal Mode 

Minor Tasks in Ape Terminal Mode 
Calibration Control in Terminal Mode (CC Terminal) is useful for those who require limited access. The simplified Terminal 
allows your Production employees or Shop personnel to make minor changes via feature shortcuts. Terminal users can 
only use CC Terminal. They will receive an error message upon starting Calibration Control stating they can only use the 
Terminal Mode. 

Both the main Ape program and Ape Terminal install together. The Terminal is the same application executable 
(apecal.exe), except it is started with the switch -t1 (i.e., apecal.exe -t1). 

 

 
Limited Use 
Currently featured in the Ape Terminal dialog: 

 

Check Out/In 
 

Status Change 
 

Asset Transfer 
 

https://www.apesoftware.com/calibration-control/help/smtp-test-procedure
https://www.apesoftware.com/calibration-control/help/users
https://www.apesoftware.com/calibration-control/help/check-in-out
https://www.apesoftware.com/calibration-control/help/status-change
https://www.apesoftware.com/calibration-control/help/asset-transfer
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Equipment Grid 
 

Systems Grid 
 

Calibration History 
Print Menu 

Further Limitations 
Disable any Terminal features by going to Options > Advanced tab > Security. In the Disable Terminal Features for 
All Users section, check the features you'd like to disable. 

 

Projects 
Keep track of projects within your organization using the Projects grid and dialog. Find the Projects icon in the 
Calibration tab of the ribbon menu. 

 

 

 

https://www.apesoftware.com/calibration-control/help/edit-equipment
https://www.apesoftware.com/calibration-control/help/equipment-systems
https://www.apesoftware.com/calibration-control/help/calibration-history
https://www.apesoftware.com/calibration-control/help/reports
https://www.apesoftware.com/calibration-control/help/options
https://www.apesoftware.com/calibration-control/help/options-security
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Projects Dialog 
The 'Add/Edit Project' dialog keeps all information related to a project organized. 

Project Dialog Fields 
Project ID and Title: Choose a project ID and give the project a title. 

 

Description: Add a description about the project. 
 

Type & Priority: Select the project type and its priority from the drop-down fields. 
 

Requestor/Sponsor/Manager: Choose which person is requesting the project, which person is sponsoring the 
project, and which person is the project's manager. 

Status & Site: Select the status of the project's completion and its location. 
 

Start Est. & End Est.: Select the estimated start and end dates for the project. 
 

Start Act. & End Act.: Select the actual start and end dates for the project. 
 

Hours Est. & Hours Act.: Choose the estimated and actual hours spent on completing the project. 
 

Cost Est. & Cost Act.: Choose the estimated and actual cost spent on completing the project. 

 

Equipment/People/Parts/Work Orders 
Use these panel grids to add, link, and edit records for a project's Equipment, People, Part Numbers, and Work Orders. 
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Notes/Attachments/Documents 
Use these panel grids to add, link, and edit records for a project's Notes, Attachments, and Documents. 

 

 
Other Tabs 

Custom Tab: Custom fields are available for adding Characters, Dates, Numbers, and Check boxes. Visit the 
Change Field Names help topic to learn how to edit these fields. 

Meta Tab: This is a READ-ONLY information tab used as a reference to view which user created the record 
and  which user was the last to edit it; including the dates and times these occurred. 

https://www.apesoftware.com/calibration-control/help/field-name-change
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Work Orders 
Submit | Service | Panel Grids | Other Tabs 

 
Create and manage work orders within Calibration Control (our Calibration Management Software ) and link them to 
specific equipment records. 

Find the Work Orders icon in the Calibration tab of the ribbon menu. 
 

 

Work Orders Dialog 
The 'Edit Work Order' dialog contains 5 tabs useful in organizing each record. 

Submit Tab 
Create a work order number and add information like who requested it, which department and location it's at, which 
account it's related to, what category it falls under, and a priority level. Add a description of the work order and then link 
related equipment using the panel grid on the right side of the dialog. Click on any of the shaded boxes to quickly add 
new fields for its drop-down box. 
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Service Tab 
Add work order information related to its status, due date, received and completed date, as well as the technician in 
charge, the work order's estimated labor time, labor cost, and material cost. This tab also includes a space to write out the 
actions taken to complete the work order. 

 

 
Documents/Notes/Parts/Attachments Tab 
Within these 4 panel grids you can add and link documents, notes, part numbers, and attachments to a work order. 
Filter and sort each panel grid using the gray shaded Filter Row. 
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Other Tabs 
Custom Fields Tab: Custom fields are available for adding Characters, Dates, Numbers, and Check boxes. 
Visit the Change Field Names help topic to learn how to edit these fields. 

Meta Tab: This is a READ-ONLY information tab used as a reference to view which user created the record 
and which user was the last to edit it; including the dates and times these occurred. 

Custom Barcodes 

Use Unique Barcodes Already on Equipment 
If Equipment already has a unique barcode (e.g., asset or serial number), that number can be entered into its 
equipment record and used to locate and open its record. Make sure that this barcode is only used once per 
equipment record because there is no way for Calibration Control (our Calibration Management Software ) to 
differentiate between two equipment records with the same barcode number. 

Custom Barcode Field 
Open an Equipment record and select the Misc tab. Enter the unique custom barcode in the 'Barcodes:' field in the 
Miscellaneous category (left side). The most accurate way of entering a custom barcode is to place the computer's 
cursor into the custom Barcode field and scan the barcode into the field. 

https://www.apesoftware.com/calibration-control/help/field-name-change
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Barcode Scan Dialog 
Close the Equipment dialog, returning to the Equipment grid. Press the [F3] button to bring up the following dialog. 
When this dialog (below) is visible and a barcode is scanned, Calibration Control will know to look in the custom barcode 
field in addition to the default field. 

 

Date Masks in Calibration Control 
A mask is a way to format a field to make the data in that field look a specific way. Calibration Control gives you the 
ability to format some of the more important date, string, and number fields. Find 'Masks - Date' in the Advanced tab of 
the Program Options dialog. 

https://www.apesoftware.com/calibration-control/help/options
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 Date Masks 

Mask Result 

MMMM August 

MMM Aug 

MM 08 

M August 23 

dddd Monday 

ddd Mon 

dd 23 

d 8/23/2022 

yyyy 2022 

yy 22 

y August, 2022 

[M] M 

The date formatting methods used in CC are software industry standards used by MS. For example, a date mask 
like MM/dd/yyyy, would format August 23, 2022 into 08/23/2022. 

Here are some sample date mask results for the date of August 23, 2022 . . . 
 
 

Mask Result 

[Anything in Brackets] Anything in Brackets 
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Each section in this dialog controls the settings for that specific date mask. They give users the ability to define a 
standard mask for all new records in that category. The date masks are sorted into 3 categories - masks for grids, 
masks for controls, and label date masks. Each mask uses a drop-down menu to select the desired format (i.e., 
MM/dd/yyyy). An example of each mask is shown in orange and changes in real time. To reset all masks to default 
settings, click on the [Reset All Masks & Formats] button at the bottom of the dialog. When done, click [Submit] to save 
changes. 

 

Number Masks in Calibration Control 
Calibration Control (our Calibration Management Software) gives you the ability to format some of the more important 
date and number fields. Find the 'Masks - Number' dialog in the Advanced tab tab of the Program Options dialog. 

https://www.apesoftware.com/calibration-control/help/options
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Number Masks 
Each section (Equipment ID Auto Increment, Calibration Certificate Number Auto Increment, etc.) controls the settings for 
that specific number mask. This gives users the ability to define a standard mask for all new records in that category. 
The first box controls the appearance of the mask, with a sequence of letters followed by a dash and zeros. This field 
should only contain zeros and no other numbers or this will cause an issue with the current increment. The 'Current 
Increment' is the next number CC will use in the mask when the next new record is created. An example of each mask 
is shown in orange and changes in real time. Activate or deactivate each mask feature by checking or unchecking the 
'Enable' checkbox. 

The Calibration Certificate Number Auto Increment textbox at the bottom of the dialog is an example of what the PDF 
format will look like when saved. Select (highlights blue) and then right-click at least one Equipment record. Then, 
click Print PDF. 
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Reserved Characters 
In the Maintenance Activity Number Increment section, notice the [M] that is used in the Mask field. The character M is a 
reserved character for date masks which represents the Month. If you'd like to use a reserved character(s), simply 
placing brackets around the character allows you to use it in your number mask. Not sure what else is a reserved 
character? Take a look at the Date Masks table in the Date Masks help topic to learn more. 

 

 
Leading Zeros Mask 
Leading zeros can be important in number formats if all numbers require the same minimum number of characters. 
Instead of a counting number sequence of 1, 2, 3, etc. an LZ Mask of ‘000’ results in 001, 002, 003, etc. 

In the case where a counting number has more characters than the mask, the counting number wins. For instance, with 
a mask of 000 and a number of 5348, the result will be 5348 even though the mask has only 3 characters. 

Calibration Measurement Group Mask 
The Mask field in the Measurement Group of the Calibration dialog sets the leading and trailing zeros of all the numbers in 
the given group. Unlike the Leading Zeros Mask, the number of leading and trailing places of these fields are strictly 
limited by the mask. For instance, a mask of 00.000 will only allow two places to the left and 3 places (rounded) to the 
right. 



  
CALIBRATION CONTROL MANUAL 170 

 

Therefore, if a number of 100 or higher is required, the mask must be modified to include three zeros to the left 000.000. 
 

 
Troubleshooting Number Masks 
If you are receiving an error message when creating a new record, your number masks may not be set up properly. Go 
to the Options dialog > Advanced tab > Masks - Number. Ensure the mask field contains no other numbers besides 
zeros (e.g. EID-0000). Then, enter the next increment number in the Current increment field (e.g. 25). 

 

Procedural Steps and Groups 

Step-by-step Procedures for Worksheets 
The Procedural Steps feature allows users to define step-by-step procedures that appear on Calibration Worksheets or 
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within custom reports in Calibration Control (our Calibration Management Software). Add multiple procedure steps to 
form a Procedural Group. If you don't see Procedural Groups or Steps in your Data Grids tab, follow along with the 
Feature Visibility help topic to learn how to show those features. 

 

 
Concept 
Each Step in a Procedure is a Procedural Step while each Procedural Group (i.e., step-by-step procedure) is a collection 
of Procedural Steps in a specific order. To eliminate the need for duplication, each Procedural Step can be linked to 
multiple Procedural Groups. 

Procedural Groups can be linked to Equipment Type, Model Number, and Equipment records. When linked, the Steps for a 
given Group will appear on the default Calibration Worksheet for Procedural Steps. 

Procedural Groups 
Create a new Procedural Group record to represent a new Procedure. 

 

 
Group Name: Name that represents a collection of Procedural Steps 

 

Code: Procedure Group Code, if needed 
 

Group Type: Used to classify the group 
Active: Currently in use (active record) 

 

Notes: Keep track of additional details about the group 

Procedural Steps 
Create a Procedural Step record from its main grid or from within the Procedural Steps tab of the Procedural Group dialog. 

https://www.apesoftware.com/calibration-control/help/feature-visibility-options
https://www.apesoftware.com/calibration-control/help/feature-visibility-options
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Description: Short description of the actual step (action) 

 

Code: Procedural Step Code, if needed 
 

Step Type: Assigning a Step Type is a good way to categorize Steps 
 

Response Type: While currently not in use, this field will designate what kind of response (in the software) will 
be required from the user 

Active: Procedural Step is still in use when checked 
 

Notes: Add any additional notes required for a Step 

Add Procedural Steps to a Procedural Group 
The Procedural Steps tab of the Group dialog contains the steps linked to the Group. Use the buttons at the bottom of 
the grid to: 

[Add] a new Step 
 

[Link] an existing Step 
 

[Edit] the selected Step 
 

[Unlink] the selected Step from the current Group without deleting it 
 

[Delete] the selected Step from ALL Groups 
 

To add sequence numbers to the procedural steps simply type the desired number into the Sequence column of the 
'Procedure Steps' panel grid. 
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Linking Procedural Groups to Equipment 
Procedural Groups can be linked to the Equipment Type, Model Number, or directly to the Equipment record. Therefore, 
any Equipment record linked to an Equipment Type or Model Number will also be linked to that Type or Model Number's 
Procedural Group. In the instance that a different Procedural Group is linked to all three records (i.e., Type, Model, & 
Equipment), only the highest priority link will be displayed on the Calibration Worksheet. The record priority is (1) 
Equipment record, (2) Model Number, and (3) Equipment Type. 
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Equipment Record 
 

Model Number 
 

Equipment Type 
 

Calibration Worksheet 
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Set the Cal Worksheet with Procedural Steps as the Global Default 
Report 
Within the Program Options dialog, go to the Reports tab and click on the 'Cal Worksheet' hyperlink. Select 
the [CalibrationWorksheetProcedureSteps.rpx] file and click [Open]. 
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Override Instructions at Equipment Level 
To override the procedural steps at the equipment level, navigate to the Overrides tab of the Edit Equipment dialog for 
a piece of equipment. Click on the 'Cal Worksheet' hyperlink and choose the 
[CalibrationWorksheetBlankProcedureSteps.rpx] file. Click [Open], then [Submit]. 

Required Fields 
Available in Version 9.1 and higher, you can define which dialog fields must require data input. 

 
Required fields in a dialog are highlighted light pink (by default) when the required field is empty or blank, and 
highlighted light green (by default) once the required field is populated. An error message will display when a required 
field is missing data when you attempt to save that record. Follow these instructions to set up your Required Fields. 
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Make Procedural Groups feature Visible 
By default, the Procedural Groups grid is hidden from the toolbar. You'll need to make it visible by going to: 

 
File > Options dialog > Advanced tab > Visibility > Data Grids tab 

 
Un-check the checkbox for Procedural Groups in order to make the feature visible. Restart Calibration Control to see 
the Feature Visibility changes reflected in the application. 

Create a New Procedural Group 
Open the Procedural Groups grid (located under the Data Grids tab in the Work Flow section) and add a New Record. 
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1. Group Name: Enter a unique Group name (i.e. Required fields for Equipment) 
 

2. Code: The Code field is where you will enter the actual name of the dialog. Below are some dialog names for 
your reference. 

 

Equip Attachment 
 

EquipmentSystem Document 
 

EquipmentType Note 
 

Calibration Department 
 

MeasurementGroup Person 
 

3. Group Type: Required Fields 
 

4. Active: Ensure the Active checkbox is marked. 
 

5. Notes: This is where you'll add your required field(s) information. The syntax for a required field is: 
 

Field Name|Custom field name|Tooltip message 
(Custom error message) 

 

Field Name: This is the actual field name that is in your database. You can open up your database to find 
the specific field name. Below is a list of some Equipment dialog field names for your reference: 

 

SerialNumber CompanySite 
 

ModelNumber DepartmentGuid 
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ModelDesc LocationGuid 
 

SizeRange Custodian 
ManufacturerGuid StatusGuid 

 

EquipmentTypeId CertificateNumber 
 

AlternateId Technician 
 

Custom Field name: This custom field name will be used in your error message instead of the actual 
field name. 

Tooltip message: Optional. This message will appear when hovering over a required field. 
Note: You can add more than one required field, by adding required fields on the next line. 

Custom error message: Optional. You can add a custom message that will appear above the default error 
message when a user attempts to submit a form with a missing required field. You can do this by adding an 
additional line with your message inside parentheses. 

Custom Highlight Colors 
The Required fields feature uses Highlight colors to indicate whether a required field has been filled out. By default, a 
required field is highlighted light green when it has a value or light pink when it is empty. Optionally, you can change 
these colors in Program Options > Advanced tab > Highlight Colors > Good Response & Bad Response. 

 

 
Get Ape Support 
If you need assistance setting up the Required Fields feature, contact us and we can do this together. 

https://www.apesoftware.com/calibration-control/help/about-contact-us.html
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Publish a Custom Website 

Publish Website of Equipment Grouped 
by Departments 
Instantly publish a static Website of all equipment in Calibration Control to your company network so everyone has 
access to online lists of equipment sorted by Department. Schedule the website to be refreshed regularly using the 
Auto Notify Utility. 

One-Click Website Publishing (Create) 
Select the 'Publish Website' menu item in the Utilities tab. 

 

 
Website will be automatically published from the available Equipment Records. A dialog box will pop up with an option 
to go to the Home Page, which has links to all Department pages. Here is an example of the type of information 
available with the Publish Website feature. 

 
 

 

Auto Publication with Auto Notify Utility 
Publish (refresh) the website automatically at a set schedule using the Auto Notify utility. Begin by selecting 'Auto 
Notify' from the Utilities group of the Calibration tab. 

https://www.apesoftware.com/calibration-control/help/auto-notify
https://www.apesoftware.com/calibration-control/help/auto-notify


  
CALIBRATION CONTROL MANUAL 181 

 

From the Auto Notify grid, open the WebSite_General record (e.g., double click to open). 

 
 

Within the Notification tab, (a) change the Frequency (i.e., 'How Often'), (b) the start date and time of day (i.e., 'Date 
& Time'), (c) ensure the Is Active checkbox is checked, and (d) submit by selecting the [OK] button. 
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Change Location Where Site is Published 
The default location where the site is published is the Settings Folder. Change the Website publication directory to 
a network folder so other network users have access. Go to File > Options and select the 'Advanced' tab. Click 'Folder 
& Path' and select the desired network location in the Location of Auto Generated Website section. 

 

Measurement Uncertainty Studies 

Perform Uncertainty Analysis of a Measurement 
The Measurement Uncertainty Studies grid (formerly called Uncertainty Budgets) in Calibration Control (our Calibration 
Management Software) is a simplified budget where Ape Software assumes no responsibility or liability for any 
unintentional errors. It is the User’s responsibility to ensure calculations and data entry are accurate and to confirm the 
suitability for any particular purpose. 

This budget is useful in situations where (a) each Component of Uncertainty is independent of the others, (b) the 
major Components are estimated with a high degree of accuracy, and (c) measurement results are measured 
directly or calculated with a linear formula using only multiplication or division (e.g., W=V×I). 

Note that each Measurement Uncertainty Budget is conducted for a single Nominal measurement for a unique piece of 
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Equipment. 

Uncertainty Study Dialog 
Study ID: Add a name or number as the ID for an uncertainty study. 

 

Date: Date the Uncertainty Budget calculations were performed. 
 

Nominal: Target value for the overall Uncertainty Budget analysis. 
 

Measure Units: Measurement unit (e.g., inches, degrees, etc.) of the Nominal value for the Uncertainty Budget 
analysis. 

Significant Digits: Number places to the right of the decimal. 
 

Description: Description or title of the Uncertainty Budget analysis. 
 

Notes: Any notes relevant to the Uncertainty Budget analysis. 
 

Combined [Standard] Uncertainty (uc): Summation in quadrature (i.e., root sum of the squares) of all the 
Sources of Uncertainty in the grid. 

uc= ∑ k = 1 n uk 2 
 

Coverage Factor (e.g., k=2): Used in the calculation of the Expanded Uncertainty and has a default value of 
k=2. The Coverage Factor is a confidence level of the interval accounts for the variation in the estimate of the 
residual standard deviation, and is based on the assumption that the random errors have a normal distribution. 

Expanded Uncertainty (U): The Expanded Uncertainty (U) assures a high level of confidence by re-scaling the 
Combined Uncertainty (uc) expressed with a different confidence level, e.g., 95 percent. The re-scaling is 
accomplished by multiplying by the coverage factor (i.e., U=k×uc). In many cases, the coverage factor may be 
2, which is typically used to approximate a 95% level of confidence. 

Expanded Uncertainty Rounded (Uce): The expanded uncertainty (Uc) rounded to two significant digits. 
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Uncertainty Detail Dialog 
Use the Detail dialog to describe each source of uncertainty (i.e., Component of Uncertainty) to be included in the 
overall Measurement Uncertainty Budget. 

Source Name: Descriptive name for the Source of the Component of Uncertainty, which will be combined with 
other Components to create a single Uncertainty Budget. 

Value (a): Numeric value related to the Unit of Measure. 
 

Unit of Measure: Units measured in such as inches, Fahrenheit, mph, etc. 
 

Type A/B: Method used to estimate uncertainty either Type A, if estimated statistically, or Type B, if inferred through 
non statistical methods such as historical measurements, manufacturer specifications, calibration certificates, 
published data, mathematical formulas, or general experience. 

[Probability] Distribution: The Probability Distribution selected dictates the Divisor (next field). For example, a 
Normal 1s distribution has a Divisor of 1 where a Normal 2s distribution has a divisor of 2. The following values 
for each Probably Distribution are defaulted into the Divisor field, which can be overridden. 

No Divisor Rectangle = 3 = 1.7321 
 

Normal 1s = 1 Triangle = 6 = 2.4495 
 

Normal 2s = 2 U-Shaped = 2 = 1.4142 
 

Normal 3s = 3 Rectangle = 12 = 3.4641 
 

Normal @ 99% = 2.58 
 

Divisor (d): The numeric value related to the Probability Distribution chosen. This value is automatically set when 
choosing the Probability Distribution (previous field) but can be edited independently after choosing the Distribution. 

Degrees of Freedom (v): For Type A uncertainties, use the d.f. for the corresponding standard deviations. For 
Type B sources refer to calibration certificates or published reports. In some instances, where the standard 
deviation must be estimated from scientific judgment or partial data, an infinite d.f. is normally assumed. 

Sensitivity Coefficient (c): Used to describe how the Component of Uncertainty contributes to the Combined 
Uncertainty when a simple functional relationship does not exist between the input quantities and the measurement 
result. For example, the unit of measure for the study may be in length units where an Uncertainty Component 
may be expressed in temperature or angular units. Use this field to change the weighting of the Component from 
the default of 1 (one). 

Standard Uncertainty (u): Calculated by dividing the Value (v) by the Divisor (d) and then multiplying by the 
Sensitivity Coefficient (c): 

u= ad × c 
 

Assumptions Explanation: Use this field to Explain any Assumptions made for the current Uncertainty 
Component. 
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Learning about Measurement Uncertainty 
Here are a few online resources to get started with learning about Measurement Uncertainty. 

 

How to Calculate Uncertainty - Dr. Jody Muelaner 
 

Uncertainty Budgets and Sensitivity Coefficients - NIST, Information Technology Laboratory 
 

Calculating an Uncertainty Budget for a Measurement - wikiHow 
 

Example of Uncertainty Budget - NIST 
 

Policy on Estimating Measurement Uncertainty for Construction Materials & Geotechnical Testing (P103d) - The 
American Association for Laboratory Accreditation 

A Beginner's Guide to Uncertainty of Measurement - Stephanie Bell, National Physical Laboratory 
 

An Introduction to Expressing Uncertainty in Measurement - Mr. Ouellette, National Research Council Canada 
 

Here are a few spreadsheet examples of Measurement Uncertainty Budgets: 
 

Uncertainty Budget Template - NIST, Laboratory Metrology Program 
Simplified Uncertainty Budget Template (xls) - National Research Council Canada 

 

Measurement Uncertainty Budget Template - American Society of Crime Laboratory Directors / Laboratory 
Accreditation Board 

References 
Degrees of Freedom - Wikipedia 

 

 

 

http://www.wikihow.com/Calculate-Uncertainty
http://www.muelaner.com/
http://www.itl.nist.gov/div898/handbook/mpc/section5/mpc56.htm
https://www.apesoftware.com/calibration-control/help/uncertainty-budget
http://www.muelaner.com/uncertainty-budget/
http://www.wikihow.com/
http://www.itl.nist.gov/div898/handbook/mpc/section5/mpc565.htm
http://www.nist.gov/itl/
https://www.a2la.org/
https://www.a2la.org/
http://www.wmo.int/pages/prog/gcos/documents/gruanmanuals/UK_NPL/mgpg11.pdf
http://www.npl.co.uk/publications/guides/a-beginners-guide-to-uncertainty-of-measurement
http://www.nrc-cnrc.gc.ca/eng/solutions/advisory/clas/uncertainty_basics.html
http://www.nrc-cnrc.gc.ca/eng/index.html
http://www.nist.gov/pml/wmd/labmetrology/upload/Uncertainty_Budget_Table_Template_16Jan2013.xlsx
http://www.nist.gov/pml/wmd/labmetrology/
http://www.nrc-cnrc.gc.ca/obj/doc/solutions-solutions/advisory-consultatifs/clas-clas/uncertainty_budget_template.xls
http://www.nrc-cnrc.gc.ca/eng/index.html
http://www.ascld-lab.org/
http://www.ascld-lab.org/
http://en.wikipedia.org/wiki/Degrees_of_freedom_(statistics)
http://www.wikipedia.org/
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THUM Temperature and Humidity Device 

Automatically Record Temperature and Humidity 
Calibration Control is compatible with the Temperature and Humidity USB Monitor (THUM) sold by Practical Design 
Group. With a THUM device plugged in and set up on a computer, Ape can automatically retrieve temperature and 
humidity data for calibration events. 

 
 

 
 

Setup 
Follow these instructions to integrate the THUM with Calibration Control: 

 
1. Setup THUM: Follow the setup instructions that arrive with the THUM device. 

 
2. Move THUM Database: The default location of the THUM database (thum.mdb) is in the Program Files folder. 

This will only work if the signed in user has read/write access to the Program Files folder. Therefore, always move 
the database out of the Program Files folder to a location where everyone has read/write access, like the CC 
Settings folder. 

a. Move the THUM database by opening the THUM application and selecting 'Show Options' from the 
Options drop-down menu. 

b. Update the ‘Database location’ field to reflect the new location, like the CC Settings folder. 
 

3. Tell Ape Where THUM Is: Open the Folders tab of the Options dialog in Calibration Control and click the Edit link in 
the ‘Location of THUM . . .’ field. Navigate to the same location as above. 

4. Test Setup: Test the setup be creating a new Calibration Event record (Calibrations tab of Equipment Edit dialog) 
and confirming that the Temp and Humidity fields are automatically populated. 

http://www.practicaldesign.com/index.php/THUM/thum.html
http://www.practicaldesign.com/index.php/THUM/thum.html
https://www.apesoftware.com/calibration-control/help/calibration-event
https://www.apesoftware.com/calibration-control/help/folders
https://www.apesoftware.com/calibration-control/help/folders
https://www.apesoftware.com/calibration-control/help/folders
https://www.apesoftware.com/calibration-control/help/options
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Troubleshooting 
Insufficient Permissions: Attempt to start the THUM Monitor software and it reports that the current user has 
insufficient permissions to make changes. Resolve this by running the THUM monitor as an Administrator. Do 
this by right-clicking on the THUM icon and selecting "Run as Administrator". 

THUM Service Will Not Start: If the THUM service cannot be started from the THUM Monitor, one or more of 
the following steps should fix the problem. For a complete reset, follow each step: 

1. Close THUM Monitor: Resets the software. 
 

2. Delete THUM Database: Delete the "thum.mdb" file that the THUM Monitor is pointed to. Ensure this is not 
the database in the Program Files folders, which should not be used for live data. Deleting the database 
resets the database file to ensure no corruption and that (thum.mdb) is in the proper version format for the 
THUM service. Therefore, when opening the "thum.mdb" file with MS Access, do not allow Access to 
convert the "thum.mdb" file to a newer version of MS Access. 

3. Reset THUM Device: Ensure the electronic THUM device itself is reset by unplugging it from the 
computer for at least 5 seconds and plugging it back in. 

4. Restart THUM Monitor: Remember to start the THUM Monitor with Administrator Privileges, if necessary. 
 

Still Need Help? Contact us if the above steps do not work and we can do a screenshare together. 

 

https://www.apesoftware.com/about/contact-us
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Best Label Printers for Ape Software 

Which label printers will work with Ape’s Software? 
Calibration Control is compatible with the PC-connectable Brother P-touch label printers. 

Brother P-touch Label Printers 
The printer we recommend most is the PT-P900W (replacement to the PT-9700PT), which is a high volume desktop unit 
intended for industrial environments. The PT-P900W will print up to 32mm (1.26 inch) width tape. If the PT-P900W is 
too expensive, maybe the portable PT-P700 would be a better starting choice. The PT-P700 uses label tape up to 24mm 
(1 inch) in width. Otherwise, either printer will work with Ape Software applications. 

You can find the PT-P900W and the PT-P700 at Amazon.com and many other online retailers. 

TZe Label Tape 
All of the P-touch label printers use the same label tape (model number starts with TZe). This tape is resistant 
to temperature, UV, scratching, and spills. 

Here are some of the common sizes along with their Amazon links: 
 

6 mm (1/4 inch) Black on White (TZe211) 
 

9 mm (3/8 inch) Black on White (TZe221) 
 

12 mm (1/2 inch) Black on White (2 pack - TZe2312PK) 
 

18 mm (3/4 inch) Black on White (TZe241) 
 

24 mm (1 inch) Black on White (TZe251) 
 

36 mm (1 1/2 inch) Black on White (TZe261) 

Extra Adhesive Label Tape 
Brother also sells label tape with extra adhesive for high-use environments or extra smooth surfaces. Before choosing 
the extra adhesive, we suggest trying the normal adhesive formula first (above labels) because the additional adhesive 
can gum up label printers faster than the normal level of adhesive. 

6 mm (1/4 inch) Black on White (TZeS211) 
 

9 mm (3/8 inch) Black on White (TZeS221) 
 

12 mm (1/2 inch) Black on White (TZeS231) 
 

18 mm (3/4 inch) Black on White (TZeS241) 
 

Here are a couple of links to B&H Photo for Cleaning 

Tape: 36 mm (1 1/2 inch) Good for PT-P900W 

18 mm (3/4 inch) Good for PT-P700 

https://www.amazon.com/Brother-PTP900W-PT-P900W-Wireless-Laminated/dp/B01IG8IOB4/
https://www.amazon.com/Brother-PTP900W-PT-P900W-Wireless-Laminated/dp/B01IG8IOB4/
https://www.amazon.com/Brother-PTP900W-PT-P900W-Wireless-Laminated/dp/B01IG8IOB4/
https://www.amazon.com/Brother-Connectable-Label-Maker-PT-P700/dp/B00DSYEB28/
https://www.amazon.com/Brother-Connectable-Label-Maker-PT-P700/dp/B00DSYEB28/
https://www.amazon.com/Brother-PTP900W-PT-P900W-Wireless-Laminated/dp/B01IG8IOB4/
https://www.amazon.com/Brother-Connectable-Label-Maker-PT-P700/dp/B00DSYEB28/
http://www.amazon.com/Brother-Laminated-Black-White-TZe211/dp/B004I2MP6I
http://www.amazon.com/Brother-Retail-Packaging-Black-TZe221/dp/B004I2EDA4
http://www.amazon.com/Brother-Laminated-Black-White-TZe2312PK/dp/B0013CED4I
http://www.amazon.com/Brother-Laminated-Black-White-TZe241/dp/B004I2EE3K
http://www.amazon.com/Brother-Laminated-Retail-Packaging-TZe251/dp/B004I2GG5Y
http://www.amazon.com/Brother-Laminated-Black-White-Inch/dp/B004ZMW20U
http://www.amazon.com/Brother-Black-White-strength-TZeS211/dp/B004I2LW9O
http://www.amazon.com/Brother-Black-White-strength-TZeS221/dp/B004I2HPJU
http://www.amazon.com/Brother-extra-strength-Black-TZeS231/dp/B004I2F47U
http://www.amazon.com/Brother-extra-strength-Black-TZeS241/dp/B004I2IB9I
http://www.bhphotovideo.com/c/product/762467-REG/Brother_TZCL6_36_mm_1_4_Cleaning.html
http://www.bhphotovideo.com/c/product/793133-REG/Brother_TZE_CL4_TZeCL4_0_7_TZ_Cleaning.html
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Free Label Editing Software and Drivers 

Free Brother Printer Drivers and Label 
Editing Software 
Ape Software uses Brother P-touch label printers for the highest quality laminated thermal transfer label printing. 

Use the following quick links to find the drivers and software from the Brother support site. 

Printer Drivers 
Download the PT-9800PCN Printer Drivers 

 

Download the PT-9700PC Printer Drivers 
 

Download PT-2430PC Printer Drivers 
 

Download PT-P700 Printer Drivers 
 

Download PT-P900W Printer Drivers 

P-touch Editor - Label Editing Software 
Download the Brother P-touch Editor for editing the labels that come with Calibration Control or creating your own. 

Labels Quick Start Instructions 

Sample Labels 
Check out the sample labels for Calibration, Asset, and CNR (Calibration Not Required). They are a good resource 
for determining which labels to use. 

Important Points 
Keep in mind when printing labels with Calibration Control: 

 
1. Brother Label Printers: Calibration Control will only print labels using one of the Brother P-touch (PT) 

label printers. Click on the link to view a list of compatible models. 

2. Printer Drivers: The printer drivers MUST BE INSTALLED in order to use a label printer with Calibration Control, 
these drivers are accessible with the CD included with the label printer (or downloaded from Brother). Follow the 
instructions before plugging in and turning on the printer. 

3. Label Files: Calibration Control uses label layout files (*.lbx) which can be accessed by clicking on the File tab at 
the top left corner of Calibration Control and selecting [Open Files Folder]. The label files must reside in the 
Labels folder for Calibration Control to find them. Watch the video on Calibration Control folders to understand the 
folder layout. 

4. Label File Number Prefixes: The 150+ label files that come with Calibration Control begin with the 
millimeter prefixes of 12 (1/2 inch), 18 (3/4 inch), or 24 (1 inch) to identify the width of label tape required. 

5. Set Default Labels: Use the Options dialog to set the default labels for Calibration Due, Asset, and Cal 

http://welcome.solutions.brother.com/bsc/public/us/us/en/dlf/download_top.html?reg=us&c=us&lang=en&prod=9800neus
http://welcome.solutions.brother.com/bsc/public/us/us/en/dlf/download_top.html?reg=us&c=us&lang=en&prod=9700eus
http://welcome.solutions.brother.com/bsc/public/us/us/en/dlf/download_top.html?reg=us&c=us&lang=en&prod=2430eus
http://support.brother.com/g/b/downloadtop.aspx?c=us&lang=en&prod=p700eus
http://support.brother.com/g/b/downloadtop.aspx?c=us&lang=en&prod=p900weus
http://www.brother.com/product/dev/label/editor/index.htm
https://www.apesoftware.com/calibration-control/help/sample-labels-calibration
https://www.apesoftware.com/calibration-control/help/sample-labels-asset
https://www.apesoftware.com/calibration-control/help/sample-labels-calibration-not-required
https://www.apesoftware.com/products/label-printers
https://www.apesoftware.com/products/label-printers
https://www.apesoftware.com/products/brother-software
https://www.apesoftware.com/calibration-control/help/folders
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Not Required. Be sure to select labels with the same width as the tape in your P-touch printer. 

6. Print a Label: Open an equipment record and click the [Asset Tag] button in the bottom-right corner of the dialog. 

Access All the Label Fields 

Understanding Labels Fields in Calibration Control 
Follow these guidelines to get the most out of printing labels with Calibration Control (our Calibration 
Management Software). 

Need To Know: 
1. Label Basics: Watch this label quick start video for an introduction to the basics of label printing in 

Calibration Control. 

2. Files Folder Basics: Watch this video for an overview of the Calibration Control folders. 
 

3. Sample Labels: Check out these screenshots of sample labels included in Calibration Control for Calibration, 
Asset, and CNR (Calibration Not Required). They are a good resource for choosing which labels you want to 
use or modify. 

4. Label Naming Requirements: 
Printing the equipment labels or Asset tags must have 'Asset' in the label file name, (e.g. 24-Asset-05). 

 

Printing Calibration labels must have 'DueCal' in the label file name, (e.g. 18-DueCal-02). 
 

Printing Maintenance labels must have 'DueMaint' in the label file name, (e.g. 24-DueMaint-01). 
 

Equipment System labels must have 'System' in the label file name, (e.g. 36-System-01). 
 

Due Cal Labels for Calibration Not Required Frequency must have 'CNR' in the label file name, (e.g. 
12- CNR-01). 

Due Cal Labels for Next Use Frequency must also use 'CNR' in the label file name for current version 9, 
(e.g. 18-CNR-09). In older version 8, it must have 'NextUse' in the file name, (e.g. 24-NextUse-03). 

Note: The format of the label file name begins with the millimeter (mm) size of your tape width. 
 

5. P-touch Editor: The P-touch editor software that comes with P-touch printers (or download from Brother) 
is required to edit the 150+ labels that come with Calibration Control or to create custom labels. 

6. Editing Label Templates: You can edit Calibration Control label templates in the freeP-touch Editor software. 
The label fields below are the designated Object Names in the Textbox or Barcode Object Properties. 

7. Using Label Fields: The label fields below correspond to the specific data fields used in Calibration Control. 
Copy the exact label field format when modifying any given template. 

8. Label Fields: All of the available label fields are shown below. 
 
 

Take a look at our Label Fields help topic to see a full list of label field names. 

 

https://www.apesoftware.com/calibration-control/help/label-quick-start
https://www.apesoftware.com/calibration-control/help/folders
https://www.apesoftware.com/calibration-control/help/sample-labels-calibration
https://www.apesoftware.com/calibration-control/help/sample-labels-asset
https://www.apesoftware.com/calibration-control/help/sample-labels-cnr
http://support.brother.com/g/b/producttop.aspx?c=us&lang=en&prod=2430eus
https://www.apesoftware.com/calibration-control/help/label-fields
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Sample Due Cal Labels 
Below are the sample Calibration Due (Due Cal) Label templates included in Calibration Control. These labels can 
be edited and additional labels can be created as needed. 

The number at the beginning of each label file refers to the width of the label tape (in mm) or height of the label as 
it's presented below. The number at the end of the label is simply an id. 
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Print Future Calibration Labels 

Print Calibration Labels to Apply at a Future Date 
Using Calibration Control, this feature is useful in a scenario where a Technician must calibrate Equipment at a remote 
site but does not have the ability to print labels while at that site. With this feature, a Technician can print a range of labels 
with a future Calibration date and apply those labels on site assuming the Unit Under Test (UUT) passes. Printing labels 
with this feature does not update the Calibration dates of the Equipment. 

Printing Future Labels 
Print Future Calibration Labels by selecting a group of records, right-clicking to get the pop-up menu, and selecting Print -
> Future Calibration Labels. Use the Filter Row in the Equipment grid to filter only the rows required. 

 

 
Set the future calibration date and the appropriate technician for the labels. 
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Depending on the type of label selected, different information will be displayed in different styles. This label shows 
the Technician name, the Future Calibration Date, and the date it will be Due for Calibration. The customizable fields 
are shown in red for reference. 

 
 

Sample Asset Labels 
Below are the sample Asset Label templates included in Calibration Control. These labels can be edited and 
additional labels can be created as needed. The number at the beginning of each label file refers to the width of the 
label tape (in mm) or height of the label as it's  presented below. The number at the end of the label is simply an id 
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Calibration Not Required Labels 
Below are the sample Calibration Not Required (CNR) Label templates included in Calibration Control. These labels can 
be edited and additional labels can be created as needed. 

The number at the beginning of each label file refers to the width of the label tape (in mm) or height of the label as 
it's presented below. The number at the end of the label is simply an id. 
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Chain Printing Labels 

How to Chain Print Labels to save Label Tape 
There are two ways to print labels using the Brother label printers and each utilizes a small portion of blank label tape used 
as a "grab-tab" to help peel away the label from its backing. The first method by default prints them individually with a 
small piece of "grab-tab" left on the end of each scored piece. The second, using this method, prints and scores them all in 
a row with one piece of "grab-tab" at the beginning of the strip. 

Individually Printed Labels 
By default, labels are printed individually with a small "grab-tab" at the front of each: 
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Chain Printed Labels 
From the File tab at the far left of the ribbon menu, choose the 'Options' button and navigate to the 'Labels' tab. At 
the bottom of the dialog there is a 'Chain Printing (not for all models)' checkbox. Check this box to enable chain 
printing. Uncheck the box in order to go back to printing them individually. 
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The chain printed labels will look like this: 

 
 

Labels & Reports Overrides 

Override Global Defaults for Reports and 
Labels 

By default, the Global (application-wide) settings in Calibration Control for file templates that are used for Labels and 
Reports are defined in Options > Advanced tab > 'Report & Label'. 

In situations where the Global template is not acceptable, users can override the template in the Equipment, Site 
(Client), Model Number, or Equipment Type. For example, if a 12mm label is set at the Global level and a different size 
(larger or smaller) is required for a specific Model Number or Equipment, a different label template can be selected at 
the Model or Equipment level. 

 
Override Settings 
In the Overrides tab of the Equipment dialog, you can override Labels and Reports. The other dialogs that have Label 
and Report Override ability have similar fields. The template values can be cleared by clicking on the red [X] buttons. 

https://www.apesoftware.com/calibration-control/help/options-report-label
https://www.apesoftware.com/calibration-control/help/edit-equipment#other
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Label Fields 
Calibration Due: Prints when the calibration frequency generates a due date and uses labels with the "Due 
Cal" string in their file name. 

Asset: File templates are identified as Asset labels by the "Asset" string in the file name. 
 

Cal Not Required: Prints in place of the Calibration Due label when the Calibration Frequency is "Cal 
Not Required" and is identified as a CNR label by the CNR string in the file name. 

Next Use: Print in place of the Calibration Due label when the Calibration Frequency is "Next Use" and the 
labels are identified by a "NextUse" string in their file name. 

Report Fields 
Calibration Cert: Template used when printing a Calibration Certificate. 

 

Due Cal Report: Report template used when printing the Calibration Due Report. 
 

Cal Worksheet: Calibration Worksheet that prints when the Equipment record has a Calibration Template or a 
previous Calibration Event. 

Cal History: Calibration History of an Equipment record. 
 

OOT Investigation: Designates the Out-Of-Tolerance (OOT) Investigation worksheet used when 
Equipment received for calibration is found OOT. 

Overrides apply to Labels and Reports via four paths of priority. 
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1. Direct: Override directly through an Equipment Record on the 'Overrides' Tab. An override through an 
Equipment Record supersedes all other methods. 

2. Company: Override labels or reports through a Company record connected to an Equipment Record. This 
override holds priority over those below. 

3. Model Number: Override labels or reports through a Model Number record connected to an Equipment Record. 
This override holds priority over those below. 

4. Equipment Type: Override labels or reports through an Equipment Type record connected to an Equipment 
Record. This override holds priority over those below. 

5. Equipment Type — Model Number: Override labels or reports by linking an Equipment Type to a Model Number, 
then linking the Model Number to the Equipment Record. 

6. Options Dialog: Override labels or reports through the Options Dialog. 

Print Reports 

Printing the Standard Reports is Easy 
Click on the [Print] icon in the Calibration tab of the ribbon menu of Calibration Control (our Calibration 
Management Software), then select which report to print. If the report requires additional information (i.e., 
parameters, due date, or other filters) to print, enter the required parameter and then click the [Submit] button to 

generate the report. 
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Ape software also offers a Report Designer to modify any of the existing reports or to create custom reports. 

Calibration Due Report 

Quick Access to the Due Cal Report 
Print the Calibration Due Report by selecting the Due Cal Report option from the Calibration tab or from the context 
menu within the Equipment grid under Print options. 

 

 
The following Due By dialog will appear. 

 

 
If a date range is required, click on the [PRINT] button in the Calibration tab of the ribbon menu to find the Calibration Due 
Date Range report. The Date Range report (file name CalibrationDueDateRange.rpx) can also be set as the default 
report. The range dates are set by default to the first date of the current month and the last date of the current month. 
See the Program Options help topic instructions on how to change the default report. 

 

 
Note: The default versions of these Due Cal reports do not include equipment with non-calibration Frequency codes, 
like 'Cal Not Required'. Also, equipment with Status Codes marked as Hidden will not be displayed. 

Due Cal: Print Preview 
Here is a sample Calibration Due Report ready to print. 

https://www.apesoftware.com/calibration-control/help/custom-report
https://www.apesoftware.com/calibration-control/help/options
https://www.apesoftware.com/calibration-control/help/hiding-status
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Calibration Worksheets 

Record Calibration Data While Away from a Computer 
Calibration Worksheets are a convenient way to record Calibration Event data without being near a computer. The 
Worksheets in Calibration Control have the proper measurements pre-determined to make calibration data easier to 
record. The Worksheets are easily configured for the needs of the organization. 

When printing a Calibration Worksheet: 
 

If the Equipment has a Calibration Template attached to it, the Worksheet will replicate the Template structure on 
the Worksheet so all the technician needs to do is fill in the blanks. 

If no Calibration Template is attached to the Equipment, Calibration Control will use the measurement structure from 
the most recent calibration of the Equipment. 

If neither a Template nor past calibration exists, Calibration Control will print a blank Worksheet with several lines 
for recording measurement data. 

Right-click for the Context menu to print. 

https://www.apesoftware.com/calibration-control/help/calibration-event
https://www.apesoftware.com/calibration-control/help/calibration-templates
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The worksheet will look like this in the print preview. Notice that some of the fields are already filled-in with information 
from the record: 
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The blank worksheet looks like this when neither a Template nor past calibration exists. All of the fields are blank to 
accommodate necessary information. 
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Create a Custom Report 

Create Custom Reports Using Report Designer 
To create a custom report from scratch, Calibration Control uses a database language called SQL. We use SQL SELECT 
statements to tell the database what fields and records from what tables and in what order we want our data displayed. 
Therefore, as a prerequisite to this help topic, read the SQL SELECT statement help topic first. 

Create a Custom Report 
To begin, let’s assume we want to create a new Calibration Due Report for all of the equipment due before the end of next 
month. Select the ‘Report Designer’ icon from the Tools tab of the ribbon menu. This is a blank slate to drag fields into 
whatever location desired in the report ‘Detail’. To use one of Ape Software's default reports, click [Open] and choose one 
of the available [.rpx] files. 

https://www.apesoftware.com/calibration-control/help/sql-select-statement
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Define Report Data Source 
If you click on the [Edit Data Source...] link in the bottom-right corner of the Report Designer a blank Report Data 
Source dialog will appear. The Connection String field defines the connection to the database being used. The Query field 
defines the fields and records needed from a specific table and in a defined order. 
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Connection String - Choosing the Provider 
The easiest way to change the connection string is to select the Connection String icon from the ribbon menu. This will 
show the same connection string the Ape application is using to connect to the database. Click the [Copy to Clipboard 
& Close] button and paste the result into the Connection String field of the Report Data Source dialog. 

 

 
Otherwise, build the connection string by clicking the [Build] button to the right of the Connection String text box and the 
Data Link Properties will be shown. Click on the Provider table if it is not already displayed. Assuming you want to 
connect to an Access database (i.e., apecal.mdb), select the 'Microsoft Office 12.0 . . .' provider and click the [Next] 
button. If connecting to an instance of SQL Server, select the SQL Server OLE DB Provider. 

If this does not work, ask your database administrator (DBA) for assistance in choosing the correct provider. 
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Connection String - Setting the Connection 
Continuing the assumption that you need to connect to the apecal.mdb file, paste the path to the apecal.mdb file in the 
Data Source field. With help on finding your database, read the Locating Database File help topic. The entire path will 
look something like this: 

C:\Users\Public\Documents\Ape Software\Calibration Control\apecal.mdb 

After entering the path to the database, click the [Test Connection] button and a ‘Test connection succeeded’ response 
should show. If the connection is unsuccessful, repeat the above steps until it is. 

 

Writing a SQL Select Statement 
When the SQL SELECT statement has been created, it will look something like the following picture. Note that the 
Calibration Due field is set to a specific filter of less than 6/18/2019. This date is called a parameter (report variable), 
which can be changed with every printing. See the help topic on Report Parameters to learn how to add Parameters to 
SQL statements. 

https://www.apesoftware.com/calibration-control/help/locate-database
https://www.apesoftware.com/calibration-control/help/report-parameters
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Adding Fields, Labels, and Report Info 
In the image at the top of this page, I performed the following actions to create the Calibration Due report: 

 
1. Dragged the bound fields (e.g., Equipment ID, Model & Description) from the right side of the page (Fields - 

Bound tree) to their current location in the Detail band and resized them to fit their contents. 

2. Selected the Date fields and edited their properties (bottom-right corner of screen) so that the OutputFormat 
= 'M/d/yyyy'. 

3. Dragged Label objects from the left side of the screen to locations above each field in the page header, resized 
them to fit their corresponding fields, bolded, and underlined them. The page title (Calibration Due Report) was 
created the same way. 

4. Report Info objects were dragged from the left side of the screen to the left and right side of the footers. I clicked 
on each object and changed their properties (bottom-right) to . . . 

Set the Format String property of the date/time field to '{RunDateTime:M/d/yyyy}' 
 

Set the Format String property of the page number field to 'Page {PageNumber} of {PageCount}' 
 

Clicked the right-align button (top of page) for the page number field. 
 

5. Other minor tasks involving bolding, underlining, aligning, and positioning were made to make the report look 
the way I wanted it to look. 

Menu Settings 
Assuming the custom report is stored in the Ape application Reports folder, the default file name of the new report in the 
report menu will be the file name. Override the file name displayed by entering a preferred name in the User Data field 
of the report properties. Also, to place the new report under the first or second node of the report tree, place a 1 or 2 
before the other text in the User Data field. For example, entering ‘1 My New Report’ in the User Data field will place the 
name ‘My New Report’ under the first node. 

Preview and save the Report Layout 
Preview the report by clicking the 'Preview' tab at the bottom of the Report Designer window. Save the report layout 
by selecting the [Save] button at the top of the Report Designer Window. 

Choose a save file location and name your report ‘my due cal report’. The file location defaults to the Report folder 
under the Files Folder (select Open Files Folder from the File drop down menu) for the Ape application to find it. 

Report Parameters 

Pass Data to SQL Statements at Run Time 
Use Report Parameters in Calibration Control to pass information to the report's SQL string at run time. A Parameter 
dialog will then prompt the user for the required input when generating reports. 
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The general syntax for a report parameter is: 

 
<%ParameterName|PromptString|DefaultValue|Type%> 

 
Where: 

 

Parameter Name: Must be a unique Parameter name not used for any other parameter or field in the report. 
 

Prompt String: The text displayed in the Parameter dialog asking for input (e.g., Calibration Due By:) 
 

Default Value: The default value of the Parameter. 
 

Type: The Parameter type code of the parameter (see below). 
 

Parameter Type Codes 
 

AS: String 
 

AD: Date 
 

AB: Boolean 
 

AI: Integer 
 

ADB: Double 
 

AC: Combobox (i.e., drop-down lists) 
 

The following is an SQL statement that uses a 'hard coded' date, which means the SQL statement must be edited 
each time the default date needs to change. 

SELECT * 

FROM qryEquipmentMaster 

WHERE CalibrationDue < #2018-10-15# 
 

Conversely, the following sample shows the same SQL statement using a Parameter, which allows users to enter a 
date value at run time. 

SELECT * 

FROM qryEquipmentMaster 

WHERE CalibrationDue < #<%CalibrationDue|Due Date:||AD%># 

Date Default Values 
When using the AD (Date) Parameter Type code, several options are available for the Default Value: 

 

Specific Date: Exact date with the syntax of #YYYY-MM-DD# for MS Access or 'YYYY-MM-DD' for MS SQL Server. 
 

Number of Days: Positive or negative integer (counting number) indicating the number days added (or 
subtracted) from the current date. 
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BOM: Beginning of current month. 
 

EOM: End of current month. 
 

BONM: Beginning of next month. 
 

EONM: End of next month. 
 

BOPM: Beginning of previous month. 
 

EOPM: End of previous month. 
 

The following example uses the EOM Default Value code for the End of the Current Month: 
 
SELECT * 

FROM qryEquipmentMaster 

WHERE CalibrationDue < #<%CalibrationDue|Due Date:|EOM|AD%># 
 

Combobox Parameter Type 
Using the AC (Combobox) data type requires the use of the DefaultValue Parameter field to configure the Combobox. 
Within DefaultValue exactly six sub-fields, each separated by a slash ("/"), are required. This also means that exactly 5 
slashes must be present in the DefaultValue field. 

The six sub-fields are: 
 

1. Table or SQL *: Table or SQL for the records used in the combobox. 
 

2. Value Member *: Field name for the value, usually an ID field. 
 

3. Display Member *: Field name for the text displayed in the combobox. 
 

4. Filter: SQL filter phrase that limits the records displayed (e.g., "Active = -1") when using a Table name instead of a 
SQL statement 

5. Sort: SQL sort phrase that places the list of choices in a specific order (e.g., "Name"). When left blank, the 
Display Member is the default sort field. This field is only valid when using a Table name instead of a SQL 
statement. 

6. Default Value: One of the values within the list created by the Value Members field (e.g., 55ec4215-7f9b-4e9f- 
b583-56be9871b895 without apostrophes or quotes). 

Although not all fields are REQUIRED (*), their places must be defined with slashes like in the following DefaultValue 
example. Note that there are still five slashes ("/") even when only three sub-fields are used. 

 
tblPeople/PersonId/DisplayName/// 

Report Settings 

Find and Change Settings of Custom Reports 
In Calibration Control within the 'Report Designer' grid (found in the Tools tab of the ribbon menu), find and modify 
the settings of custom reports. Adjust paper size, orientation, gutters, styles, fonts, and more. 
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Open Settings 
Find most of the settings for the custom reports by double-clicking the Settings node in the top-right corner of the 
Report Designer. 

 
 

 
Page Setup 
Adjust the Margins and Gutter settings. 

 

 
Printer Settings 
Set paper size, orientation, and other page settings. 
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Styles 
Define new or edit existing font styles. 
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Global 
Modify the Report Designer settings for layout, units, maximum number of preview pages, and word-wrap in the 
Script Editor page. 

 

Update Default Reports 

Quickly Update Default Report and Label Templates 
In Versions 9.0.4.2 and higher, go to the Utilities tab and click Refresh Templates. All of your reports and labels will 
be moved to the Backup folder and replaced with the most up to date default templates. All of your custom reports/labels 
will need to be MANUALLY updated. If you need help updating your custom reports, contact us for a screen share and 
we can show you how to update your reports. If you only added some text and a logo to your custom report, for example, 
it would be simple to recreate the custom report using the default reports instead of manually updating it. 

 

 
 
 

https://www.apesoftware.com/help/remote-desktop-support
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Manually Update Default Reports Using a 2-
Step Process 
To find the Reports folder, click on File and select "Open Files Folder", then open the Reports folder to find all of the 
default reports. When a report is customized, make sure to create a custom name for the file, adding "_custom" or 
"_yourcompanyname" works best. During version updates for CC, default reports may be updated and the custom reports 
will be overridden if the original file name is not changed. 

 

 
Steps to Update Default Reports 

1. Delete the Default reports in the Reports folder. 
 

2. Restart Calibration Control. 
 
If the customized reports do not have a new custom name then they will be overridden with the new version update. To 
accommodate for this, Ape creates a backup folder within the Reports Folder and moves all of the old reports into that 
folder. This means that if the custom reports you had in the main Files Folder are gone, first check the backup folder 
and rename them before replacing. 

SQL SELECT Statement 

Useful with Calibration Management Software 
Reports 
SQL stands for Structured Query Language. SQL is the basic language of most common databases, including MS 
Access and MS SQL Server, the two databases that Calibration Control can use. For the purpose of report writing, the 
part of the SQL language we need to focus on is the SELECT statement, which retrieves information from Calibration 
Control. 
Although SELECT statements are used by reports, web pages, on screen displays, and even when moving data between 
applications, we will need SQL primarily for reports. 
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A Primer on Tables 
Before we get started, let’s make sure we understand the source of our data when we use a SELECT statement. Within a 
database, information is stored in tables that look something like a spreadsheet with columns and rows. Unlike a 
spreadsheet, a table uses records (horizontal rows) and fields (vertical columns). 

Imagine each record in the database as a photocopied standard form used for keeping track of test equipment and 
imagine that these forms are kept in a file. The file may have a hundred forms, each with information describing a specific 
piece of test equipment. Just like a table, these forms can be sorted in different orders and records can be scanned by a 
single field on each form; it just takes a bit longer with paper compared to a database table. 

The Equipment Master View 
Within Calibration Control, you will probably derive most of your reports from the qryEquipment view (also called a query) 
because it has most of the required fields for your test equipment records. The fields in the view will also be easier to 
read than their corresponding codes in the root table. Think of a view as a way to pre-package part of the SQL complexity 
that makes data easier to work with. 

As an example, the contents of the tblEquipmentMaster table (where the data is actually stored) contain fields like 
ModelNumberID with meaningless numbers in the fields (see image below). On the other hand, look at the qryEquipment 
and you will see the actual model numbers and descriptions that look familiar. This is because the view has SQL code in 
it that looks up and displays the meaning of the ModelID code so you don’t need to. 
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SELECT * 
FROM qryEquipment; 

 
SELECT * 
FROM qryEquipment 
WHERE (DepartmentCode = 'QA') AND (CalibrationDue <> #5/1/2019#) 
ORDER BY Location DESC, SerialNumber; 

 
SELECT * 
FROM qryEquipment 
WHERE (DepartmentCode = 'QA') AND (CalibrationDue <> '5/1/2019') 
ORDER BY Location DESC, SerialNumber; 

The SQL SELECT Statement 
There are four main parts of the SELECT statement that we need to cover: 

 

SELECT – (IDs the fields from a table that will be included) 
 

FROM – (IDs the table where the fields come from) 
 

WHERE – (Defines the filter that includes only the records you want to include) 
 

ORDER BY – (Defines the sort order of the records) 
 

While the SELECT and FROM clauses are always required, only the WHERE and ORDER BY clauses need to be 
included when filtering and sorting. Otherwise, the results will include all records and in no particular order other than 
the physical order of the underlying table. 

Here is an example of a common SQL statement used to return all the fields from the qryEquipment view: 
 

Pretty easy, right? Notice the asterisk (*)? The asterisk is a wildcard that includes all fields. With the relatively easy 
SELECT statements that we need in our Calibration Management Software, using the wildcard is usually the best 
bet because you don’t need to worry about forgetting a field when designing the report. 

Now let’s assume that we want to filter and sort our results in the following example: 

 
You can even add multiple filters and multiple sorts with the following MS Access: 

 

Note that the date value has number signs (#) around it rather than the single quotes of the text values? You need to use 
the # sign when using MS Access and the single quote (‘) when using SQL Server. Although both databases use SQL 
Server, there are still slight differences. 

Here's the same code for MS SQL Server: 
 

The final example deals with filtering for numeric values and is compliant with both MS Access and MS SQL Server. 
Note that the value (1) uses neither the single quote (‘) or the number sign (#)? 

 
SELECT * 
FROM qryEquipment 
WHERE DepartmentCode = 'QA' 
ORDER BY Location; 
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You can learn more about the SQL SELECT statement through an Internet search or go directly to Microsoft for SQL 
Server SELECT Statements or MS Access SELECT Statements . 

 

Dashboard Charts 
Under the Calibration tab in the Visual group, you'll find a new Dashboard including Column charts, Pie charts and 
more. You can change the look and feel of the dashboard by customizing each chart. 

 

 
Refresh the Dashboard and the randomized chart colors by right-clicking a grey area and clicking Refresh. Additionally, you 
have Options to modify the alignment and spacing of the charts. 

Edit Dashboard Charts 
To edit each chart, double click the chart or right-click and select Edit. 

Chart tab 
If you want to remove a chart from the Dashboard, deselect the Active checkbox. You can also edit all Dashboard Charts 
in the Tools tab of Calibration Control. 

Sort Order determines the order of the charts in the Dashboard. 
 

Height and Width: The default height of 0.5 refers to 50% and the Width of 0.2 is 20%. Any number above 0.9 is in 

pixels. Click the Refresh Chart button to see the reflected changes while editing. 

 
SELECT * 
FROM qryEquipment 
WHERE FrequencyUnits = 1; 

https://docs.microsoft.com/en-us/sql/t-sql/queries/select-transact-sql
https://docs.microsoft.com/en-us/sql/t-sql/queries/select-transact-sql
https://msdn.microsoft.com/en-us/library/bb208930(v%3Doffice.12).aspx
https://docs.microsoft.com/en-us/sql/t-sql/queries/select-transact-sql
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SQL| Grid tab 
Whether you are using a MS Access or SQL Server database, the SQL for the appropriate database type will be 
automatically selected. The SQL script produces the chart data and you can view the Results in grid format by 
clicking Refresh Grid. 

 

 
Legend tab 
First, make the Legend visible by checking the Visible checkbox and Refreshing the Chart. Then, you can use the 
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available settings to modify the legend. 

 
 

Pie | Doughnut tab 
If you are editing a Pie or Doughnut chart, use these available settings to modify the chart. 

 

 
Column | Bar | Line tab 
Column or Bar spacing settings are located on the left. Settings for Line or Spline charts are located on the right. 
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Edit Titles 
By default, all charts have a Top title already visible. You can edit each available title in this dialog but only the titles 
marked as Visible will appear on the chart. 
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Edit XY Titles 
You can edit XY chart titles here. The Visible titles depend on the type of chart you are editing. For example, Stack 
Column charts use X and Y titles. 

 

Displaying Charts 

Use Pie, Column, and Bar Charts to Visualize 
Your Data 
Display the Charts grid by clicking on the Charts icon in the Calibration tab of the ribbon menu. 

 

 

Chart Data Tables 
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Use the Data Table combo box to select what information is shown in the Chart. 
 

 
Customize a Chart by editing the default Title and by changing the settings for Chart Type, Color Model, and 
Legend position. Use the Data Table combo box to choose which department information is used. 

 
 

Saving and Printing Charts 
Right-click the Chart screen to Save (several formats) or Print the Chart. ‘Save as PNG – Transparent Background’ 
is recommended for use in reports and presentations with backgrounds other than white. 
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3D Charts 
Change the viewing angle on 3D Chart Types by holding down [Alt] and then clicking and dragging the mouse to the 
best angle. Zoom in and out of the Chart by rolling the mouse roller back and forth while keeping the [Alt] button 
pressed. 
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‘Min Others Pie Slice’ (for pie charts only) 
Use ‘Min Others Pie Slice’ to group very small percentages into an ‘Other’ category. This helps to declutter the pie 
chart when there are too many slices. 



  
CALIBRATION CONTROL MANUAL 228 

 

 

Due Cal Calendars 

Visualize Due Cal Equipment in Calendars 
Display a Calendar of Equipment Calibration Due dates by clicking the Calendar icon in the Calibration tab of the 
ribbon menu. 

 

 
Toggle between Month, Week, or Day views using the tabs at the top of the Calendar screen. 

 
Click on specific dates in the Calendar to view which tools are due to be calibrated on that date. The ‘Equipment Due 
Cal’ label automatically displays how many tools are due for calibration on that date. Click in the default label to 
customize. 
Switch between viewing month, week, or day by using the tabs shown in the top left corner of the dialog below. 
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Quickly view Equipment Due for Calibration dates in different months by clicking through the mini calendar view in 
the upper left-hand corner of the screen. The current day is highlighted in a red box while the day selected is 
shown in orange. The bold dates are ones with at least 1 equipment that will be due for calibration. 

Adjust the number of weeks visible in the Calendar screen by clicking up or down in the ‘Visible Weeks’ box (Month 
view only). 
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Printing Calendars 
Print a 5-Week, 1-Week, or 1-Day Calendar by viewing dates you want to be printed in the Calendar screen and 
clicking [Print]. 

 
 

Customize printing Paper Size and Source, Orientation, and Margins by clicking on [File], then [Page Setup...]. 
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Security Methods - How They Work 

Database Security 
When using a MS SQL Server database in Calibration Control, the built-in SQL Server and Windows authentication will 
keep the database protected. Otherwise, when using MS Access the database file (apecal.mdb) can use a database 
password. 

Activating User-Authentication (Sign-In Mode) 
Any user can activate User-Authentication mode after ensuring at least one active User has Admin privileges. Only a 
User with Admin privileges can deactivate User-Authentication. 

 

 
What an Administrator Can Do 
Administrators have full access to all parts of the application that require any level of security. An Admin can create Users 
and change the privileges of any other User, including other Admins. Administrators cannot remove themselves from being 
an Admin while User-Authentication mode is activated; one Admin must remove the Admin privileges of another. This is a 
safety feature to ensure there is at least one Admin while the application is in User-Authentication mode. 

Administrators and Passwords 
When an Administrator creates or changes the password for any User other than themselves, that User will be required 
to change their password the next time they sign in. Use the Password Security Dialog page for help in implementing 
and adjusting Password Security methods. 

Pre-Defined Roles 
There are six pre-defined security roles, which are: Administrator, Super User, Supervisor, Technician, Layouts and No 
Role (read-only user). Although these Roles cannot be changed, Admins and Super Users can change which Role has 
access to which Permission. In addition to a role, a user can be a Terminal User. This means they can only use 
Calibration Control's Terminal Mode. 

Hierarchy of Roles 
A User with no Roles assigned can see, print, and export any information within the database. Each of the other Roles 
has the privileges of a User with no Role in addition to: 

Administrator: Can do anything that requires security. 

https://www.apesoftware.com/calibration-control/help/database-password
https://www.apesoftware.com/calibration-control/help/database-password
https://www.apesoftware.com/calibration-control/help/password-security
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Super User: Can do anything an Administrator can do except add or edit Users. 
Supervisor: Same authority as Technician and Production, can also edit Technician Name and Status 
of calibration records, and can remove relationships between Equipment and Jobs. 

Technician: Can create and edit equipment records. Cannot edit the Technician Name (added 
automatically) or the Status of calibration records. 

Layout: Has the authority to make most application layout changes relating to the look and feel of 
the database. 

 

 
Permissions 
There are pre-defined Permissions for specific areas of the application that require a given level of security. Although 
each Permission has a default minimum Role, Administrators can change the Role of any of the Permissions. Non-admins 
can only view the Permissions grid but cannot make changes. 

Change Log 
All field and label changes are tracked in the 'Change Log' grid found in the Data Grids tab of the ribbon menu. It 
records time and date, user (if User-Authentication mode is activated), the screen where the changes were made, 
machine (computer) name, and the detail of the change. The change detail includes field names and before/after data. 

https://www.apesoftware.com/calibration-control/help/permissions
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Users 

Creating a User 
Select the Users icon under the Utilities tab in the ribbon menu and create a new User record by double-clicking in 
the gray area or right-click for the context menu and choose [New Record]. 

User Tab 
The only required fields are 'User Name' and 'Password'. When creating a password, select from the various 
checkboxes below the password field. By default, the password will be marked as Temporary and the new user will be 
marked as Active. 

If a Person record already exists for this User, select that record in the Person dropdown. 
 

You can choose a language for the user in the Language dropdown. The language is unique to each user. 
 
Roles 

In the Roles section, select a role for this User. To view the Permissions each role has by default, go to the 
Permissions grid located in the Utilities tab. Users with No Role (read-only rights) are free of charge. 

 
 

In addition to the user's role, selecting Terminal User will allow the user to connect to Calibration Control's Terminal 
Mode but the user will NOT be allowed to use the full version of Calibration Control. 

 
 

https://www.apesoftware.com/calibration-control/help/people
https://www.apesoftware.com/calibration-control/help/terminal
https://www.apesoftware.com/calibration-control/help/terminal
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Advanced tab 
Lockouts 

Here you can Remove Lockouts, view the number of failed log in attempts and the last locked out date. 
 
Logins & Password 

Calibration Control keeps track of the user's last log in date and the number of log ins since the user record was created. 
 
Domain 

A Windows User name can be used instead of a username and password. 
 
Advanced Skills 

In this section, you can give users the ability to edit SQL statements or HTML in the software (i.e. Auto Emails & 
Dashboard Charts). By default, these checkboxes are not selected. 
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Notes Tab 
Add or Link Note records to each User record. 

Sign-In Mode (Enabling Authentication) 

Set up and Turn on User Authentication 
Utilize User Authentication to keep track of changes made in Calibration Control. Activating Sign-In mode is simple. All 
you need is at least one user with an Administrator role. 

Creating an Admin User 
Create a User record and select Administrator as the role. 

Turning On User Authentication 
After creating at least one user with an Administrator role, open the Options dialog > Advanced tab > Security and select 
Activate Sign-In Mode. 

https://www.apesoftware.com/calibration-control/help/users
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Click Yes and Calibration Control will restart. Then, the Sign-In dialog will open. 
Note: If you select Remember Sign-In, you can undo this in Calibration Control by going to File > Sign Out and 
restarting the program. 
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Password Security 

Using the Password Security Dialog 
Go to the 'Options' dialog and go to the Advanced tab, then Security and select Password Security. 

 

 
Use the Password Security dialog to set expiration times, password strength, and naming rules. 

A default value of zero (0) means that a setting is not active. 
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Maximum Settings 
Set the maximum limits for password usage: 

 

Days Before Expiration: Number of days before a User's Password expires and must be changed. 
 

Unused Days Before Expiration: Number of days a User can go without signing in before their Password 
expires and must be changed. 

Invalid Password Attempts: Number of times an incorrect Password can be entered for a given User before that 
User is locked out. Entering a correct Password for the same User sets the number of incorrect password 
attempts for that user back to zero (0). 

Minimum Characters 
Minimum Character password rules are enforced when a User creates a new password after signing in with a temporary 

password. The password assigned by an Administrator in a User dialog is temporary and is not subject to these rules. 
 

Upper Case: Minimum number of Upper Case characters required in a Password. 
 

Lower Case: Minimum number of Lower Case characters required in a Password. 
 

Special (e.g., ~@#$%^): Minimum number of Special Characters required in a Password. 
 

Length: Minimum character length required for a Password. 

Check Settings 
Additional safety settings for passwords. 

 

Different From Temp: When checked, Passwords cannot be the same as a Temporary Password set by an 
Administrator. 

Cannot Contain User Names: When checked, Passwords cannot contain the First, Last, or User name of 
a registered User. 
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Reset Login by Admin 
When a User is locked out due to invalid password attempts, an Administrator can reset the User Login information 
from the Advanced tab of the 'Edit User' dialog. 

 

Database Password Encryption 

Encrypting an MS Access Database with a Password 
Part of the data security within Calibration Control includes the password encryption of MS Access databases. This 
meets the standards of the FDA's 21 CFR Part 11 requirements. 

You can take the following steps to add a password to your MS Access database: 
 

In order to encrypt your database with a password, you must first open the database in Exclusive Mode. 
 

Start Microsoft Access. 
 

Click Open, then Browse. 
 

Browse to your database file location and select the database by clicking it once. 
 

Click the downwards arrow next to Open, then click Open Exclusive. 
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In MS Access, click File then Info. 

 

Click Encrypt with Password. Your version of MS Access may say "Set Database Password" 
 

Type in your password, type it again to verify and click OK. 
Note: Use a strong password and store the password in a secure place. If you forget your password, Microsoft 
won't be able to retreive it. 

Start Calibration Control and you'll be prompted to enter your database password. 

 
If you do not have MS Access installed on your computer, or you could not complete the above steps successfully, 
contact us and we can help. 

Permissions 

Change the Roles Required for Any Permission 
Permissions are now in the Utilities tab (Security group). Any user can view the Permissions grid but only 
Administrators (by default) can edit Permissions. 

**Pre Version 9.2 
First, go to File > Options. For Version 9.1.2, go to the Advanced tab > Security > Edit Permissions. For Versions 9.1.1 
and older, go to the Security tab > Edit Permissions. 

https://support.office.com/en-us/article/encrypt-a-database-by-using-a-database-password-12aa0e5c-34c6-4957-af3b-b5f5cfa9a766#bm2
https://support.office.com/en-us/article/encrypt-a-database-by-using-a-database-password-12aa0e5c-34c6-4957-af3b-b5f5cfa9a766#bm2
https://www.apesoftware.com/calibration-control/help/about-contact-us
https://www.apesoftware.com/calibration-control/help/about-contact-us
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Permissions can be edited by double clicking each record. You can change each permission's required Minimum Role by 
selecting from the dropdown. In the reference below, anyone with a Technician role or higher has Permission to Add 
Attachments. 

 

Reset Options 
There are two reset options, one for each Permission and one for all Permissions. You can reset EACH permission within 
each Permission dialog and you can reset ALL permissions by right-clicking on the Permissions grid and selecting Reset 
All Permissions. 

Change Log 

Audit Changes Made in Calibration Control 
The Change Log grid shows a complete list of all the changes made within the program, including time, date, user, 
and technical information. Find this feature in the Data Grids tab of the ribbon menu. 

https://www.apesoftware.com/calibration-control/help/security-methods
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Determine how many records are shown using the combo box on the left-hand side and search for a specific record using 
the search bar on the right-hand side. Filter options are the same as other grids, and can be found in the row under the 
column headers; enable or disable the Filter row feature by right-clicking in the grid to bring up the context menu and 
toggling the [Filter Row] option. Each column has a default search option of "Contains", and hover the curser over the 
row to reveal a drop-down box and the clear filter button. 

 

 
Columns of the Change Log Grid 

Change Time: Date and time that the change took place. 
 

User: When sign-in mode is enabled, this will show the name of the user who made the change. 
 

Dialog: The dialog box in which the change occurred. 
 

Change Detail: An auto-generated description of the change that was made in the database. 
 

Person: The full name of the User profile who made the change. 
 

Computer: Which computer the change was made on. 

FDA 21 CFR Part 11 Compliance 

FDA Software Compliance 
Ape Software's calibration management software (Calibration Control) complies with FDA 21 CFR Part 11 Rule on 
electronic records and signatures by containing the following functionality: 

Authentication at User Level 
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Calibration Control has the ability to individually authenticate each user for the purpose of audit trails and 
electronic signatures. 

File Integrity 
The default MS Access back-end database is secured through password encryption, which includes tamper detection. If an 
MS SQL Server is used as the back-end database, instead of MS Access, the necessary security features are already part 
of SQL Server. 

Change Management (Audit Trails) 
All user activities (e.g., record changes & calibrations) are automatically recorded in the Change Log to provide an 
audit trail. 

Electronic Signatures 
Re-entry of password required upon electronically signing (approving) Calibration Event (optional). Also, inherent in the 
Change Log, all user activity relating to equipment maintenance and calibration is recorded (electronically signed). 

Password Strength 
Ability to define the strength required for passwords including numbers of upper, lower, number, and special characters. 
Ability to define expiration intervals and other features. 

Inactivity Settings 
Ability to define the number of inactivity minutes in a usage session before the application times out and users are 
required to sign in again. 

Sessions 

See Who is Using Calibration Control 
See which users or machines (i.e., computers) are currently using or have used the software. Time and date stamps show 
when the software was used (start and end times) and also shows if the session was interrupted due to network 
problems. Find the Sessions grid in the Utilities tab of the ribbon menu. 

 

 

Sessions Grid & Dialog 
The Sessions grid shows a READ-ONLY log of sessions and displays the following fields: 

 

Machine: Shows the name of the machine (computer) the session was conducted from. 
 

User: Displays the name of the User (e.g., Admin) of the Session. A blank 'User Name' field indicates that 
the Session was conducted while User Authentication was disabled (i.e., Machine Authentication). 
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Person: Displays the name of the person from the Person table record linked to the User record at the time of 
the Session. If this field is blank while the User Name field is not, it means that the User record was not linked 
to a Person record. 

Session Start: When the user signed in to the software. 
 

Session End: When the user signed out of the software. If this field is blank the session is still active or was 
interrupted (e.g., network interrupted). When the user for an interrupted session signs in again, the previous 
session with a blank 'Session End' field will automatically close (receive a date and time) and the 'Interrupted' 
checkbox will be ticked to indicate an ungraceful exit. 

Interrupted: This box is checked when the session was ended ungracefully (e.g., software not shut down 
normally or network interrupted). 

Session Bumped checkbox: Check this box to terminate a session for the selected user. This is helpful when 
the user count exceeds the software license agreement and is preventing registered users from using the 
software. 

 

 
 

View All or Current Sessions 
Toggle between viewing All or Current sessions by right-clicking in the grid for the context menu and selecting 'All 
Sessions' or 'Current Sessions'. Sort the sessions grid using the filter row to easily find the record you are looking for. 
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Machines 

Control Computer Access in the Machines Grid 
The Machines grid shows a list of all the machines (computers) that connect to the Calibration Control database and 
the number of times they have connected. Find the Machines grid icon under the Utilities tab of the ribbon menu. 

 

 
The Machines dialog contains a name field which is auto-populated by the software when a machine (i.e., computer) user 
is signed in, a space for notes to be added, and an 'Is Blocked' checkbox. The only fields that can change in the Edit 
dialog are the 'Is Blocked' checkbox and the Notes field. Only check the 'Is Blocked' checkbox if you need to remove a 
machine from the license count by blocking that machine from using the software. 

The Meta Tab displays the meta-data pertaining to the selected record and IS A READ-ONLY INFORMATION tab showing 
the date and time the record was created, the user that created it (if they are signed in), as well as the most recent date 
and time the record was updated, and the machine that made the change (if no user is signed in). 



  
CALIBRATION CONTROL MANUAL 246 

 

 
 

In addition to the IsBlocked checkbox, you can quickly block ALL machines besdies the one you are current using. 
Right- click the grid and at the bottom of the context menu, select Block All but Me. 
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Licensing and Authentication 
Ape Software applications can be used in "Machine" or "User Authentication" modes. The default mode is Machine (no 
sign-in) although User Authentication (sign-in) can be enabled for additional security controls and more accurate 
change records (e.g., who changed what and when). 

Users can only have one active session at a time. 

Machine Authentication (default) 
Machine Authentication means that User Authentication (sign-in mode) is not enabled. Therefore, the license count is 
managed by the names of the individual computers (i.e., machines) that connect to the database. This is the default 
method of authentication. 

User (Machine Perspective) 
When using Machine Authentication all users who connect to the database have full access, so everyone (each machine) 
is considered a user for the purposes of license use. 

Per Seat Licensing 
With a Per Seat license and User Authentication not enabled, the number of machines that connect to the database 
cannot exceed the license count. 

For example, with a 2-user license no more than two unique machines can connect to the database. 

Concurrent (at the same time) Licensing 
With a Concurrent license, and User Authentication not enabled, the number of machines that connect to the database 
at the same time cannot exceed the license count. 

For example, with a 2-user concurrent license, unlimited machines can connect to the database, but no more than two 
of them at one time. 

User Authentication 
User Authentication means that at least one User was created, at least one of those Users was given Administrator-level 
access, and User Authentication is enabled. In this scenario, license count is managed by the number of Users created 
within the software who have some level of write access within the software (e.g., Technician, Supervisor, or Administrator). 

User (Authenticated) 
When User Authentication is enabled only users that have any level of write access (i.e., have a role checked in their 
User record) count as a user for the purposes of license use. 

Per Seat Licensing 
With a Per Seat license, and User Authentication is enabled, the number of authenticated users that connect to 
the database cannot exceed the license count. 

For example, with a 2-user license there should be no more than two authenticated users (listed in the "Users" grid) 
that have a role defined. 
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Concurrent (at the same time) Licensing 
With a Concurrent license and when User Authentication is enabled, the number of authenticated users who connect to 
the database at the same time cannot exceed the license count. 

For example, with a 2-user concurrent license any number of authenticated users can exist in the User Grid but no 
more than two of those users can connect at the same time. 

Simple Troubleshooting 

Fix Most Setup or Configuration Problems 
Most configuration or setup problems encountered while using Calibration Control can be resolved or isolated using the 
following steps. 

1. Version: Confirm that the most current version is installed: Download Ape Software. 
 

2. Reset: Try a simple reset, by closing Calibration Control and either holding CTRL and starting Calibration Control or 
manually deleting the configuration file in the Settings folder: 'general.config' file. The Settings Folder is located at: 

C:\Users\Public\Documents\Ape Software\Calibration Control 
 

Note: The database location is defined in the general.config file. Therefore, if the general.config file is deleted, but 
an 'apecal.mdb' file is still in the Settings Folder, which is the default location for the Data Folder, then the 
application will automatically connect to that database (i.e., apecal.mdb). If the apecal.mdb file does not exist in 
the Settings folder, the [Choose Database Format] dialog will appear. Follow the prompts of the dialog to re-
connect to the database. 

https://www.apesoftware.com/calibration-control/download
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4. Isolate Access Database: Assuming none of the above measures resolve the problem, this step will help identify 

if there is a problem with the database. 
a. Open the Data folder from the File menu and then close Calibration Control. 

 
b. Rename the 'apecal.mdb' file to something else like '_apecal.mdb'. This will make CC recreate a new 

default database in the Data folder. 

c. Restart CC and when the dialog below appears, select the [MS Access] button to create a new sample database. 
 

d. If the problem is resolved in the sample database, then zip your '_apecal.mdb' file (your database) and the 
'errorlog.html' and email these files to service@apesoftware.com with a description of what you are 
experiencing. 

e. If the problem continues to occur with the sample database, contact Ape Software for assistance. 

mailto:service@apesoftware.com
https://www.apesoftware.com/about/contact-us
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Problem Steps Recorder 
Utilize the built-in Problem Steps Recorder to record the steps you are taking to reproduce the error. Contact Ape 
Software at service@apesoftware.com with the following information, or as much of it as possible: 

a. Description of what you are doing that leads to the issue you are trying to communicate. Include as many details 
as you can and include relevant screenshots. 

b. Problem Steps Record File (see above), if possible (file has an *.mht extension) 
 

c. The 'errorlog.html' file from the Settings folder 
 

d. The 'general.config' file from the Settings folder 
 

e. The 'apecal.mdb' file from the Data folder 
 

f. Zip the above files into a single file/folder if you know how 
 

 

Crash Reports 
The Ape Software Crash Reporter dialog will appear if Calibration Control encounters an error. If this dialog appears, 
you can easily help us find the cause of this error and we can help you by preventing it from happening again. 

Tell Ape About This Crash 
If you receive a crash while using Calibration Control, please check the Tell Ape About This Crash checkbox. This sends 
us the Error Detail and other relevant information. If the checkbox is not checked, we are not receiving any details of any 
crashes you may encounter. However, if you contact us about a crash, we'll need to locate the Log of All Errors (error log) 
stored on your computer. 

Description 
While the Error Detail is one of the most important pieces of the puzzle, you can add your own description of what 
happened and it can help us put all the pieces together. Try to be as descriptive as possible so we can follow your 
steps while testing. 

Follow up 
Finally, your email address is not required to send us details of the crash but it could save both of us some time. If the error is 

crucial and keeping you from working, your email address could allow us to easily contact you. Even if the error appears to be 

minor, we may need to contact you if you did not leave a description or if we need more clarification. 

https://support.microsoft.com/en-us/help/22878/windows-10-record-steps
https://www.apesoftware.com/calibration-control/help/contact
https://www.apesoftware.com/calibration-control/help/contact
mailto:service@apesoftware.com
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Find Lost Records in Equipment Grid 

Troubleshooting Missing Records 
The two most common things that make it look like some or all of your records are missing in Calibration Control (our 
Calibration Management Software) are (a) un-cleared filters in the filter row or (b) records with hidden status codes. 

Clearing the Filter Row 
The row at the top of the grid that looks blank is actually a filter row. Learn more about the filter row by checking out the 
filter row help topic. A single column can be cleared by clicking on the clear filter button (funnel with a line through it) 
within that column. Clear all of the filters in the row by clicking on the far left clear filter button. 

 

https://www.apesoftware.com/calibration-control/help/filter-row
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NOTE: If the phrase 'FILTERED Records' is displayed in the grid header, then not all of the fields have been cleared. 

 

 
Showing Hidden Records 
Some of the records may be hidden because they are assigned a status code with a ‘Hide these records in the Browse 
Table’ attribute set to true. Learn more about hiding and showing records with certain Status Codes by reading the Hiding 
Equipment Records by Status Code help topic. Just right-click in the Browse Grid and toggle the Show Hidden Records 
option. 

 
 

https://www.apesoftware.com/calibration-control/help/hiding-status
https://www.apesoftware.com/calibration-control/help/hiding-status
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Lost or Invalid Product Key / Lost All Records 

Troubleshoot an Invalid Product Key or Lost Records 
In Calibration Control, if it looks like some records are lost or that a product key is absent or no longer valid, the most 
common scenario is that there are multiple databases on your computer and you are currently connected to a new 
blank database. Therefore, the solution is to redirect Ape software back to the master database. 

How It Happens 
Network Database: The database has been moved to a common network location for multiple users, safety, security, 
and/or ease of backup. 

Database Not Available: When launching Calibration Control, the software attempts to connect to the network database, 
but the network is down, paths are remapped, or permissions are changed. When the following dialog is prompted, you 
might quickly hit the [Enter] key to get past it, thereby unknowingly creating a new blank database in the default location 
on your computer's (C:) drive. 

 

 
How to Fix It 
Follow the instructions under the 'Add Additional Users' section of the Creating a Multi-User Environment help topic. 

Related Help Topics 
Locating a Database File (MS Access) 

 

Creating a Multi-User Environment 

 

https://www.apesoftware.com/calibration-control/help/multiple-users
https://www.apesoftware.com/calibration-control/help/locate-database
https://www.apesoftware.com/calibration-control/help/multiple-users
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Troubleshoot Calibration Control Not Working 

Why Did Calibration Control Stop Working? 
There are a few reasons why Calibration Control would stop working. Use these troubleshooting tips to resolve 
the problem. If these steps do not work, give us a call to set up a screenshare. 

Missing Database Drivers 
The most common problem that would cause CC to stop working is that the database drivers are not up to date or were 
deleted by another program. Sometimes the installation of other versions of MS Office will remove these drivers and they 
may need to be re-installed. Download the most current MS drivers here, and see if that resolves the issue. 

Missing .NET Drivers 
If installing the database drivers does not help resolve the issue, try installing the .NET drivers. 

Missing Read/Write Privileges 
Calibration Control requires users read/write access in a few folder locations that are listed in Minimum Requirements. 
Without the proper permissions to those folders, users cannot save changes in Calibration Control. The error messages 
usually indicate if the user is denied the privilege to create, edit, delete in the network folder location where the 
database resides, (e.g., "Insert Unsuccessful: The database insert failed." or "Data provider failed while executing a 
provider command. Operation must use an updateable query."). 

Cannot Connect to an Unstable Database 
If users receive an error message opening Calibration Control that reads, "Data Provider could not be initiated," this points 
to problems within the database and Calibration Control cannot connect to it. Most of the time, a corrupt MS Access 
database can be quickly repaired. Refer to our troubleshooting tips for MS Access Database Corruption and How to 
Repair your MS Access Database. If SQL Server database is corrupt, contact us for troubleshooting help. 

Server is Waiting for a Response 
The server might require a response relating to the database locking file (*.ldb). See if there are any messages on 
your server that need to be dismissed. 

Get Ape Support 
If installing the drivers does not work, send us an email and attach the following files from this 
folder (C:\Users\Public\Documents\Ape Software\Calibration Control) on your computer: 

connectionlog*.csv 
 

errorlog*.html 
 

general.config 
 

If you can, zip up a copy of your database and add it to these files. 
 

https://www.apesoftware.com/about/contact-us
http://www.microsoft.com/en-us/download/details.aspx?id
https://docs.microsoft.com/en-us/dotnet/framework/get-started/system-requirements
https://www.apesoftware.com/products/minimum-requirements
https://www.apesoftware.com/articles/repairing-corrupt-database
https://www.apesoftware.com/articles/repairing-corrupt-database
https://www.apesoftware.com/about/contact-us
https://www.apesoftware.com/articles/repairing-corrupt-database
https://www.apesoftware.com/about/contact-us
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Troubleshoot Database Location 

Why Am I Seeing the "Choose Database Type" Dialog? 
When Calibration Control starts up, it looks in the Settings Folder to find the "general.config" file which tells CC where 
the database is located. If that file is missing, has been moved, or has been renamed CC prompts the "Choose 
Database Format" dialog. To navigate to the misplaced database, choose the "BROWSE to Existing Database" option 
and click [Continue]. 

 

 
In order to browse to the existing database you must first know where the database has been moved to. This is a 
question that Ape Software does not know, but once the existing database has been located by you then the Calibration 
Control software will remember the current location. 

Last Known Location of Database 
When the location of the database is unknown, check the Connection Log which is located in the Settings 
Folder [C:\Users\Public\Documents\Ape Software\Calibration Control]. 
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Within the Connection Log Excel document, locate the most recent date and its database path will show a network 
location of where the database used to be. This may give some insight into where the new database location would be. 

To reset Calibration Control to factory default, delete the "general.config" file and restart Calibration Control. 

 

Troubleshooting Label Printing 

Label Print Failed 
If you receive an error message window upon printing a label, you'll notice there are several error messages. The first will 
be the most likely cause but might not always be the most accurate. The Code Error message will show a very short 
description of the error. Finally, the System Error will show the most accurate description of the error, though it may 
require some research. 

1. Take a screenshot of the error message to refer back to. 
 

2. Eliminate the most likely cause by reinstalling the label printer drivers and/or disconnecting/reconnecting your label 
printer. Search for your specific label printer on Brother's support site to find the proper troubleshooting methods for 
your device. 

3. Take a look at the Label Print Failed error message below and the different solutions to find one that works for you. 

https://support.brother.com/g/b/countrytop.aspx?c=us&lang=en
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Solution 1 
Some users have encountered this error after updating from Windows 7 to Windows 10. The most successful solution 
is downloading and installing these Brother label printer drivers: b-PAC3CCI Setup. 

Solution 2 
You may see a slight difference in the error message if you are using a Windows 7 computer and you may see there is an 
error with vcruntime140.dll. Downloading and installing the newest version of Microsoft Visual C++ Redistribution 
package has solved this error as well. You can find the latest supported Visual C++ downloads here: 
https://support.microsoft.com/en-us/help/2977003/the-latest-supported-visual-c-downloads 

 
 

Get Ape Support 
If you've tried all the solutions provided and you are still unable to print a label, email us and include the error 
message screenshot. We may have encountered the same error before and may have a quick solution for you or 
we can troubleshoot together with a call/ screenshare. 

No Label File Error 

Label File Could Not Be Loaded 
When attempting to print a label in Calibration Control, the following dialog will display when (a) there is a problem with 
the label drivers, (b) printer, or (c) the label file is missing. 

 

 
This situation most often occurs after a change in computer settings, such as (a) new computers, (b) wiping hard 
drives and reinstalling the OS, (c) cleaning after a virus, and (d) installing or uninstalling other software. 

The main issue is that the printer drivers are not reinstalled or not installed properly, as was previously accomplished. 

Label Printer Drivers 
Download and install the Brother label printer drivers for your model. When using a label printer connected to the network 
(rather than a computer) or a label printer is connected to another computer, you will need to manually add the label 
printer to the Windows Devices and Printers. 

P-touch Editor Software 

https://www.apesoftware.com/products/download/7D36BCB6-E313-4923-A016-BD2077FBDFBC
https://support.microsoft.com/en-us/help/2977003/the-latest-supported-visual-c-downloads
https://www.apesoftware.com/calibration-control/help/brother-software
http://windows.microsoft.com/en-us/windows7/install-view-and-manage-your-devices-and-printers
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If you can see your label printer enabled in the Windows Devices and Printers but are still unable to print labels, 
try installing the free Brother P-touch Editor Software. 

If this still does not resolve the problem, contact Ape Software for assistance. 

Troubleshoot SQL Server Connection 

For Use with Ape Software Databases 
WARNING: Ape Software applications can only connect to databases created by and specifically for the given Ape 
Software application. Blank databases, databases created by non-Ape professionals, and modified Ape Software 
databases will not connect or not connect properly. Also, SQL Server databases created by migrating an existing 
MS Access database will also not work and often have severe functional issues sometimes not immediately visible. 

Universal Data Link (UDL) File 
Use a UDL file to create a direct connection to a SQL Server database with as few other variables as possible, like 
connecting through other software. This helps to simplify and focus the troubleshooting process on the most likely 
failure points (e.g., SQL Server configuration or network permissions). 

A UDL file is simply a text file with a .udl extension. Therefore, creating a UDL file is as simple as creating a new text 
file and changing its extension to UDL. 

Create a UDL File 
Create a UDL file by (1) right-clicking in a folder or desktop, (2) selecting 'New', (3) selecting 'Text Document', and then (4) 
creating a text file with a .udl extension (e.g., MyTestFile.udl). 

 

http://windows.microsoft.com/en-us/windows7/install-view-and-manage-your-devices-and-printers
http://welcome.solutions.brother.com/bsc/public/us/us/en/dlf/download_index.html?reg=us&c=us&lang=en&prod=2430eus&type2=33&os=all&flang=all&dlid=dlfp001711
https://www.apesoftware.com/about/contact-us
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Note: If a warning appears related to making the file unusable by changing its extensions, ignore the warning. 

Data Link Properties 
Double-click on the new UDL file and the following Data Link Properties dialog appears. 

Provider Tab 
Select the appropriate SQL Server Provider. 
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Connection 
In the Connection tab . . . 

 
1. Enter the fully qualified SQL Server name. 

 
2. Select the authentication method (i.e., Windows or {1st choice} or SQL Server {2nd choice} and enter 

the appropriate user name and password, if SQL authentication is used. 

3. Select the database. By default, this is apecal but must match whatever name is actually used on the SQL Server. 
 

4. Click the [Test Connection] button. 



  
CALIBRATION CONTROL MANUAL 261 

 

 
 

If the above test fails, then work with your organization's Database Administrator (DBA) to resolve the connection before 
attempting to use the Ape Software application. If using SQL Server authentication, the User Security section of the 
Add Ape Database to SQL Server help topic is often useful. 

 

 
Otherwise, if the above process leads to a 'Test connection succeeded' dialog and the Ape Software application cannot 
connect to the SQL Server, contact Ape Software to continue troubleshooting the connection. 

https://www.apesoftware.com/calibration-control/help/sql-server-install
https://www.apesoftware.com/calibration-control/help/sql-server-install
https://www.apesoftware.com/about/contact-us
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SMTP Test Procedure 

Introduction 
If you are having difficulty getting the Test Email Settings to work, this test procedure will determine whether or not 
you have access to your SMTP server and help to identify the problem. 

Network firewalls or antivirus software sometimes block email traffic preventing you from accessing the mail server, which is 
required in order for the Auto Notification utility to function. 

This procedure should only be used if you are getting a system error or timeout message. 
 

If you are getting an authentication error, the problem is probably due to an invalid username/password or unknown source. 
 

 

Procedure 
Verify Domain: 
To begin, open a Command Prompt Window. Click on the Start menu from your computer's desktop and type “CMD” in the 
run or search box. In Windows 10, right click on the Window (start) icon and click "Command Prompt". 
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Then type in “nslookup” and insert your SMTP server address, like the example below for Gmail: 

 

 
 

After pressing "Enter" you should see a result similar to the one below. This will verify that your SMTP server address 
is valid. 

 

 
Adding TELNET: 
Once you have verified the domain, we can try to connect to the SMTP server. This requires the use of 

TELNET. You will probably need to add TELNET since this function is not available by default. 

To add this feature, open up your Control Panel and select “Programs and Features”. In Windows 10, click on the Start 
button then click on the gear icon to get to settings. In the search bar type "turn Windows features on or off". Within the 
Windows Features dialog, check the box next to "Telnet Client" and click OK to save the change. 
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Once Windows has installed this feature, click "Close" to complete this step. 

Connect to SMTP server: 
Now go back to the Command Prompt window and type the following: 

 
telnet "SMTP server address" "port" 

 
 

 
 

If you are able to connect, you should see a result similar to the one below: 
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If the result says "Connect Failed", you do not have a connection to your SMTP server using that 

port. Reasons for this include: 

The email server is not functioning 
 

The traffic is being blocked by network security 
 

UDL File for Database Connection 

Universal Data Link for Database Connection 
Use a Universal Data Link (UDL) file when the Ape software Program Files are installed on a central file server and the 
central database is a SQL Server. The UDL file is then used to define the SQL Server and database name. Finally, 
the UDL file is consumed by creating a program shortcut with a switch pointing to the UDL file. 

Without using a UDL file, an Ape setting file on each of the Client computers (i.e., general.config) requires a property 
that defines the location of the database server and database. This means the database location is defined, and can 
be changed, in multiple locations. 

Create Universal Data Link (UDL) File 
Follow these steps to create a UDL file: 

 
1. Open Windows Explorer to the location where the UDL will be created. 

 
2. Right-click and select New -> Text Document, naming the file something like "apedb.txt". 
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3. Change the extension of the new text file to "udl" with an end result of "apedb.udl". 
4. Double-click on the new file to open the Data Link Properties dialog. Select the Provider tab and select 

the "Microsoft OLE DB Provider for SQL Server". 
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5. Select the Connection tab and enter the (1) Server Name where the Ape Calibration database is located, (2) 

select Windows NT Security, and (3) select the database name. 
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6. Click the [OK] button to save the UDL file settings. 

Create Shortcut 
Now create a new Shortcut to the "apecal.exe" executable with a switch at the end in the format of -udl:"[path statement 
of udl created in previous steps]" and include the quotations. Ensure both path statements are valid for all Client users. 

1. While still in Windows Explorer, right-click and select New -> Shortcut. 
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2. In the Create Shortcut dialog, add the "[executable path]" -udl:"[udl path]" statement like below. 
 

 
3. Click the [Next] button, give the Shortcut a name like "Calibration Control" and then click the [Finish] button. 

Copy Shortcut to Clients 
Remember that even though the Program Files for Calibration Control are installed on a File Server, the program itself 
actually runs on the Client computers. Therefore, each Client computer must have the Minimum Requirements. 

1. Ensure the Minimum Requirements are installed on the Client computer. 
 

2. Copy the newly created Shortcut to a Client computer. 
 

3. Test the new shortcut. 
 

If you need help making this feature work, please Contact Us for help. 

Startup INI 

Single Connection Configuration for All Users 
In network environments where the Calibration Control (our Calibration Management Software ) program files are 
installed on a single file server and executed from multiple clients, the Startup INI (startup.ini) gives Network Administrators 
the ability to configure database connection properties in a single location. Each time Ape starts, it looks for the 
“startup.ini” file in the same folder as the executable. If found, the connection settings in the “startup.ini” file take 
precedence over connection settings, or absence of settings, at the Client level. 

Additionally, all data stored in the INI file (e.g., database name, location, server, password, etc.) is 128 bit encrypted. 

Before Using the INI Utility 

https://www.apesoftware.com/products/minimum-requirements
https://www.apesoftware.com/products/minimum-requirements
https://www.apesoftware.com/about/contact-us
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Before creating the “startup.ini”, install the Ape Software on the computer/server and Create a Multi-User Environment. 
Note that the Minimum System and Configuration Requirements is a highly relevant and useful document that will help 
prevent deployment issues and should be followed. In addition, the Startup INI feature may be hidden from your toolbar. 
To learn how to show this feature, follow the Feature Visibility help topic. 

Start the INI Utility 
Select the Startup INI menu option of the Utilities tab of the ribbon menu. 

 

 
Startup INI Editor 
Work with your internal IT group to assist with setup if further help is needed. All enabled fields (fields that can be typed 
in) are required except for the Password fields when the Database Type is set to [MS] Access. 

 

 
 

https://www.apesoftware.com/calibration-control/help/multiple-users
https://www.apesoftware.com/products/minimum-requirements
https://www.apesoftware.com/calibration-control/help/feature-visibility-options
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Updating Access DB 
This help topic covers possible difficulties related to updating an MS Access DB for Calibration Control (CC). Refer to 
the Update a SQL Server Database help topic for SQL Servers. 

Problem Description 
Revisions of CC often require / make changes to the structure of the DB. These changes include tables, index, fields, and 
query creation, deletion, or modification. The speed and ability of CC to update an Access DB is affected by the speed 
and stability of a network in addition to the size and complexity of the update itself. Therefore, the combination of a slow 
or unstable network with a large update (e.g., version 9.0) can result in a failure to update. The following are methods to 
turn such a failure into a success. 

Automatic Backups 
Before the update process begins, CC automatically creates a backup of the Access DB and places that backup file in 
the Backup folder below the Database Folder (refer to the Folders help topic). The name format of the backup files is 
‘apecal- auto-backup-[large number].dbk’. The backup files are renamed copies of the Access DB. This means that the 
backup files are still valid MS Access DB files, just with a different extension (*.dbk). 

It’s important to understand the backup process (above) since an update activity may fail / freeze at any point. Therefore, 
the backup process may need to be re-started. If a re-start is required, it should start with a database file that has not 
been altered by a previous failed update attempt. 

Local Update 
The simplest method to bypass a slow or unstable network (e.g., noisy/weak Wi-Fi) is to move/copy CC’s Access DB 
(usually named apecal.mdb) to the local HDD (Hard Disk Drive) of a computer with the new version of CC installed. 
Update the DB locally and the move the DB back to its network location. Here are a few explicit steps: 

Step 1 – Move DB to Local HDD: Move the CC DB to the local HDD (refer to the Locating Database and Move 
Database help topics). If previous update attempts already failed, use the first backed up copy (*.dbk) of the database 
(before an update attempt was made) instead of the main database file (*.mdb). Do this by copying and renaming the 
backed up file to the correct file name (e.g., apecal.mdb) and placing that copy on the local computer’s HDD. 

Step 2 – Delete Config File: Delete the general.config file (located at C:\Users\Public\Documents\Ape 
Software\Calibration Control). When the general.config file is deleted, CC provides a dialog that helps you navigate to 
the copied DB on the local HDD (see step 1, above). 

Step 3 – Update DB: Start CC and allow the software to update the local DB. 
 

Step 4 – Return Updated DB: After the update succeeds, close CC and place the DB back in its original network 
location. Ensure the local DB is moved, deleted, or re-named so you don’t accidently connect to it when re-starting 
CC. 

Step 5 – Connect to Updated DB: Delete the general.config file again and re-start CC, this time navigating to the 
original network location. 

If everything worked as it should, you will be up-and-running. If not, Ape Software can provide a free update service. 

https://www.apesoftware.com/calibration-control/help/sql-server-update
https://www.apesoftware.com/calibration-control/help/folders
https://www.apesoftware.com/calibration-control/help/locate-database
https://www.apesoftware.com/calibration-control/help/move-database
https://www.apesoftware.com/calibration-control/help/move-database
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Current Access Database Drivers 
If you are repeatedly receiving a message saying that you need to set ACE to 'True' in your general.config, then you 
probably need the download and install database drivers. You can find these drivers on the Minimum Requirements page 
or just download from here. 

Ape Software Free Update Service 
If you need Ape to update your DB for you, simply send us an un-altered zipped copy. 

 
Un-Altered DB Copy: Ensure you send us a copy of your DB that has not previously failed the update process. Refer 
to the Automatic Backups section of this help topic for more info. 

Send Method: If your zipped DB is less than 5 MB, you can email a copy to service@apesoftware.com. Otherwise, 
you can upload your zipped file to a cloud service you are familiar with or we can send you an upload link. 

If you have any specific questions, please contact us. 

 

Update a SQL Server Database 

Update an Ape Software SQL Server Database 
Use these instructions to update the database structure of a Calibration Control database installed on a SQL Server 
2012 or higher. 

Before Updating 
Open SQL Server Management Studio and sign in to a SQL Server as a SYSTEM ADMIN because you'll require 
enough permissions to create and update databases and their objects. Otherwise, your IT Group may need to perform the 
update. 

All of the SQL files needed to update the database reside in the SQL Tools folder under the CC program folder located 
in your computer at C:\Program Files\Ape Software\Calibration Control. 

Before attempting to update an apecal database protect your database with a backup . Right-click the database, 
hover over Tasks, and then select Back Up. 

Follow along with our Backup/Restore SQL Server Database help topic for more detailed instructions. 

 

https://www.apesoftware.com/products/minimum-requirements
https://www.apesoftware.com/content/downloads/AccessDatabaseEngine_2007.exe
mailto:service@apesoftware.com
https://www.apesoftware.com/calibration-control/help/backup-sql-database
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Updating Database 
1. Determine the current database structure version by first expanding the database tree and expand the Tables folder. 

Then, right-click the dbo.tblDBVersion_DO_NOT_EDIT table and Select Top 1000 rows. There should only be one 
record. 
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 DB Version Interpretation 

Indication Database Version 

dbo.tblDBVersion_DO_NOT_EDIT table does not exist 1 

Rev = 1.1, 7.0, 7.0.1, etc. Rev = Version 

Rev = DoNotEdit Use StructureVersion field 

StructureVersion = 66 66 

 

 
If you do not have a StructureVersion field in the file name (versions 7.2.5 and older), use the following table as a 
guide to interpret the dbo.tblDBVersion table and how to choose the appropriate sql_update SQL file to begin with: 
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 List of Updates 

SQL Update Script File 
 
sql_update_01 (pgm ver 1 to 1.1).sql (read as version 1.0 to 1.1) 

sql_update_02 (pgm ver 1.1 to 7.0).sql (same as above) 

sql_update_03 (pgm ver 7.0 to 7.0.1).sql 

sql_update_04 (pgm ver 7.0.1 to 7.2.0).sql 

sql_update_05 (pgm ver 7.2.0 to 7.2.2).sql 

sql_update_06 (pgm ver 7.2.2 to 7.2.5).sql 

sql_update_07 (pgm ver 7.2.5 to 7.2.5.8).sql 

sql_update_08 (pgm ver 7.2.5.8 to db ver 15).sql (read as program version 7.2.5.8 to database version 15 {new 
system}) 
 
sql_update_09 (db ver 15 to 24).sql (read as database version 15 to 24) 

sql_update_10 (db ver 24 to 30).sql 

sql_update_11 (db ver 30 to 31).sql 

2. Open each SQL Update file with SQL Server Management Studio. Once again, ensure you backup your 
database before proceeding. 
Note: If your database name is not the standard "apecal", change the database name before proceeding. The 
database name may appear in the following lines of the update files: 

 
ALTER DATABASE apecal -- *** 

SET OFFLINE WITH ROLLBACK IMMEDIATE 

ALTER DATABASE apecal -- 

*** SET ONLINE 

USE apecal -- 

*** GO 

ALTER DATABASE apecal SET PAGE_VERIFY CHECKSUM -- 

*** GO 

3. Apply the sql_update SQL files in their sort order beginning with the database version indicated by the Db Version 
table (above). 
For example, if the StructureVersion field of your database equals 66, then begin with file sql_update_22 (db ver 66 
to 73).sql then click the [Execute] button to apply the changes. 
Note: Ensure that none of the text in the SQL file is highlighted when the [Execute] button is pressed because this 
will run only the highlighted text. 

4. Once the query is complete (without any red query errors), continue to the next file until you finish with the final SQL file. 
 

5. If you encounter any query errors, take a screenshot of the error(s) and contact us for assistance. 
 

https://www.apesoftware.com/about/contact-us
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Get Ape Support 
Contact us and we can setup a screen share and update your database together or if you prefer, you can send us a 
backup of your database and we can update your database for you. 

Backup and Restore SQL Server Database 

Create a Full Database Backup 
While there are many ways to back up your database, a full database backup backs up the entire database (including 
part of the transaction log) which makes it simple to restore. However, as the size of the database increases, full 
database backups will take longer to complete and require more storage space. For larger databases, consider using 
a series of differential backups in addition to a full database backup. 

1. Using SQL Server Management Studio, log in to the appropriate server with sufficient permissions and, if 
needed, expand the server tree. 

2. Expand the Databases folder. 
 

3. Right-click the database that you wish to backup, hover over Tasks, and then click Back Up.... 

SQL Update Script File 

sql_update_12 (db ver 31 to 38).sql 

sql_update_13 (db ver 38 to 39).sql 

sql_update_14 (db ver 39 to 40).sql 

sql_update_15 (db ver 40 to 41).sql 

sql_update_16 (db ver 41 to 42).sql 

sql_update_17 (db ver 42 to 43).sql 

sql_update_18 (db ver 43 to 46).sql 

sql_update_19 (db ver 46 to 51).sql 

sql_update_20 (db ver 51 to 64).sql 

sql_update_21 (db ver 64 to 66).sql 

sql_update_22 (db ver 66 to 73).sql 

sql_update_23 (db ver 73 to 81).sql 

sql_update_24 (db ver 81 to 84).sql 

https://www.apesoftware.com/about/contact-us
https://www.apesoftware.com/help/remote-desktop-support
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4. The Back Up Database dialog will appear and you will see your selected database in the dropdown list. You 

can select a different database from the dropdown if you choose to do so. 
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5. By default, the Backup type will be Full. You must create a full backup before you can select a differential backup 
type. 

6. Choose Database under the Backup component (if not already selected). 
 

7. Under the Destination section, your database will back up to a default SQL Server Backup location, however 
you can Add/Remove additional location(s) or remove the default file path in order to Add and rename the 
backup file name (still using the default backup location). Ensure you have read/write permissions to the 
selected file path. 

8. Note: If you have previously created a backup of the same database, go to the Media Options page and review 
the settings. Choose whether this backup will append to the existing database or overwrite it. 

9. Recommendation: Go to the Backup Options page and review the settings. Under the Compression 
section, compress the backup to save storage space (database compression is not available in SQL 
Express). 

10. Click OK to start the backup process. Once the backup is successful, a dialog will appear to notify you. 
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Restore a SQL Server Database Backup 
Follow these instructions for restoring a full database backup. Once again, using SQL Server Management Studio, connect 
to the appropriate server and expand the server tree. 

1. Right click the Databases folder and select Restore Backup 
 

2. Select Device as the Source. 
 

 
3. Click the browse button 

 

4. Then, click on the Add button. The dialog will automatically show available backups in the default backup location. 
If you previously saved your backup in a different location, copy the path and paste it in the Backup File Location 
box. Note: Only .BAK file types will be available in this dialog. 

5. Select your backup file and click OK. 

... 
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6. The database name may be automatically loaded if you previously restored this backup. You can change 
the Database name if needed. 

7. At the point, you may see "Ready" at the top of this dialog. This means you can restore your database now 
or continue and adjust additional settings. 

 
 

8. The restore process may fail if there are existing connections. To prevent this, go to the Options page and 
check "Close existing connections to destination database" located under the Server connections section. 
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9. Optionally, if you want to overwrite an existing database, select "Overwrite the Existing database". The
database name will need to match the existing database.

10. Click OK to start the restore process. Once the restore is successful, a dialog will appear to notify you.

Downgrading a Database 

Return a Database to the Previous Version 
Sometimes after a new version of Calibration Control is deployed a decision is made to return to a previous version. 
Unfortunately, many Ape updates include changes to the database which cannot be uninstalled as easily as the software. 
This is why a manual database backup is strongly encouraged before updating the MS SQL Server database. 

Restore an Access Database 
1. Refer to the Folders used by Ape help topic before continuing.

2. Open the Data folder and rename the apecal.mdb file (e.g., higher-version-apecal.mdb).

3. In the Backup folder under the Data folder, rename the most recent database backup file from apecal-auto-
backup- [long number].dbk to apecal.mdb.

4. Install the previous version of Ape or download and install one of the older Ape versions that your product key 
works    with.

5. Restart the previous version of Ape to confirm that the database works.

Restore a SQL Server Database 
Use the same instructions in the Installing SQL Server help topic – Restore (1st Method), but choose the file that 
was   backed up as part of the update process. 

https://www.apesoftware.com/calibration-control/help/sql-server-update
https://www.apesoftware.com/calibration-control/help/folders
https://www.apesoftware.com/calibration-control/download-archive
https://www.apesoftware.com/calibration-control/download-archive
https://www.apesoftware.com/calibration-control/help/sql-server-install
https://www.apesoftware.com/calibration-control/help/sql-server-update
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